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Welcome to the SpeechMiner online help system. 
 
 

If you're unable to find what you're looking for in this
help system, try our support page:

http://www.genesyslab.com/support/general-
pages/contact-us.aspx

or contact our support team at:

customercare@genesyslab.com
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Getting Started

SpeechMiner®, Genesys Telecommunications Laboratories’s award­winning Speech Analytics platform, leverages recorded customer
interactions (from any recording system) and analyzes each call for critical business topics and events. With unmatched accuracy, the
system “listens” to conversations between customers and contact­center agents, precisely identifies the topics that were discussed,
and categorizes what took place within each interaction. 

SpeechMiner is made up of two software components:

1. SpeechMiner browser-based interface, which offers a variety of ways to access the results of the call analyses performed by
the system. Users can employ this interface to find calls that have specific characteristics or that deal with particular topics, to
identify and listen to the parts of calls that interest them, to audit and fine-tune SpeechMiner's call processing, and to keep
track of a range of system-metrics.

2. SpeechMiner Administration Tool (SMART), which enables users to configure the Speech Analytics system to search calls for
specific topics and other characteristics.

This manual explains how users can use the SpeechMiner browser-based interface. This first section explains how to log into
SpeechMiner and gives an overview of the interface. Upcoming sections provide details about working with the interface. Information
about using the SMART SpeechMiner component is available in the SMART User Manual.

See also

Logging into SpeechMiner
Overview of the Main Window
About Calls and Interactions
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Logging into SpeechMiner

In order to work with SpeechMiner, you must log into the system with a username and password that is defined for you by
your SpeechMiner system administrator.

When you log in, SpeechMiner automatically checks the roles and groups that are assigned to your account. The roles tell the system
what SpeechMiner functions and features you can access. Only those items you have permissions to view are displayed in the
interface when you are logged in. The groups tell the system which call data is relevant to you. The Interaction Lists, call searches,
and reports you access in SpeechMiner will only include data from this body of calls. For additional information about roles and
groups, see User Management.

To log into SpeechMiner

1. In an Internet Explorer browser window, navigate to the SpeechMiner address. The SpeechMiner Login page appears.

Note: The SpeechMiner address should be given to you by your system administrator. Alternatively, when your account was
created, you may have received an automated e-mail notification with this information.
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SpeechMiner Login Page

2. Select SpeechMiner if your username and password are managed by SpeechMiner. Select Windows if you log
into SpeechMiner using the same username and password you use to log into Windows. The fields required for the selected
option are displayed.

Note: If you are not sure which option to choose, contact your system administrator. 

3. In the Login and Password fields, type your username and password.

4. If you selected Windows in step 2, in the Domain field, select your Windows domain.

5. Click Login. You are logged into the system, and your homepage is displayed. (If no homepage has been set in your profile
settings, your Views page is opened.)

Note: The first time you log in, the End User License agreement appears before you are logged in. Read the agreement. Then,
select I accept and click OK. Your homepage is displayed.

 

See also

Overview of the Main Window
About Calls and Interactions
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Overview of the Main Window
The SpeechMiner interface is divided into pages from which you can access all of the system's functions. The following pages are
included in the interface:

Page Description 

Views The home page of the interface, this page can contain a number of Views, each of which can contain a selection of
small applications that help you keep tabs on information that is of importance to you. 
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Search Searching for calls and other interactions by their characteristics, listening to calls in SpeechMiner's multi-featured,
proprietary Media Player; viewing the content of calls and other interactions

Explore Identifying unexpected trends and problems by viewing automated analyses of the terms that were found in call
transcripts and records of other interactions.

Reports Managing reports by selecting filter criteria, generating reports, and handling the results. 

Quality Management of call monitoring. This system enables call monitors and supervisors to check selections of calls that
meet specified criteria and fill in forms rating the calls and drawing attention to issues that arise in them. 

Coaching Management of coaching sessions. Coaching sessions provide managers with extensive tools for helping agents and
other personnel to improve their performance. Each session directs the trainee to listen to particular recorded calls and
can include notes on how lessons from these calls can be implemented by the agents in their work.

Tools Access to system administration tools, including user management, Preset-View management, and system
administration

Help A dropdown menu that provides access to this guide, information about the current version of SpeechMiner, and a
form for sending feedback about SpeechMiner to Genesys

To open a page:

Place your mouse pointer over the name of the page in the Main Menu. If a dropdown menu opens, select one of the options in
the menu. If no dropdown menu opens, click the name of the page. 

Elements of the Interface

Each page of the interface contains some or all of the following elements:

Key to illustration:

Element Number in
Illustration

Description 

Main
Menu

 1 A menu bar for navigating from page to page in the interface.

Most of the menu options have dropdown submenus that provide quick access to the tabs of the page
or to other functions. Place the mouse pointer on the menu item to view the dropdown menu.

Most of the submenus have a default option. This option appears in the submenu in bold type. For these
menu options, if you click the name of the menu option, the default option from the submenu is
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automatically selected. For example, in the Views menu option, the default option is the first View in
the submenu. The name of this View appears in bold type in the submenu; clicking Views in the main
menu opens this View. 

Tabs  2 In many of the pages, the functionality is divided into tabs. The tabs appear below the Main Menu. Click
a tab to display it.

Page
contents

 3 Below the Main Menu and tabs are the contents of the page. For example, in a Views page, the widgets
of the current View are displayed, and in a Search page, in the New Search tab, a search form is
displayed on the left, and, once a search has been performed, an Interaction Grid with the results
appears on the right.

Action
Items 

 4 A link that opens the current user's Action Items box, which is used to manage job assignments

Search
box

 5 Enter one or more terms in the box to perform a quick search for calls in which the terms were found.

User
name

 6 The user name of the user who is currently logged in

Logout  7 Click to log out of SpeechMiner 

Date and
time 

 8 The date and time at which the current page was loaded. 

 

 

See also

Logging into SpeechMiner
About Calls and Interactions
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About Calls and Interactions

The basic SpeechMiner package works with audio calls that are recorded by external recording systems and then imported into the
SpeechMiner database for further processing, such as transcription, identification of Topics, and association with Categories. An
optional add-on enables SpeechMiner to also process various forms of written texts, such as e-mails and Facebook
conversations. When this add-on is activated, SpeechMiner can include calls and other data in its processing. The general term used
in SpeechMiner for data that includes both calls and other written sources is interactions. 

If your system only includes the call-processing features, some of the menu items and labels in your SpeechMiner interface differ from
those that appear in this manual, because they say call or calls instead of interaction or interactions. In addition, certain options are
not included in the interface. For example, since only call data is available for searches, you will not see the options that allow you to
select the types of interactions to include in a search (see Defining Search Criteria).

If your system includes both call-processing and text processing, the menu items, options, and labels in your SpeechMiner interface
should match those that appear in this manual. In filters, you can choose the types of interactions to include. For example, you could
choose to perform a search for specific terms in calls and e-mails, but not in social media. In a list of search results, individual items

like calls or e-mails are labeled using icons that identify their source-types. For example,  indicates a call,  an e-mail, and  an
excerpt from Facebook.

 

See also

Logging into SpeechMiner
Overview of the Main Window
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Home > Workflows

Workflows

See also

Welcome
Getting Started
Views
Action Items
Search
Using the Media Player
Explore
Quality Monitoring
Coaching
Reports
Tools
Permalinks
Appendix A: Standard Reports
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Home > Views

Views
Your Views page is your customizable home page in SpeechMiner. The Views page can contain one or more Views. Each View
contains small applications called widgets that display information or other content of interest to you. For example, a View could
include a number of Report widgets to give you a snapshot of metrics and key performance indicators, a My Messages widget to
display system messages, and a My Queues widget that enables you to easily access and play calls that require auditing.

 

Views Page

Key to Illustration:

Number Description 

 1 View tabs

 2 Widget

Two types of Views can be included in your Views page:

1. Preset Views: Views that were created by a manager or system administrator and published to your account.

2. Personal Views: Views that you created manually in your Views page. Personal Views are identified by an  icon in its tab.

Note: Depending on your permissions, you may or may not be able to add personal views and remove or modify any of the Views in
your Views page. If you do not have permission to perform an action described in this section, the buttons or controls required for
that action will not appear in your interface. In addition, you can choose a different page as your homepage. If you do so, the page
you select will open when you first log into SpeechMiner. For additional information, see Editing Your User Profile.

To open a View:

In the Main Menu, under Views, select the View. The Views page opens with the View displayed in a tab.

To switch to a different View:

Click the desired tab, or select the View from the Main Menu, as described above.

To open the last View you had open in your Views page:
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In the Main Menu, select Views.

 

See also

Managing Views
Managing Widgets

Managing Preset Views
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Managing Views

This section explains how you can create new personal Views, modify the name and widget layout of an existing View, change the
order of the tabs in the Views page, and delete existing Views.

Note: Depending on your permissions, you may or may not be able to perform all of the actions described in this section.

Adding a New View

You can add as many new views to your Views page as you wish. Each view can contain a different selection of widgets. For example,
if you are a manager of two workgroups, you may choose to create two different Views, to help keep track of each workgroup
separately.

To create a new View:

1. In the Views page, click the plus sign ( ) at the end of the tabs. A new blank View opens, and its tab is labeled New Page.

2. Modify the properties of the View; see Renaming a View and Changing the Column Layout of a View below.

3. Select widgets to add to the View; see Managing Widgets.

 Renaming a View

You can change the name of an existing View.

To change the name of a View:

1. On the right side of the screen, click Change Settings. The setting options appear on the screen.

2. Under Change View Title, in the Title field, modify the name of the View.

3. Click Save. The name is applied to the View, and the setting options are closed.

Changing the Column Layout of a View

You can change the column layout of an existing View. The widgets in the View are arranged to fit into the column layout you
select. The width of each widget is determined by the width of the column in which it appears. Within a given column layout, you can
manually change the width of each column to suit the widgets that appear in them.

Note: You can move widgets within a View, or change their heights, to suit the column layout you choose. See Managing Widgets.

To change the column layout of a View:

1. On the right side of the screen, click Change Settings. The setting options appear on the screen.

2. Under Change Columns, click the desired layout, as follows:

Icon Description
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Three columns of equal widths

Two columns, with the larger on the left

Two columns with the larger on the right

One column

The layout is applied to the View, and the setting options are closed.

To change the width of a column:

Drag the border line at the top of the column to the left or right.

Changing the Order of the View Tabs

You can move the View tabs to change their order.

To move a View tab:

1. When the View is open, place you mouse pointer on the orange stripe across the top of the tab. The mouse pointer changes to 

.

 

2. Drag the tab. The location in which it will be placed when you release the mouse button is outlined.
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3. When the outline appears in the desired location, release the mouse button. The tab is moved to that location.

Deleting a View

You can delete existing Views from the Views page. 

To delete a view:

1. On the right side of the screen, click Change Settings. The setting options appear on the screen.

2. Under Delete View, click Yes. You are prompted to confirm that you want to delete the View.

3. Click Yes. The View is deleted, and the setting options are closed.

 

See also

Managing Preset Views
Views
Managing Widgets
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Managing Widgets

Widgets are small applications that can be included in a View in the Views page. Each widget is displayed in the page as a small
rectangle. Depending on your user permissions, you may be able to add widgets to a View, move widgets from one location to
another within a View, modify the settings of widgets, minimize widgets, and remove widgets from a View. 

Various types of widgets can be included in a View: Gauge, Report, My Messages, My Queues, and Recently QAed. The Gauge and
Report widgets can be configured to display information about a variety of topics, so you may find it useful to include more than one of
them in a single View, or to create multiple Views in which these widgets display different data. 

Adding a Widget

You can add any number of widgets to a View.  

To add a widget to a view:

1. When you have the View open, click Add Widgets. The available widgets are displayed.

2. Click the widget you want to add to the View. The widget is added to the view.

3. Drag the widget to the desired location on the screen.
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Editing a Widget

 You can change the name, height, and refresh rate of all widgets. Some widgets have additional settings that you can change.

To change the name of a widget:

1. Click the title of the widget. The title becomes an editable text field.

2. Modify the title as required.

3. Click OK. The title is updated.

To change the height and other settings of a widget:

1. In the upper-right corner of the widget, click Edit. The widget's configurable settings are displayed.

2. Change the settings as required. For detailed information about the settings of each type of widget, see the description of the
widget, as follows: 
Gauge Widget
Report Widget
My Messages Widget 
My Queues Widget 
Recently QAed Widget 

3. Click Save to save your changes.

4. In the upper-right corner of the widget, click Close. The setting options are hidden.

Moving a Widget

You can move a widget from location to location within a View.

To move a widget:

 Drag the widget to its desired location.

Minimizing a Widget

If you do not want to see the contents of a widget temporarily, you can minimize the widget.

To minimize a widget: 

In the upper-right corner of the widget, click the minus sign ( ). The title bar of the widget is displayed, but its content is
hidden.

To maximize a widget: 

In the upper-right corner of the widget, click the plus sign ( ). The content of the widget is displayed below its title bar.

Refreshing a Widget

The contents of widgets are refreshed automatically at specified intervals, but you can also refresh them manually.

To refresh a widget:

Click . 

Deleting a Widget

You can remove a widget from a View.

To remove a widget from a View:

1. In the upper-right corner of the widget, click the x ( ). You are prompted to confirm that you want to remove the widget from
the View.

2. Click Yes. The widget is removed from the View.

  

See also
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Gauge Widget
Report Widget
My Messages Widget
My Queues Widget
Recently QAed Widget

Managing Views
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Gauge Widget

The Gauge widget provides a graphic representation of the current quantity of a selected type of data. For example, a Gauge widget
can show the average handling time for calls received by the workgroup, or the number of calls waiting for your handling. You can
choose from a selection of customizable SQL stored procedures that retrieve the data of your choice for display in a Gauge widget. 

 

Gauge Widget

Configuring the Widget

You can configure the settings of a Gauge widget.

To configure a Gauge widget: 

1. In the upper-right corner of the widget, click Edit. The widget's configurable settings are displayed.

 Setting Description 

Height The height of the widget, in pixels

Color
Direction

Select one of the following:

Green to Red: The gauge will display green for the lower values, yellow for the middle values, and red
for the highest values.

Red to Green: The gauge will display red for the lower values, yellow for the middle values, and green
for the highest values.

Min The minimum value to display

Max The maximum value to display

Bound1 The value at the boundary between the first color and the yellow area

Bound2 The value at the boundary between the yellow area and the last color

SQL
Stored
Procedure

The name of the SQL procedure that will retrieve data for presentation in the gauge.

Note: For information about the procedures that are available, contact your system administrator.
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Refresh
Rate

How often the data represented in the gauge should be refreshed, in minutes

Edit Filter Select the data to include in the sample used for calculations:

Click the Edit Filter icon ( ). The Filter Panel opens in a new window. Select the required filter settings, and
then, at the bottom of the window, click Save. For additional information about working with the Filter Panel,
see Defining Search Criteria.

2. Click Save. The settings are implemented.

3. Click Close. The settings are hidden.

 

See also

Report Widget
My Messages Widget
My Queues Widget
Recently QAed Widget
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Report Widget

The Report widget can be used to display any of the existing reports saved in the system. Many report templates are available in Mini
versions that are specially formatted for the Views page because they require less space on your screen, but you can select reports of
any size.

 

Report Widget

Drilling Down in a Report

Clicking on certain locations in the Report widget will drill down to other reports or to Interaction Lists, as appropriate for the item that
was clicked. For example, clicking on a bar in the report above will open a list of calls specific to the agent whose name was
clicked. Interaction Lists are opened in a separate window, but other drill-down reports are usually opened in the same widget. For
information about available reports and the expected drill-down results, see Templates.
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A Back ( ) button appears in the left corner of the Report widget's title bar. If you have drilled down from a report to another
report, you can use the back button to return to the original report. 

To close a drill-down report and return to the report results:

Click Back ( ). 

Configuring a Report Widget

You can specify the height of a Report widget, how often it is updated, and what report is should contain. 

To configure a Report widget: 

1. In the upper-right corner of the widget, click Edit. The widget's configurable settings are displayed.

2. Fill in the fields as follows:

 Setting Description 

Height The height of the widget, in pixels

Refresh
Rate

How often the data in the report should be refreshed, in minutes

Select 
Select the report you want to display in the widget. The list contains all saved reports for which you have
permissions. Reports that are saved in your account are marked with an asterisk (*). The name of the user who
saved the report appears in parentheses after the name of the report.

Note: If a report has already been selected, additional configuration fields may appear.

3. In the widget's settings, click Save. The settings are implemented, and the name of the saved report is displayed at the
bottom-left of the widget. 

4. In the upper-right corner of the widget, click Close. The setting options are hidden.

Changing the Settings of the Report

Once you have selected a saved report for display in a widget, you can modify the report's settings as necessary.

To change the settings of the report:

1. In the upper-right corner of the widget, click Edit. The widget's configurable settings are displayed.

2. Click the Edit Report icon ( ). The report template opens in a new window. 
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Report Template

3. Modify the settings as necessary.

4. Click Save Changes. The dialog box closes. The report is generated with the new settings, and the results are displayed in
the widget.

Note: If the saved report you modified was not in your account, you are prompted to provide a new name for the saved report.
The modified settings are saved under the new name you specified, in your account. The original saved report in the other
user's account is not changed.

5. In the upper-right corner of the widget, click Close. The setting options are hidden.

Opening the Edit Report Page

You can open the Edit Report page directly from a Report widget. You can then run the report with different settings, view a larger
version of it, or create a new saved report. 

To open the Edit Report page:

In the bottom-left corner of the widget, click the name of the saved report. The Edit Report page opens.

Note: To return to the Views page, use your browser's Back button.

 

See also

Gauge Widget
My Messages Widget
My Queues Widget
Recently QAed Widget
 

Home > Views > Managing Widgets > My Messages Widget

My Messages Widget

The My Messages widget is a mailbox in which you can send and receive messages and schedule a new coaching session.
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 My Messages Widget

Three types of messages may appear in the My Messages widget:

Message
Type 

Description 

Call A message containing a link to a recorded call. This type of message is sent by other users. It contains a link to the
call. Click the link to play the call. A SpeechMiner Media Player window opens and plays the call.

Note: This type of message is sent when a user forwards a call from an Interaction Grid or from the Media Player.

Note A note from another user 

Coaching An automated notice from the system informing you that another user has scheduled a coaching session for you.
When you open the message, the Session Details page of the coaching session opens. To accept the coaching
session, in the My Messages widget, under Action, click Accept. The coaching session is accepted, and the message
is deleted from the message list.

To open a message:

 Click the subject of the message. 

To send a message to another user:

1. Click New and then select Note. A New Note dialog box opens. 

2. Fill in the fields and then click Send. A message pops up confirming that the message was sent successfully.

To schedule a new coaching session: 

1. Click New and then select Coaching Session. A New Coaching Session dialog box opens. 

2. Fill in the fields and then click Save. A message pops up confirming that the session was added successfully.

If your mailbox contains too many messages to display in the widget at one time, the message list is divided into pages. In this case,
page numbers appear at the bottom of the list.

Note: The number of messages that can be displayed in a page depends on the height of the widget. You can change the height, as
explained below.

To go to a different page in the mailbox:

At the bottom of the list of messages, click the page number.

Configuring the Widget

You can configure the height and refresh rate of a My Messages widget.

To configure a My Messages widget: 

1. In the upper-right corner of the widget, click Edit. The widget's configurable settings are displayed.
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2. Fill in the fields as follows:

 Setting Description 

Height The height of the widget, in pixels

Refresh Rate How often the list should be refreshed, in minutes

3. Click Save. The settings are implemented.

4. Click Close. The settings are hidden.

See also

Gauge Widget
Report Widget
My Queues Widget
Recently QAed Widget
 

Home > Views > Managing Widgets > My Queues Widget

My Queues Widget

The My Queues widget is used by quality analysts to quickly and easily access and keep track of the interactions they need to
review. The widget displays a list of the queues that are assigned to you - those that you created and those that were created by
others and shared with you. You can click a button to play the next call in a queue or to drill down in the list to view more details about
the calls it contains.

My Queues widget

Columns in the Queue List

The Queue List contains the following columns:

Column Description

Name The name of the queue

Quota The number of calls that should be reviewed per per agent; if the queue is an "opportunity" queue, with no quota
specified, this field is blank

Date
Range 

The time period during which the calls took place

Calls in
Queue

The total number of calls available in the database that meet the requirements of the queue and have not already
been QAed. Calls handled by agents for whom the quota has already been filled are also excluded from this number.  

Note: This value is "0" for "opportunity" queues.

Note: If this value appears in red, the number of calls available is larger than the maximum number of calls that can
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be displayed in search results in your system. For example, if the maximum number of calls that can be displayed is
1000, and 2000 calls are available that meet the queue criteria, the value displayed will be 1000.

Left The number of calls that still must be reviewed in order to fill the quota 

Note: This value is blank for "opportunity" queues.

Note: If this value appears in red, either the number of calls available is larger than the maximum number of calls
that can be displayed in search results in your system, or the number displayed is an estimate. This latter situation
may occur if the criteria for inclusion in the queue did not include any agents or groups.

Available The number of calls that available in the database that can be used to meet the quota. This is the sum of all the calls
in the database, for each agent included in the queue, that meet the criteria of the queue and have not already been
QAed.

Note: This value is blank for "opportunity" queues.

Note: If this value appears in red, the number of calls available is larger than the maximum number of calls that can
be displayed in search results in your system.   

  Click to refresh the values displayed for this queue 

 Click to play the next call in the queue

Note: This option remains available even if the quota has already been met. Thus, you can listen to more calls from a
queue than are required, as long as calls that meet the search criteria and were not yet reviewed are available in the
database.

 Click to drill down to the list of agents in the queue

Sorting the Columns 

You can sort the rows of the Queues List by any of the columns.

To sort the list by a column: 

Click the column heading. (To reverse the sort order, click the column heading again.)

Playing a Call

You can play the next call in a queue simply by clicking the  button in the My Queues widget. The Media Player opens in the current
Views page.

To play the next call in a queue:

In the My Queues widget, click the  in the row in which the queue appears. If it is not already open, the Media Player opens at
the top of the Views page. Playback begins automatically. For information about working with the Media Player, see Using the
Media Player.

Media Player opened in the Views page

Refreshing the List

You can refresh the list at any time in order to see the latest data about the queues in it.
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To refresh the list:

In the upper-right corner of the widget, above the list of queue, select .

Completed Quotas

When the quota of a queue has been filled, the queue still appears in the list, but the values under Calls in Queue, Left, and
Available, are crossed out.

Drilling Down in the List

You can drill down from a queue to see it sub-divided into lists for each agent. From the agent list, you can drill down once again
to a list of calls for the agent. All three levels of the queue list have the same basic functionality. You can play calls from any of these
lists, refresh individual items in them, or refresh the entire lists, as described above.

Agent List

To drill down to the list of agents for a queue:

In the My Queues widget, click the  icon in the row in which the queue appears. The list of agents is displayed in the widget:

List of calls per agent

To close the agent list and return to the queue list:

In the upper-right corner of the My Queues widget, click  (Back).

Call List

You can drill down from any agent in the agent list to see the list of calls in the queue that are associated with the agent.

To drill down to the list of calls for an agent:

In the agent list, click the  icon in the row in which the agent appears. The list of calls for the agent is displayed in the widget:
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Call List

To close the call list and return to the agent list:

In the upper-right corner of the My Queues widget, click  (Back).

Configuring the Widget

You can configure the height of a My Queues widget, select the columns that will be displayed in for each of the lists (queues, agents,
and calls), and configure some update and display options.

To configure a My Queues widget: 

1. In the upper-right corner of the widget, click . The widget's configurable settings are displayed.

2. 

My Queues widget settings

1. Fill in the fields as follows:

 Setting Description 

Height The height of the widget, in pixels

Choose Columns
Select the columns you want to display in each of the lists. Selected items are highlighted in blue. Hold
down the Shift or Ctrl keys to select multiple items in a list.

Automatically load
queues data 

Select this option to load the latest queue data for all the queues when the widget is opened (i.e.,
when the View tab is opened). 

Clear this option if you have a large number of queues and you don't need to see all of their data as
soon as the widget opens. In this case, only the queue names will load automatically. To load the
current data for a queue, refresh that queue (i.e., click the  on the line in which it appears).

Show agents that
completed the
quota 

Select this option to display data in the agent list for all agents included in the queue, even if the
quotas for those agents were already filled. 

Clear this option to hides agents from the agent list when their quotas have been filled.

Number of calls to
display 

Specify the maximum number of calls to display in the call list. Range: 1-100. The smaller the value,
the faster the call list will load. 

2. Click OK. The settings are implemented.
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See also

Gauge Widget
Report Widget
My Messages Widget
Recently QAed Widget
 

Home > Views > Managing Widgets > Recently QAed Widget

Recently QAed Widget

The Recently QAed widget is used by quality analysts and their supervisors to keep track of the calls that have been reviewed. The
widget displays a list of the calls that were reviewed in the specified time period, and included information about who reviewed them,
when, and, if a form was filled out by the reviewer, which form and what the score was. You can click a link to play a call in the list,
and filter the list by time period and by reviewer.

Recently QAed widget

Columns in the Interaction List

The Interaction List contains the following columns:

Column Description

Call ID The external ID of the call

Review Time The date and time at which the call was reviewed

By The user name of the reviewer

Queue The name of the queue

Form The name of the form the reviewer filled in, if any 

Score The score of the call in the form, if one was filled in 

Sorting the Columns 

You can sort the rows of the list by any of the columns.

To sort the list by a column: 

Click the column heading. (To reverse the sort order, click the column heading again.)
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Filtering the List

Filter controls are located above the Interaction List. You can filter the Interaction List by reviewer, time period, and queue.

Filtering by Reviewer

You can choose to display calls that were reviewed by any reviewer or only those calls that you reviewed yourself.

To use the reviewer filter:

In the upper-left corner of the widget, under Show, select All to view calls that were reviewed by any reviewer, or My to only
view calls you reviewed. (The option that is currently selected is unavailable.)

Filtering by Time Period

You can choose the time period from which you want to view calls by choosing the time unit (days, weeks, or months) and the
quantity of that unit (e.g., 5 hours, or 3 months). The Interaction List will only include calls that were reviewed during the selected
time period. (The time period always ends with the current date. Thus, you can view calls from the previous three months, but not
from six months ago to three months ago.)

To modify the quantity of time units:

1. Under Show Last, click the number. The number becomes a text field, and an OK button appears below it.

2. Enter the required number.

3. Click OK. The number is saved.

To modify the time units:

1. Under Show Last, click the time unit (Hours, Weeks, or Months). A time-unit dropdown list appears, with an OK button
below it.

2. Select the required time unit.

3. Click OK. The selection is saved.

Filtering by Queue

You can choose to view all the calls that were reviewed or only those that belonged to a particular queue.

To use the queue filter:

Under Queue, select the name of the queue, or select ALL to view calls from all queues.

Playing a Call

You can play a call in the list simply by clicking the ID of the call. The Media Player opens in the current Views page, above the
widget.

To play a call in the list:

Click the ID number of the call. If it is not already open, the Media Player opens at the top of the Views page. Playback begins
automatically. For information about working with the Media Player, see Using the Media Player.  
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Media Player opened in the Views page

Configuring the Widget

You can configure the height and refresh rate of a Recently QAed widget.

To configure a Recently QAed widget: 

1. In the upper-right corner of the widget, click Edit. The widget's configurable settings are displayed.

2. Fill in the fields as follows:

 Setting Description 

Height The height of the widget, in pixels

Refresh Rate How often the list should be refreshed, in minutes

3. Click Save. The settings are implemented.

4. Click Close. The settings are hidden.

 

See also

Gauge Widget
Report Widget
My Messages Widget
My Queues Widget
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Home > Action Items

Action Items

The Action Items feature is a tool that helps users manage their SpeechMiner tasks, assign tasks to others, and monitor progress on
these tasks. For example, a supervisor can create an Action Item for one of his staff members, asking him to perform a particular task
at a particular time. The staff member will see that a new task has been assigned to him when he logs into SpeechMiner. He can see
details about the task, add notes as he progresses with the task, and close the task when it is completed. The supervisor can monitor
progress on the task by reading the notes that are added as it is performed and by keeping tabs on its status.

You can create new Action Items, and view the Action Items you have created or been assigned, from any SpeechMiner screen. Action
Items can also be linked to specific Coaching sessions. If they are, you can also view them in the Coaching session page.

Viewing the List of Action Items

The Action Items link in the upper-right corner of the SpeechMiner screens provides information about the number of Action Items
assigned to you, and indicates whether any new action items exist that you have not yet read, as follows:

If no Action Items are assigned to you, the Action Items link appears in black. 

If Action Items are assigned to you, the link appears in green, and the number of Action Items appears after the link in
parentheses.

If new Action Items are assigned to you that you have not yet read, or the status of an existing Action Item has changed, the
Action Items link appears in bold green.

To view your Action Items:

1. In the upper-right corner of any SpeechMiner page, click the Action Items link. The Action Items box opens below the link.

2. Click the My Items tab to view a list of the Action Items assigned to you; click the I Created tab to view a list of the Action
Items you created.

 

Action Items box

Key to illustration:
 

Number Description 

 1 Tabs

 2 An Action Item that was already read by the assignee; status is displayed in plain text

 3 An Action Item that was not yet read by the assignee, or whose status has changed since it was last read;
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status is displayed in bold text

 4 The number of Action Items assigned to the current user

 5 Click to close the Action Items box.

 6 Click to create a new Action Item (see Creating a New Action Item).

Viewing Item Details

An Action Item appears as unread until you view the item's details. The status of unread items appears in bold. When an item is read,
its status appears in plain text.

To view an Action Item's details:

In the Action Items box, under Actions, click Details. The item's details are displayed below the item. 

 

Action Items box with item details displayed

Key to illustration:

Number Description 

 1 Close Action Items box

 2 Close Details area

 3 Details area

To close an Action Item's details:

Click the  in the upper-right corner of the Details area. 

Sorting Action Items
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You can sort the lists of Action Items by any of the columns. For example, you can sort the list by Status or Due Date.

To sort a list of Action Items:

Click the heading of the column by which you want to sort the list. For example, click the Status heading to sort by status.

Note: Click the heading a second time to reverse the order (e.g., z to a instead of a to z).

 

See also

Welcome
Getting Started
Workflows
Views
Search
Using the Media Player
Explore
Quality Monitoring
Coaching
Reports
Tools
Permalinks
Appendix A: Standard Reports
 

Home > Action Items > Managing Action Items

Managing Action Items

Both the creator and the assignee of an Action Item can modify an Action Item and add notes to it. The notes are displayed with the
item details.

When the assignee has completed an Action Item, they should change its status to Completed. The creator can then either confirm
that the item is completed or reject the change of status. When the change of status is confirmed, the item is closed and is no longer
displayed in the lists of Action Items. When the change of status is rejected, the item continues to appear in the lists. The assignee
can continue to work on the item, and change its status to Completed again later on.

Editing an Action Item

You can modify the settings of and Action Item and add notes to it as necessary. All notes are displayed when the item's details are
displayed.

To modify an Action Item and/or add a note to it:

1. In the Action Items box, under Actions, click Edit. The Action Item: Edit dialog box opens.
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Action Item: Edit dialog box

2. Modify the settings as required.

3. If you want to add a note to the Action Item, under Add Note, type the note.

4. Click Save. The dialog box closes and the changes are implemented.

Changing the Status of an Action Item to Completed

 When you have completed and Action Item that is assigned to you, you change its status to Completed.

To change the status of an Action Item to Completed:

1. In the Action Items box, under Actions, click Complete. The Action Item: Change Status from Open to
Completed dialog box opens.

Action Item: Change status from Open to Completed dialog box
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2. If you want to add a note to the Action Item, under Add Note, type the note.

3. Click Save. The dialog box closes and the status is changed. In the Action Items box, under Actions, the options Confirm
and Reject appear instead of the Complete option.

Confirming or Rejecting a Completed Action Item

When the assignee changes the status of an Action Item to Completed, the creator should either confirm that the item was properly
completed or reject the change in status in order to indicate to the assignee that more work is required to complete the item
satisfactorily.

To confirm a completed Action Item: 

1. In the Action Items box, under Actions, click Confirm. The Action Item: Change Status from Completed to
Confirmed dialog box opens.

Action Item: Change status from Completed to Confirmed dialog box

2. If you want to add a note to the Action Item, under Add Note, type the note.

3. Click Save. The dialog box closes. The Action Item is closed and removed from the list of Action Items.

To reject a completed Action Item: 

1. In the Action Items box, under Actions, click Reject. The Action Item: Change Status from Completed to
Rejected dialog box opens.
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Action Item: Change status from Completed to Rejected dialog box

2. If you want to add a note to the Action Item, under Add Note, type the note.

3. Click Save. The dialog box closes. The Action Item is reopened with the status Rejected.

  

See also

Creating a New Action Item
 

Home > Action Items > Creating a New Action Item

Creating a New Action Item

You can create new Action Items as required, and assign them to the appropriate person. If you wish, you can assign Action Items to
yourself, to help you keep track of your own tasks.

Note: Action Items can also be created as part of coaching sessions. When they are, they appear both in the general lists of Action
Items and in the Coaching session screen. For additional information, see Creating a New Coaching Session.

To create a new Action Item:

1. In the Action Items box, click New. The Action Item dialog box opens
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Action Item dialog box

2. Fill in the fields as follows: 

Field Description

Assignee
Select the assignee in one of the following ways:

In the text field, type part of the name or username of the assignee. As you type, names and user
names containing those letters are displayed in a dropdown list. Select the assignee from the list.

Click the ... button ( ) beside the text field. In the dialog box, select the user from the list of users in
the relevant workgroup.

Type Select the type of Action Item

Due Date  Click the calendar icon ( ) to select the date by which you want the assignee to perform the task.

Summary Type a description of the Action Item

3. Click Save. The Action Item is opened. It appears in your Action Items box in the I Created tab, and will appear in the
assignee's Action Items box in their My Items tab the next time they open it. 

 

See also

Managing Action Items
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Home > Search

Search

The Search page provides you with tools that help you filter massive quantities of interaction data so that you can find the data you
are interested in. Filtering can be performed in one of two ways:   

1. Searching: Creating a set of criteria and then searching for interactions or Events that meet those criteria. The set of criteria
can be saved as a Saved Search. The search can then be run again as necessary. For example, you could search for calls that
were handled by workgroup A, were processed using either Program B or Program C, and had the Category "Frustration"
assigned to them. A list of calls matching these criteria would be displayed in an Interaction Grid. 

2. Browsing: Navigating in a tree structure in which recorded interactions are divided into groups based on specified
characteristics. This method of sifting provides a visual overview of the database of interactions. You can browse through the
database by expanding nodes to see more detailed breakdowns of interactions in a particular group, by filtering the tree to limit
the display to certain types of interactions, and by viewing details about selected groups of interactions in an Interaction
Grid. For example, you could browse through the database of interactions by dividing it into groups based on the workgroups
that handled the interactions. If you expanded the nodes, you could see information about which interactions were handled by
each agent in the workgroup.  

Regardless of which sifting process you use, the end result is a list of items that is displayed in a grid. The grid lists interactions or
Events that match your search criteria and contains detailed information about each item. You can use the results in a variety of ways
and for many different purposes. For example, you can listen to selected calls, save the list of results for further use, or save selected
calls from the grid in an Interaction List for use in a coaching session. In addition, the SpeechMiner Media Player can help you find the
important parts of calls and play them back without wasting precious time listening to every second of each call.

See also

Using an Interaction Grid
Searching for Interactions
Saved Searches
Call Lists
Browsing Interactions

 

Home > Search > Using an Interaction Grid

Using an Interaction Grid

Lists of interactions are generated by SpeechMiner in the Search page when you do one of the following:

1. In the New Search tab, click Search

2. In the Saved Searches tab, click Display

3. In the Content Browser tab, click a line in the tree structure

4. Click a Permalink to a list of interactions

The list of interactions is presented in an Interaction Grid either at the bottom or the right side of the page. The Interaction Grid
contains detailed information about each interaction. You can modify the display to suit your requirements by selecting which columns
you want to include in the grid and sorting the interactions in the grid by one of the columns. If you want to listen to a call or
view other types of interactions, you can select them in the grid and they will be opened above the grid. You can also save calls in a
Call List, export calls, and send links to calls to other users. 
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Interaction Grid

Note: If you performed a search in the New Search tab, the grid may contain a list of Events instead of a list of interactions. For
additional information, see Using an Event Grid.

Columns in the Interaction Grid

The Interaction Grid can display any or all of the following columns:

Column Description 

Open An icon indicating the type of interaction (see About Calls and Interactions). Click the icon to open the interaction
above the grid.

ID A unique number assigned to the interaction in the SpeechMiner database 

External ID A unique number assigned to the interaction by the external recording or storage system 

Date/Time The start date and time of the interaction

Workgroup The workgroup of the agent who handled the interaction 

Agent The agent who handled the interaction 

Program The program that was used by SpeechMiner to analyze the interaction 

Category The Category or Categories that were assigned to the interaction. If only one Category was assigned, the name of
the Category appears. If multiple Categories were assigned, the number of Categories appears; place your mouse
pointer on the value to see a list of the Categories.

Duration The duration of the interaction, in hours:minutes:seconds 

Topic The Topic or Topics SpeechMiner identified in the interaction. If only one Topic was identified, the name of
the Topic appears. If multiple Topics were identified, the number of Topics appears. Place your mouse pointer on
the value to see a list of the Topics.

Text An excerpt from the interaction text containing a term that was included in a search . (The term must be specified in
the SpeechMiner filter group.) The term is highlighted in the excerpt.

Note: This column is only visible in Interaction Grids that contain search results from searches that included terms.

 

Additional columns may appear if specific types of interactions are included in the grid. For example, if e-mails are in the grid, the
columns Subject, Sender, Receiver, CC, and BCC appear. In addition, in some systems, additional columns can be opened for specific
types of metadata. For example, if your system stores a "Location" field for calls, a Location column can be opened whenever calls are
listed in an Interaction Grid. Because columns are added for all selected fields that are relevant to all the types of interactions included
in the grid, some columns may be blank for some interactions. For example, Duration is only defined for calls, and Sender is only
defined for e-mails. For other types of interactions, these columns are blank.

Search . 32

 

SpeechMiner ® User Guide Release 8.0 © 2013, Genesys Inc. Unauthorized Reproduction is Prohibited



Choosing the Columns to Display

You can choose which columns to display in the Interaction Grid.

To choose which columns to display in the Interaction Grid:

1. At the top of the Interaction Grid, click  Columns. A list of all the available columns opens.

List of available columns

2. Select the checkboxes beside the columns you want displayed and clear the checkboxes beside those you do not want
displayed.

3. Click OK. The list closes, and the columns are displayed in accordance with your choices. 

Sorting the Columns

You can choose to sort the Interaction Grid by any column.

To sort the Interaction Grid by a column:

Click the title of the column.

Note: Click the title a second time to reverse the sort order.

Interaction-Grid Pages

When an Interaction Grid contains a large number of items, it is divided into pages. The Page field of the page navigator at the
bottom of the grid shows which page is currently being displayed. In addition, the View information at the top-left of the grid shows
how many interactions are in the list, and which of these are displayed in the current page.

 

View information

 

Page navigator
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You can use the page navigator to go to a particular page in the list and to select the page size - the maximum number of interactions
to display in a single page. 

To navigate to a different page in an Interaction List:

In the page navigator. select one of the following:

Option Description 

 Go to the first page

Go back one page

Page Type the required page number in the field, and then press Enter.  

Go forward one page

Go to the last page

To select the page size:

In the page navigator. in the dropdown list on the right, select the page size. The available options are 10, 25, 50, and 100.  

Viewing Interaction Search Criteria

If the Interaction Grid was generated in response to a search, the upper-left corner of the Interaction Grid contains a summary of the
search criteria and settings that were employed during the search. Click the  beside the summary to expand it and see more details
about the search criteria.

In addition, if the grid was generated in response to a search for terms, the system may list a "related search" term below the search
criteria. For additional information, see Related Searches.

Furthermore, if the system determines that one or more of the search terms was spelled incorrectly, it will correct the apparent errors
and indicate this in a note below the search criteria. For additional information, see Spelling Corrections.

Opening an Interaction

You can play a call or open an interaction from the Interaction Grid. The interactions are opened above the Interaction Grid.

To open an interaction:

In the Open column, click the icon of the interaction. For example, to open a call, click the . If the interaction is a call, the
Media Player opens above the grid, and the call automatically begins to play. If it is a non-call interaction, the text of the
interaction is displayed above the grid.

To open the previous or next interaction in the grid:

At the top of the grid, click  Prev or  Next.

Exporting Calls

If you want to save some or all of the call results, or send them to someone else, you can export them. Exporting calls from the
Interaction Grid creates a ZIP file that contains the following:

A CSV file containing a list of the calls that were exported, including all the information about the calls that was presented in
the Interaction Grid. This file can be opened using a spreadsheet application such as Microsoft Excel.

A WAV file for each call included in the list (optional). The WAV file is a playable audio file of the call.

Note: Only calls can be exported. 

To export one or more calls from the Interaction Grid:

1. Select the checkbox to the left of each call you want to include in the export file. To select all of the calls in the grid, select the
checkbox in the column title.
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Note: If you select both calls and other types of interactions, the calls are exported, but the other interactions are not. If
you only select non-call interactions, no action is performed.

2. Under Batch Actions, select Export. A dialog box opens and asks if you want to include the audio files with the export.

3. Select Yes if you want to export the audio along with the CSV file, or No if you only want the CSV file. A dialog box opens and
asks if you want to open or save the ZIP file.

4. Select the desired option. If you select Open, the file opens in the application that is configured to open ZIP files on your
computer. If you select Save, a Save As dialog box opens.

5. If you selected Save, navigate to the folder in which you want to save the file, and then click Save. The file is saved in the
selected location.

Forwarding Links to Calls

You can send links to calls to other users in the system. Each call link is sent in a separate Call message that appears in the
recipient's My Messages widget in the Views page. When the recipient clicks the message, a SpeechMiner Media Player window opens
and plays the call.

If you wish, you can also send the recipient an e-mail notification with links to the selected calls. When the recipient clicks a link, the
Media Player opens in a new browser tab or window and plays the call. If the recipient is not already logged into SpeechMiner, they
are prompted to do so before the Media Player opens.

Note: Only calls can be forwarded. 

To send a call link to another user:

1. Select the checkbox to the left of each call you want to forward. To select all of the calls in the grid, select the checkbox in the
column title.

Note: If you select both calls and other types of interactions, the calls are forwarded, but the other interactions are not. If
you only select non-call interactions, no action is performed.

2. Under Batch Actions, select Forward. A dialog box opens.

Forward dialog box

3. Under Subject, modify the subject text if you wish. 

4. Under Please Select the Recipient, select the user you want to send the link to, in one of the following ways:

In the text field, type part of the name or username of the recipient. As you type, names and user names containing
those letters are displayed in a dropdown list. Select the recipient from the list.

Click the ... button ( ) beside the text field. In the dialog box, select the user from the list of users in the relevant
workgroup.

5. If you want to send notifications to the user's e-mail address as well as to their My Messages box, select Send Email
Notification.

6. Click Send. A Call message is sent to the recipient's My Messages box for each call you selected. If you chose to send the user
an e-mail notification, an e-mail is also sent for each call.   

Adding Calls to a Call List 

A Call List is a list of calls that is saved for later use. SpeechMiner supports two types of Call Lists: global Call Lists and coaching-
session Call Lists. You can see existing global Call Lists in the Search page in the Call Lists tab, under Call Lists. Coaching-session
Call Lists can only be viewed within the coaching session. For additional information about coaching sessions, see Coaching.

You can add calls to an existing Call List or a new list. You can select an existing Call List from a list of global Call Lists or select a
coaching-session Call List from those that are attached to the Coaching session. If you wish, you can add a new Coaching session
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directly from the Interaction Grid, and then add calls to a Call List that is attached to that session.

Note: Only calls can be added to a Call List. 

To add calls to a Call List: 

1. Select the checkbox to the left of each call you want to include in the Call List. To select all of the calls in the grid, select the
checkbox in the column title.

Note: If you select both calls and other types of interactions, the calls are included in the Call List, but the other interactions
are not. If you only select non-call interactions, no action is performed.

2. Under Batch Actions, select Add To, and then select one of the following:

To Select Result 

Create a new Coaching session
and a new coaching Call List
within that session, and add the
calls to the new Call List

Coaching >
New

A New coaching session dialog box opens. Specify the
name and other settings of the Coaching session, and then
click Save. The dialog box closes, and a new Call List dialog
box opens. 

In the text field, type a name for the Call List, and then click
OK. The Coaching session and Call List are created, and the
calls are added to the Call List.

Create a new coaching Call List
within an existing Coaching
session, and add the calls to the
new Call List

Coaching >
[existing
Coaching
session] > New

A Call List dialog box opens. In the text field, type a name for
the Call List, and then click OK. The new coaching Call List is
created and attached to the Coaching session, and the calls
are added to the Call List.

Add the calls to an existing
coaching Call List that is attached
to an existing Coaching session

Coaching >
[existing
Coaching
session] >
[existing Call
List]

The calls are added to the selected coaching Call List.

Add the calls to a new Call List Call List > New A Call List dialog box opens. In the text field, type a name for
the Call List, and then click OK. The new Call List is created
and the calls are added to it.

Add the calls to an existing Call
List

 Call List>
[existing Call
List]

 The calls are added to the selected Call List.

  

See also

Searching for Interactions
Saved Searches
Call Lists
Browsing Interactions
 

Home > Search > Searching for Interactions

Searching for Interactions

This section explains how to search for interactions or Events by specifying their parameters. In order to perform a search, you use
filters to specify which types of interactions or Events you want to see. When you run the search, SpeechMiner combs the database
for interactions that match the filter settings you selected, and displays the results in a grid. You can sort the results by date or by
relevance (how well the item matches the search parameters).
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Search criteria are defined in the New Search tab, in the Filter Panel. Once you have defined the criteria, you can run the search and
see the results in a grid that appears in the New Search tab, to the right of the Filter Panel. If you wish, you can then hide the Filter
Panel, to make more room for the results grid.

You can also perform a search for terms using the Search box. This box is available in all SpeechMiner screens, and can be used
without opening the New Search tab.

Sets of search criteria can be saved as Saved Searches or Queues, and can then easily be used again. A Permalink to a set of search
criteria can also be created, and, in addition, search results can be exported.

To open the New Search tab:

In the Main Menu, under Search, select New Search. The New Search tab opens.

New Search tab 

Key to Illustration:

Number Description 

 1 Filter Panel (see Defining Search Criteria)

 2 Hide Filter Panel button (see Performing a Search)

 3 Select sorting method (see Performing a Search)

 4 Select grid type (see Performing a Search)

 5 Switch to Text Mode button (see Using Text Mode)

 6 Filter summary (see Defining Search Criteria)

 7 Search results grid (see Performing a Search)

 8 Expanded filter set (see Defining Search Criteria)

 9 Collapsed filter set (see Defining Search Criteria)
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See also

Using an Interaction Grid
Saved Searches
Call Lists
Browsing Interactions
 

Home > Search > Searching for Interactions > Defining Search Criteria

Defining Search Criteria

Search criteria are specified in the Filter Panel by selecting values for the various filters available. In order to make it easier for you to
find the filters you need, most of them are grouped into sets. You can expand the sets to access the filters they contain, and collapse
them when you do not want to view them. Most filters provide Multi-Select boxes that enable you to select multiple values for the
filter. In addition, some filters allow you to create multiple sets of values; the conditions specified in each set of values must be met
for a call to be included in the search results.

The currently defined search criteria are always displayed at the top of the right panel of the New Search tab (no. 6 in the
illustration above). As you add conditions to the search criteria, the display is automatically updated, so you can always see what the
current selections are.

You can save the current set of search criteria in a number of ways: as a Saved Search, as a Permalink, or as a queue.

Note: The Filter Panel can be used in one of two modes, Standard mode and Text mode. This section explains how to use the Filter
Panel in Standard mode. For information about using Text mode, see Using Text Mode.

Filter Groups

The filters in the Filter Panel are divided into groups. The basic settings - interaction types, languages, date range, and processing
limit - appear at the top of the Filter Panel and are always displayed when the Filter Panel is displayed. The other groups of filters can
be expanded or collapsed. The following groups of filters are available:

Filter Group Description 

SpeechMiner Filters for selecting the Categories and Programs of calls, and/or the Topics and terms that must be found in
them

Call Properties Filters that allow you to select agents, call length, and external call ID properties

Metadata Filters for selecting metadata values

User Actions Filters for finding calls that have user comments, were played back by users, about which forms were filled
out, or quality checking was performed

Audit and
Implementation

Filters for finding Events based on their confidence ratings and auditing results

Note: This group only appears if the Events grid type is selected.

Expanding and Collapsing Filter Groups 

You can expand or collapse a single group, or all of the groups.
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Expanded and collapsed filter groups

To expand or collapse all of the groups:

 Click Expand All or Collapse All (no. 1 in the illustration above).

To expand a single group of filters:

Click the name of the group or the  beside it (no. 3 in the illustration above). 

To collapse a single group of filters:

Click the name of the group or the  beside it (no. 2 in the illustration above). 

Using Multi-Select Boxes

Many of the filters allow you to select more than one item. For example, you can select three Categories to include in your search. A

specially designed Multi-Select box enables you to select the items you require for each filter. The  symbol beside a field indicates
that selections for the field are made using the Multi-Select box.

Note: The logical relationship between all items selected in a single Multi-Select box is OR. That is, if any of the items is found to be
true for a call, the call is considered to have met the specified condition. If you want to define an AND relationship between two or
more items, you must add additional lines to the field, as explained below.

Two types of Multi-Select boxes exist: Standard Multi-Select boxes and Agent Multi-Select boxes. Standard Multi-Select boxes are
used for all multiple-selection tasks except the selection of agents and workgroups. The Agent Multi-Select box was specifically
designed to make selecting agents simple and efficient.

Standard Multi-Select box

 To select items for a field using a Standard Multi-Select box:
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1. Click the  beside the field. The Multi-Select box opens below the field.

2. Select the checkbox beside each item you want to select. If necessary, expand an item to select one or more of the items it
contains. Use the dropdown menu to select all items or all of the sub-items of an item. Use the Find feature and the Selected
display option to help you find the items you need and keep track of what you have selected. For additional information, see
below.

3. Click outside of the Multi-Selector box, or, at the top of the box, click Close. The Multi-Select box closes. The text field indicates
how many items were selected. Place your mouse over the text field to see a list of the selected items.

Agent Multi-Select boxes allow you to quickly and easily find and select individual agents or groups of agents. The expandable list on
the left contains all available workgroups and agents. The list on the right shows the agents and workgroups that are currently
selected.

Agent Multi-Select box

 To select agents or workgroups using an Agent Multi-Select box:

1. Click the  beside the Agents field. The Agent Multi-Select box opens below the field.

2. In the left column, select the checkbox beside each workgroup or agent you want to select. If necessary, expand a workgroup
to select one or more of the agents it contains. Use the dropdown menu to select all items or all of the sub-items of an item.
Use the Find feature to help you find the items you need.

3. Click Add. The selected workgroups and agents are added to the list on the right.

4. Repeat the previous two steps as necessary to add additional workgroups or agents to the list.

5. Click outside of the Multi-Selector box, or, at the top of the box, click Close. The Agent Multi-Select box closes. The text field
indicates how many items were selected. Place your mouse over the text field to see a list of the selected items.

Expanding and Collapsing Items

The list of items in a Multi-Select box has a tree structure. When an item contains other items, a  or  appears to the left of that
item's checkbox. You can expand an item to see and select the items it contains, or collapse an expanded item if you do not want to
display its contents. You can also expand or collapse all of the items in the list.

To expand an item:

Click the  beside the item.

To collapse an expanded item:

Click the  beside the item.

To expand all of the items in the list:

Right-click any item in the list, and then select Expand All.

To collapse all of the items in the list:

Right-click any item in the list, and then select Collapse All.
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Selecting Groups of Items

You can select all of the items in the list, or all of the sub-items of an item in the list. You can also clear all selections or all selections
of an item's sub-items.

To select all of the items in the list:

Right-click any item in the list, and then select Check All.

To select all of the sub-items of an item in the list:

Right-click the item, and then select Check SubTree.

To clear all selections in the list:

Right-click any item in the list, and then select Uncheck All.

To clear all selections of an item's sub-items:

Right-click the item, and then select Uncheck SubTree.

Using Find to Locate an Item in the List

To help you find items in the list quickly, the Multi-Select box contains a Find option. This option enables you to filter the list so that it
only displays items that include the sequence of letters you specify.

To use the Find option:

At the top of the Multi-Select box, in the Find field, type a letter or sequence of letters that appears in the item you are looking
for. The list is filtered as you type; only those items that contain the sequence you typed are displayed.

Displaying Selected Items Only

In the Standard Multi-Select box, you can choose to display only those items that are currently selected.

To display only those items that are currently selected:

At the top of the Standard Multi-Select box, click Selected.

To switch back to display of all items:

At the top of the Standard Multi-Select box, click All.

Removing Items from the List of Selected Agents

In the Agent Multi-Select box, you can remove items from the list of selected agents in the right column as required.

To remove items from the list of selected agents:

1. In the list of selected agents, select the workgroups and agents you want to remove. Hold down the Ctrl key to select multiple
items, or the Shift key to select a group of adjacent items (by selecting the first and last item in the group).

2. Click Remove. The items are removed from the list.

Negative Conditions

By default, a condition is met when one or more of the items selected for a field are true found in a call or are true for a call. You
can also choose to define negative conditions for many fields. When you define a negative condition, the condition is met when none
of the items selected for the field are found in the call or are true for the call. For example, you can choose to find all calls to which
Categories A, B, and C do not apply.

When it is possible to define a negative condition for a field, a Not ( ) button appears to the left of the field.

To define a negative condition for a field:
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1. Click the  button beside the field. The button is turned on, and looks like this .

2. Select the conditions for the field as usual. These are the conditions that a call must not fulfill in order to be included in the
search results.

Adding a Line to a Filter

When you select multiple items in a Multi-Select box, an OR logical relationship is defined between the items. For example, if you
select two Categories, a call that belongs to either of the two Categories meets the condition. If you want to define multiple conditions
that must all be met in order for a call to be included in the search results, you must define each of the conditions in a separate line.
For example, if you want to find calls that belong both to Category A and to Category B, you have to select Category A in the first field
of the Category, then add a new line to the Category filter and select Category B in the new field it contains. 

To add a line to a filter:

Click the  to the right an existing line in the filter. A new line is added below the existing line, with the word And at the
beginning of the line. 

 

New line added to filter

Available Filters

This section explains the filters that are available in each filter group.

General Filters

The general filters, which appear at the top of the Filter Panel, are always visible. The following filters are in this group:

Filter Description 

Interaction
Type 

Select the types of interactions to include in the search.

Note: This set of filters is not displayed if your system only includes calls (see About Calls and Interactions).  

Language Select the language or languages of the calls you want to include in the search.

Note: In some systems, some or all calls do not undergo speech-recognition processing. In these systems, the
option No Speech Recognition appears in the list of Languages. Select this value to include calls that did not
undergo speech recognition processing. 

Note: This set of filters is not displayed if your system only includes one language, and all calls undergo
speech-recognition processing.

Date Range Select the range of dates to include in the search. The following options are available:

All: This is the default value, which includes all calls in the database.

Yesterday: Filters calls recorded on the previous day from 00:00 until 23:59.

Today: Filters calls recorded on the same day from 00:00 until the exact time the search is performed.

Week to Date: Filters calls recorded from the beginning of the current week (the last Sunday at
00:00) until the exact time and date the search is performed. Note: In the U.S., the week starts on
Sundays and ends on Saturdays; for users with Europe-localized versions of the software, the week
starts on Mondays and ends on Sundays.

Last 7 Days: Filters calls from seven days prior to today (at 0:00) until the exact time and date the
search is performed.

Last Week: Filters calls from the beginning through the end of the previous week.

Month to Date: Filters calls from the first day of the current month at 00:00 until the exact time and
date the search is performed.

Last 30 Days: Filters calls from thirty days prior to today (at 00:00) until the exact time and date the
search is performed.
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Last Month: Filters calls from 00:00 on the first day until 23:59 on the last day of the previous month.

Quarter to Date: Filters calls from 00:00 on the first day of the current quarter until the exact time
and date the search is performed.

Last 90 Days: Filters calls from 90 days prior to today (at 00:00) until the exact time and date the
search is performed.

Last Quarter: Filters calls from 00:00 on the first day until 23:59 on the last day of the previous
quarter.

Custom: Filters calls from any date range selected from the two drop-down windows displayed. You
can specify the exact day, month, and year of both the beginning and ending dates.

Note: The times given are for the time zone where your Web server is deployed, and therefore are not
necessarily the same as the times where you are physically located.

Limit Processing Specify the maximum number of calls to reprocess when Active Search is selected. 

Note: If you do not have the required permissions, this field is not visible. In this case, the processing limit is
fixed and you cannot change it.

SpeechMiner Filters

The SpeechMiner filter group includes the following filters:

Filter Description 

Categories Select one or more Categories. Only calls in which at least one of these Categories was identified are included in
the search results. If you add lines to the filter, only calls that meet the conditions of all the lines are included.

Programs Select one or more Programs. Only calls that were analyzed using one of these Programs are included in the
search results. Since no call can belong to more than one program, you cannot add additional lines to this filter.

Topics Select one or more Topics. Only calls in which at least one of these Topics was identified are included in the search
results. If you add lines to the filter, only calls that meet the conditions of all the lines are included.

Any of the
following
terms

Define a list of one or more terms (words or phrases) that must be in the call. Multiple terms should be separated
by pressing Enter to place them on different lines. Calls containing any of the terms are included in the results of
the search. An excerpt from the text of the call in which the term appears is displayed in the Interaction Grid in
the Text column. 

If you add text boxes to the filter (by clicking the  beside an existing text box), only calls that meet the conditions
in all the text boxes are included.

Limit Terms
and Topics
to Speaker
Types 

Select one or more Speaker Types from the list. Only calls in which the Topics and terms specified in the search
filters were found in one of the following situations are included in the search results:

For calls with only one audio channel (in which the system cannot identify who is speaking at any particular
time in the call): At least one of the selected Speaker Types were involved in the call. For example, the
Topic "Payments" was found at least once in the call, and one of the participants in the call was a speaker of
type "Agent."

For calls with more than one audio channel (which allows the system to identify who is speaking at every
moment in the call): At least one of the selected Speaker Types mentioned the required Topics and/or
terms at least once in the call. For example, the "Agent" in the call talked about the Topic "payments." 

Call Properties Filters

The Call Properties filter group includes the following filters:

Filter Description 

Agents Select any combination of agents and workgroups. If you select a workgroup, all the agents in the workgroup are
included in the search condition. 

You can also choose to search for the "current user" rather than a specific agent or workgroup. In this case, when the
search runs, the condition changes depending on which user runs it. For example, if the user is agent 12, the search
results will only include calls that were handled by agent 12. If the user is a manager, the "current user" option includes
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data for the entire workgroup. This option is useful if you want to save the search criteria and share them with other
users so they can run the search themselves on their own calls (see Saved Searches).

Note: The "current user" feature will only work if the user's profile includes a mapping. For additional information about
user profiles and mapping users to agents or workgroups, see Managing Users.

Call
Length

Select the range of call durations to include in the search: In the first field, select either Less Than, Between, or
More Than. In the second text field or fields, fill in the number of seconds. If you selected Less Than, only calls that
are shorter than the value you specified are included in the search. If you selected Between, calls whose durations are
more than the first value and less than the second value are included in the search. If you selected More Than, only
calls that are longer than the value you specified are included in the search.  

Call
External
ID 

Type any portion of a call's external ID; any calls whose external IDs include the characters you specify are included in
the results. 

You can use the * character as a wildcard. Place it at the beginning or end of a sequence of characters to indicate that
at least one other character must be in that position in the sequence. For example, type *123 to specify external IDs
that begin with any sequence, but end with 123, or type 123* to specify external IDs that begin with 123 and end
with any other sequence of characters.

Metadata Filters

Metadata is collected by the recording system and relayed by it to SpeechMiner. The types of available metadata vary from system to
system.

You can define one or more metadata conditions to apply to the search results. The search results will only include calls for which the
selected types of metadata have values defined, and, if you specify values or a range of values, for which the values match the
specified conditions. 

Three types of metadata values can be used in the conditions you define: a string of text (e.g., "Detroit"), a decimal number (e.g.,
"10" or "32.5"), and a date. Dates must be entered manually in the format that is used in your SpeechMiner web interface. For
example, if your system represents dates in this format: mm/dd/yyyy hh:mm, you would enter Oct 24, 2013 at 10 AM as 10/24/2013 10:00.

(The format used in your system is specified in the webserviceparams table, in the globalDateFormat parameter. For additional
information, please consult your system administrator.) 

To define a metadata filter:

1. In the Name field, select one of the available types of metadata.

Note: If you only want to specify that the calls must have values for the specified type of metadata, but any value is acceptible,
you only have to select the name of the metadata type; you do not have to perform any of the steps below. 

2. If you want to specify a value or range of values for the selected type of metadata, select . A box opens in which you can
define the values.

3. In the first field, select Equal To if you want to specify a specific value for the type of metadata, or Between, if you want to
define a range of values. If you select Between, a third field is added to the box.

4. If you selected Equal To, in the second field, type the required value. If you selected Between, in the other two fields, enter
the range of values.

Note: If you want to define a range that is greater than a specified value, enter the value in the first field. If you want to define
a range that is less than a specified value, enter the value in the second field.

5. To add an additional OR condition on this type of metadata value, click the  to add a line in the box, and fill it in as explained
above.

6. Click the  as necessary to add additional OR conditions.

7. Select Close to close the box.

8. To convert the condition into a negative condition (i.e., to exclude calls with the specified metadata values from the data set),

in the Filter panel, select the Not ( ) button to the left of the condition. 

Search . 44

 

SpeechMiner ® User Guide Release 8.0 © 2013, Genesys Inc. Unauthorized Reproduction is Prohibited



9. To add an additional AND metadata condition, either on the same type of metadata or on a different type, in the Filter panel,
beside the Name field, click the . A new line is added to the metadata conditions. Follow the steps above to specify
the values for this condition.

10. Click the  as necessary to add additional AND conditions.

User Actions Filters

User Action filters let you search for calls based on how SpeechMiner users interacted with them after they were recorded.

Filter Description 

Call
Comment:
Text

Specify text that must appear in a comment that a user added to a call. Only calls that contain comments in which
this text is found are included in the search results. If you leave this field blank, calls that contain comments from the
users selected in the next field are included in the search results, regardless of the contents of the comments.

Call
Comment:
User

Select the users who must have added comments to a call. Only calls that contain comments from the selected
users are included in the search results. 

Call
Playback
By 

Select the users who must have played a call. Only calls that were played back by the selected users are included in
the search results. 

Form
Filled By

Select the users who must have filled in a feedback form about a call. Only calls for which forms were filled in by the
selected users are included in the search results

Quality
Checked
By 

Select the users who must have checked the quality of a call. Only calls whose quality was checked by the selected
users are included in the search results 

Audit and Implementation Filters

If the Events grid type is selected, this filter group appears in the Filter Panel. The group includes the following filters:

Filter Description 

Confidence
threshold 

Select the minimum Confidence value required. Only Events whose Confidence values are at least this high are
included in the search results.

Note: The Confidence value is generated by SpeechMiner during call processing. It indicates how reliable the
identification of the Event is; the higher the value, the greater the degree of certainty.

Term ID Specify the ID number of a term that is included in a Topic.

Note: This field only appears if you have Event Audit permissions.

Note: The Term ID of each term that is found during a search appears in the Event Grid.

Exclude
audited events

Select this checkbox to exclude calls that have already been audited from the search.

TP, FP, SFP Select the audit ratings required. Only audited Events whose ratings match one of the selected types are included
in the search results. 

 

Saving the Query
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After you have selected your search criteria, you can save the criteria in the system as a Saved Search. Then if you want to run the
search again, you can do so without redefining the criteria. Saved Searches can be accessed in the Saved Searches tab. They can
also be attached to Coaching sessions.

To save your search criteria as a Saved Search:

1. At the top of the Filter Panel, click Save. You are prompted to provide a name for the query.

2. In the text field, type a name for the query and then click OK. The search criteria are saved as a Saved Search, and the name
you specified appears at the top of the search form. 

If you opened the search criteria by selecting a Saved Search in the Saved Searches tab, you can choose either to save the current
search criteria with the same name or as a new Saved Search with a new name. In this case, in addition to the Save option, a Save
as option appears at the top of the Filter Panel. If you click Save, the search criteria are saved under the original name; if you click
Save as, you are prompted to provide a name for the new query.

Generating a Link to the Query

After you have selected your search criteria, you can generate and save a Permalink to the query. To run the search again, you need
only open the link in a browser.

Note: For additional information, see Permalinks.

To create a Permalink to the current search criteria:

At the top of the Filter Panel, select Permalink. A Permalink dialog box opens and displays the Permalink.

Saving the Query as a Queue

You can save the current search criteria as a queue for Quality Monitoring. When you do, the queue appears in your Queues
screen and your My Queues widget. For a detailed description of this feature, see Quality Monitoring.

To save the current search criteria as a quality-monitoring queue:

1. At the upper-right of the screen, click Save As Queue. A New Queue dialog box opens.

2. Fill in the dialog box. (For additional information, see Quality Monitoring.)

3. Click Save. The search criteria are saved as a queue.

Deleting Filter Conditions

You can clear all of the filter conditions in order to begin defining new conditions from scratch..

To clear all the filter conditions:

1. At the top of the Filter Panel, click Clear Filters. You are prompted to confirm that you want to delete all of the currently
defined filters.

2. Click Yes. The filters are cleared.

 

See also

Using Text Mode
Performing a Search
Using an Event Grid
Performing a Quick Search for Terms
Exploring Terms with a Custom Data Set
Comparing Two Data Sets
 

Home > Search > Searching for Interactions > Using Text Mode

Using Text Mode
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Search criteria can be specified in the Filter Panel in one of two modes: 

Standard mode: The user selects options from lists in each filter category

Text mode: The user types the search criteria in a text box using a specified syntax 

In general, Standard mode is easier to use. In addition, it includes the full range of search options available, while Text mode only
includes the more basic options. However, in some cases, Super Users who know exactly what they want to include in their search
criteria may find it faster to type the criteria in Text mode.

Filter Panel in Text mode 

You can switch back and forth between the two modes while you are in the process of defining search criteria. The display in each
mode is automatically updated to include the changes that were made in the other mode.

This section explains how to use Text mode. For information about using Standard mode, see Defining Search Criteria.

Switching to and from Text Mode

You can open Text mode at any time while you are defining search criteria. The criteria that are currently selected are displayed in
both modes.

To switch into Text mode:

At the upper-right corner of the Filter Panel, click .

To switch into Standard mode:

At the upper-right corner of the Filter Panel, click .

Defining a Filter Condition in Text Mode

You define filter conditions by typing the code for the type of filter and selecting the condition from a dropdown menu.

Filter Codes

You can use the following codes in Text mode:

Code Description 

 T Topic

 C Category

 D Date

 CD Custom Date
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 L Language

Inserting Filter Conditions

You can insert one language and one date condition, and multiple Category and Topic conditions. Each Category and Topic condition
can also include multiple items. The logical relationship between items within a single condition is OR - if any of the items are in the
call, the call will be included in the search results. The logical relationship between separate conditions is AND - only calls that meet
both conditions are included in the search results.

1. In the text field, type the code of the type of filter you want to use, followed by a colon (:). A dropdown menu (or date and time
selectors, if you type the CD code) opens and displays a list of the available options for the filter.

 

Dropdown menu for the Topics option (code T).

Date and time selectors for the Custom Date option (code CD)

2. Select the required option from the list. The dropdown menu closes and the option appears in the text field.
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Note: To filter the list, begin typing a sequence of characters that appear in the name of the option. Only those options that
contain the specified sequence of characters are displayed.

3. For the Categories and Topics filters, if you want to add an additional selection to the filter, type a comma (,). The relevant
dropdown menu opens again. Select the additional option as explained above. 

4. To add another filter condition, press Enter and then repeat the steps above.

Note: You can insert multiple Category and Topic filter conditions. The search results will only include calls or Events that
match all of the filter conditions. For example, if you insert two Category conditions, C:Accounting and C:Short Calls,

only calls that are in both Categories are included in the search results. Note, however, that within a single filter condition, if
you select multiple items, the logical relationship between the items is OR. That is, if any of the items is found in a call, the call
is included in the search results. For example, if you insert one condition, C:Accounting, Short Calls,  calls that are in

either Category are included in the search results.

Deleting Filter Conditions

You can delete filter conditions as necessary by editing the text field. In addition, you can clear all of the filter conditions. Note that if
you clear all filter conditions, even conditions that are only visible in Standard mode, and cannot be seen in Text mode, are deleted.

To delete a filter condition:

Select the condition and press Delete. 

To clear all the filter conditions:

1. At the top of the Filter Panel, click Clear Filters. You are prompted to confirm that you want to delete all of the currently
defined filters (including those that are not currently visible).

2. Click Yes. The filters are cleared.

 

See also

Defining Search Criteria
Performing a Search
Using an Event Grid
Performing a Quick Search for Terms
Exploring Terms with a Custom Data Set
Comparing Two Data Sets
 

Home > Search > Searching for Interactions > Performing a Search

Performing a Search

Once you have selected the required parameter values for a Search, as explained under Defining Search Criteria, you can perform a
search. The search results are displayed in a grid on the right side of the screen. The grid is sorted either by relevance or by date,
depending on the sorting method that was selected when you initiated the search. It either contains a list of interactions (Interaction
Grid) or a list of Events (Event Grid), depending on which grid type was selected. You can change the sorting method whenever you
wish. If the search included Topics or terms, you can also change the grid type. In addition, after you run a search, you can hide the
Filter Panel, to make more room for the display of the search results.

Note: You can export or forward calls from the list of search results, or add the calls to a Call List. For additional information about
these options, see Using an Interaction Grid.

To perform a search:

At either the top or the bottom of the Filter Panel, click Search. The search is performed, and the results are displayed in a
grid to the right of the panel.

Choosing the Sorting Method

During a search, SpeechMiner continues searching for items that match your search criteria until one of two things occurs:
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All the items in the database are checked for matches with the search criteria.

The processing limit (defined in the system's database configuration settings) is reached. For example, if the processing limit is
1000, the first 1000 calls that match the search criteria are retrieved and the search ends.

You can choose the sorting method that is employed during the search. This can be significant if the database contains more items
that match your search criteria than the processing limit. Two sorting methods are available:

By date: The newest items that match your search criteria are retrieved

By relevance: The items that most closely match your search criteria are retrieved 

Note: Initially, the search results are sorted in the grid based on the sorting method. You can then choose to sort the results based on
any column (see Sorting the Columns). Sorting by column changes the order in which the items that were found are displayed, but
does not affect which items are included in the list. When you choose a sorting method, the items that are included in the list may be
effected.    

The current sorting method appears as plain text at the top of the grid. Beside it is a link that activates the alternative method. (See
#3 in the illustration above, in which the current selection is Sort by date.)

To choose the sorting method of the search:

At the top of the grid, select Sort by date to retrieve calls in chronological order, or Sort by relevance to retrieve calls in
order of relevance. The search runs again, and the new results appear in the grid.

Choosing the Grid Type

When a search includes Terms, Topics, and/or Term IDs, the results can be displayed as a list of interactions or as a list of
Events. When the grid contains a list of interactions, it offers the standard functionality of the Interaction Grid. You can use it to open
interactions, export them, save them in interaction lists, etc. When the grid contains a list of Events, the columns of the grid are
somewhat different from those of the Interaction Grid, and the functionality available is also slightly different, as explained under Using
an Event Grid.

The current grid type appears as plain text at the top of the grid. Beside it is a link that activates the alternative method. (See #4 in
the illustration above, in which the current selection is Interactions.)

Note: Searches for Events can only be performed on calls. Other types of interactions are not included in Event searches.

To change the grid from a list of interactions to a list of Events or vice versa:

At the top of the grid, select Events to view a list of Events or Interactions to view a list of interactions. The search runs
again, and the new results appear in the grid.

Related Searches

When a search includes Terms, the results may include a "related search" that is suggested by the system. For example, if you search
for the term "order," the list of results includes interactions in which "order" appears. If the system finds that another term is often
found in these same interactions, it may suggest a new search for interactions in which both terms appear. In the example below, the
system has found that the term "within" is related to "order" in this way, and suggests performing a search for interactions in which
both "order" and "within" appear.

When the system suggests a related search, the suggestion appears above the Interaction Grid after the initial search is performed.
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Related-search suggestion

To run a related search:

In the related-search suggestion, click the suggested term or terms. (For example, click the "order within" link.) The search
runs and the results are displayed in an Interaction Grid.
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Related-search results

Spelling Corrections

When a search includes Terms, the system may determine that one or more of the terms was spelled incorrectly. In this case, it
attempts to correct the apparent errors, and performs the search using the corrected terms. When this occurs, the spelling correction
is indicated by a note above the Interaction Grid.
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Spelling corrected

To repeat the search with the original terms you typed:

In the spelling-correction note, click the original terms.

Active Search

You can choose to reprocess calls in order to see if they contain terms that were not sought in their original processing. When you do
this, SpeechMiner reprocesses the calls and, as it does so, it gives added weight to the terms listed in the Terms field of the search
form. This helps to ensure that more occurences of the term will be found if they exist. Reprocessing is performed after an initial
search for the required terms has been performed using the results of the original call processing.

To reprocess calls: 

1. Type the terms you want to search for in the Terms field.

2. Fill in the other search parameters as required.

Note: If the Language filter appears in the Filter Panel, make sure to select one of the languages. Active Search is not
available unless a language is selected.

3. Click Search. The search is performed and the results appear in the grid on the right side of the screen.

4. At the upper-right of the grid, click Active Search. A dialog box opens and prompts you to provide a name for your new
query.

5. Type a name for the query, and then click OK. The query begins to run, and is also saved as a Saved Search. When the
processing of the query is completed, the results appear in the grid.

Note: you can see the status of the Active Search as it runs in the Saved Search screen.
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Hiding the Filter Panel

After you specify search criteria and run a search, you may want to hide the Filter Panel while you are working with the search
results, because this will allow you to use a larger portion of the screen for the interaction grid.

Filter Panel hidden

To hide the Filter Panel:

At the upper-right of the Filter Panel, click .

To display the Filter Panel when it is hidden:

On the left side of the screen, click .

 

See also

Defining Search Criteria
Using Text Mode
Using an Event Grid
Performing a Quick Search for Terms
Exploring Terms with a Custom Data Set
Comparing Two Data Sets
 

Home > Search > Searching for Interactions > Using an Event Grid

Using an Event Grid

When you search for calls by Event, the results are presented in an Event Grid. The Event Grid is identical in structure to an Interaction
Grid, but it differs in a number of ways:

The items listed in an Event Grid are Events, not calls. Thus, the same call may appear more than once in the grid, if Events
matching the search criteria are found in it multiple times.
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The columns of an Event Grid are different from the columns of an Interaction Grid.

When you play back an Event that is in the grid, the entire call in which the Event was found is opened in the Media Player, but
playback begins at the beginning of the Event.

Events can be audited in an Event Grid.

Only calls are included in Event searches; other types of interactions never appear in Event Grids.

This section describes the columns of Event Grids, and explains how to audit Events. For general information about the functionality
of Event Grids, including information about choosing which columns to display and choosing a column to sort the list by, see Using an
Interaction Grid.

Event Grid 

Columns in an Event Grid

The Event Grid can display any or all of the columns listed below. In addition, Event Grids may contain additional columns in which
metadata specific to your system is displayed.

Column Description 

Open A Play ( ) button; clicking the button opens the call in the Media Player. 

TP/FP If the Event has been audited, one of the following values is selected, and the entire cell is color-coded:

TP: True Positive, color-coded green
FP: False Positive, color-coded peach
SFP: Sense False Positive, color-coded pink

If you have Event Auditor permissions, you can select a value in this column. To select a value, click it. To clear the
selection, click Clear.

Note: If you selected Exclude events that have been audited before you initiated your search, previously
audited Events will not appear in the grid.

Text If the Event was a linguistic event, the text of the Event

Confidence A value indicating how reliable the identification of Events in the call is. The higher the number, the greater the
degree of certainty. You can use this information to choose calls for auditing. Sort the list by this column (by clicking
in the column title) and select those calls whose Confidence value is below a certain threshold.

Note: This number is not a percentage, but it does range from 1 to 100.

Start Time The start time of the Event, offset from the start of the call, in hours:minutes:seconds

End Time The end time of the Event, offset from the start of the call, in hours:minutes:seconds
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Term ID The ID number of the term that was identified in the Topic

Resource
Name

The name of the Topic corresponding to the Event

Agent The agent who handled the call 

Date/Time The start date and time (in hours:minutes) of the call

Program The program that was used to process the call 

External ID A unique number assigned to the call by the external recording system 

ID A unique number assigned to the call by SpeechMiner

Auditor If the Event was audited, the name of the auditor

Auditing an Event

Each linguistic Event that is recognized in a call can be audited. This means that a SpeechMiner user listens to the Event and then
rates the accuracy of the identification. Auditing is an important part of fine-tuning the SpeechMiner's speech-recognition accuracy.

In order to audit an Event, the auditor listens to the Event, and then rates the accuracy of the Event recognition by selecting one of the
following values in the TP/FP column of the Event Grid.:

TP (True Positive): The Event was correctly identified by SpeechMiner.

FP (False Positive): The Event was incorrectly identified by SpeechMiner.

SFP (Sense False Positive): The words were correctly identified by SpeechMiner, but they were used in a sense that does not
match the intent of the Topic.

Summary information about Event auditing in your system can be seen in the Audit Analysis and Topic Analysis - Audits reports.
Existing audit data can be managed globally in the Calls Admin screen.

 

See also

Defining Search Criteria
Using Text Mode
Performing a Search
Performing a Quick Search for Terms
Exploring Terms with a Custom Data Set
Comparing Two Data Sets
 

Home > Search > Searching for Interactions > Performing a Quick Search for Terms

Performing a Quick Search for Terms

You can perform a search for terms from any screen using the Search box in the upper-right corner of the screen. All calls from the
last 30 days are included in the search. As you type, the Search box may offer search suggestions for terms that are related to the
terms you type.

To perform a quick search for terms:

1. In any screen, in the Search box, type one or more terms you want to search for. Separate multiple terms with spaces
or commas.  

Note: Multiple terms are inserted in the search query with AND operators. That is, if you type in two words, the search will find
calls in which both words appear.

Search box
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2. If search suggestions appear below the Search box, and you want to select one of them, click the suggestion. The text you
typed is replaced by the suggestion you selected.

Search suggestions below the Search box

3. Click . The search is performed, the New Search tab opens, and the results are displayed in it. The terms you specified
appear in the Filter Panel, in the SpeechMiner filter group.

Search results

Note: As with any other search performed in the New Search tab, the system automatically corrects apparent spelling errors
and makes suggestions for related searches.

 

See also

Defining Search Criteria
Using Text Mode
Performing a Search
Using an Event Grid
Exploring Terms with a Custom Data Set
Comparing Two Data Sets
 

Home > Search > Searching for Interactions > Exploring Terms with a Custom Data Set

Exploring Terms with a Custom Data Set

SpeechMiner's Explore feature provides an additional way to mine call transcripts for useful information. The exploration process
produces reports that graphically illustrate the distribution of particular terms in calls. The standard Explore feature is completely
automated, and is based on the analysis of all the calls in the database that took place during a specified period of time. The Search
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page offers you an alternative way of performing the exploration process, in which you can filter the data set that is included in the
report in order to hone in on the particular calls that you want to explore. The process produces a Common Terms report for the
filtered data set, which shows the most common term clusters in the selected dataset.

Common Terms report for custom Explore data set

When you initiate the exploration process in the Search page, the results of the exploration are sent to you via e-mail when they are
ready. In addition, you can open them in the Saved Reports tab of the Reports page.

Note: Only calls can be included in data sets that are used for exploration.     

To run an Explore process on a custom data set:

1. In the Search page, select the New Search tab. 

2. In the Filter Panel, define the data set you want to use for the exploration, as explained under Defining Search Criteria. Be sure
to select a single language, and only the Calls interaction type.

3. At either the top or the bottom of the Filter Panel, click Explore. You are prompted to provide a name for the report.

4. Enter a name, and then select OK. A message appears, informing you that the report is being generated, and that an e-mail
will be sent to you when the report is available. 

 

See also

Defining Search Criteria
Using Text Mode
Performing a Search
Using an Event Grid
Performing a Quick Search for Terms
Comparing Two Data Sets
 

Home > Search > Searching for Interactions > Comparing Two Data Sets

Comparing Two Data Sets

You can compare two custom data sets to see how they differ with regard to specific search criteria. For example, you could compare
two teams of customer-service agents to see which team has more Dissatisfaction in the calls it handles. You can also compare the
results of Explore processes between two data sets to see whether there are any noticable differences between them with regard to
the most common terms that appear in their call flows.

Setting up comparisons of this sort is a two-stage process. In the first stage, you define the data sets you want to compare in the New
Search tab, and save each of them as Saved Searches. In the second stage, you select the two data sets in the Saved Searched tab
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and then initiate the comparison process. The results of the comparison included in a report that is sent to you via e-mail when it
is ready. In addition, you can open the report in the Saved Reports tab of the Reports page.

Note: Only calls can be included in the custom data sets that are compared.   

To compare two custom data sets:

1. In the Search page, select the New Search tab. 

2. In the Filter Panel, define the first data set you want to use for the comparison, as explained under Defining Search Criteria. Be
sure to select a single language, and only the Calls interaction type.

3. At either the top or the bottom of the Filter Panel, click Save. You are prompted to provide a name for the Saved Search.3. At either the top or the bottom of the Filter Panel, click Save. You are prompted to provide a name for the Saved Search.

4. Enter a name and select OK. The data set is saved as a Saved Search.

5. Repeat the steps above to define the second data set you want to use in the comparison and save it with a different name.

6. In the Search page, select the Saved Searches tab.

7. Select the checkboxes beside the two Saved Searches you created. The Compare option in the Actions area above the table
of Saved Searches becomes active.

Saved Searches tab with two Saved Searches selected

8. Select Compare. A dialog box opens.

Compare dialog box

9. Under Report Name, enter a name for the comparison report.

10. Under Categories and Topics, click the  buttons beside each of these options and select the Categories and Topics you

want to compare. (For information about using the Multi-Select box that opens when you select , see Defining Search
Criteria.)

11. If you also want to receive an Exploration report for the two datasets, select Also run exploration.

12. Select Run. A message appears, informing you that the report is being generated, and that an e-mail will be sent to you when
the report is available. 

Sample Report
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See also

Defining Search Criteria
Using Text Mode
Performing a Search
Using an Event Grid
Performing a Quick Search for Terms
Exploring Terms with a Custom Data Set
 

Home > Search > Saved Searches

Saved Searches

The criteria of a search can be saved as a query, so that the search can be easily run again using the same criteria whenever it is
required. You can access saved searches in the Saved Searches tab.

Saved Searches tab

To open the Saved Searches tab:

In the Main Menu, under Search, select Saved Searches. The Saved Searches tab opens, and displays a list of the searches
you have saved or other users have shared with you.

Columns in the Saved Searches Table
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The following columns appear in the Saved Searches table: 

Column Description 

 Select the checkbox to include the search in a Delete action (see below).

Note: If you did not create the search, this option is not available.

Display Click the  icon to run the search and display the results in an Interaction Grid or an Event Grid at the bottom of the
screen. (The type of grid depends on which type was selected in the search's settings when it was saved.)

Edit Click the  icon to open the Saved Search in the New Search tab, where you can change the parameters and
settings and make use of all of the other features of the New Search tab.

Delete Click the  icon to delete the search.

Note: If you did not create the search, this option is not available, and the icon appears as .

Name The name of the search.

Created
by

The name of the user who created the search

Status The status of the Saved Search. The following statuses may appear:

Finished: The search was completed.

Starting: The search is about to be executed. When this status appears, a Stop link appears beside it. Click
the link to prevent the search from running. Processing stops and the status is changed to Stopping.

Running: The search is being executed now. When this status appears, a Stop link appears beside it. Click
the link to stop running the search. Processing stops and the status is changed to Stopping.

Stopping: The Stop link was clicked during execution, and the search is in the process of stopping. When the
process is completed, the status changes to Finished.

Sharing The names of the groups and users with whom the search is shared appear in the table beside the icon.

Click the  icon to open a dialog box in which you can select the groups and individual users with whom you want to
share the search. The members of the selected groups and the selected users will see the search listed in their Saved
Searches tab, and will be able to run them.

Note: You can only modify or delete searches that you created. If you want to modify the search criteria of other
searches, you must save them under a new name.

Created
on

The date on which the search was created

Coaching Click Add to add the search to a Coaching session.

Permalink Click Copy to create a Permalink to the search. You can copy the link to your clipboard and then paste it elsewhere as
necessary. Later, you can use a browser to navigate to the Permalink address. When you do, the search will open in
the browser. For additional information, see Permalinks.

Sorting the Columns

You can choose to sort the tables by any column that contains a call parameter.

To sort a table by a column:

Click the title of the column.

Note: Click the title a second time to reverse the sort order. 

Selecting the Number of Rows

You can choose how many rows to show in each of the tables.
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To select the number of rows to display in a table:

At the bottom of the table, in the dropdown list, select the desired number of rows.

 

Selecting the number of rows to display at one time

Filtering a Table

If there are a lot of items in a table, you can find the items you are interested in by filtering the display. You can filter by item name
and/or by the name of the user who created the item.

To filter the items in a table by name:

At the top of the table, in the Name field, type a letter or sequence of letters that appears in the name of the item you are
looking for. The list is filtered as you type; only those names that contain the sequence you typed are displayed in the table.

To filter the items in a table by their creators:

1. At the top of the table, under Created by, click the . A Multi-Select box opens.

2. Select the users whose searches you want to see.

3. Click Close. The list is filtered; only those items that were create by users you selected are displayed in the table.

Note: For additional information about using the Multi-Select box, see Defining Search Criteria.

Collapsing a Table

If you do not want to display one or both of the tables, you can collapse them. This may be convenient, for example, when
an Interaction Grid is displayed at the bottom of the screen. 

To collapse a table:

At the upper-left corner of the table, beside the title of the table, click .

To expand a collapsed table: 

Click the  beside the name of the table.

Deleting Multiple Saved Searches

You can delete multiple saved searches in one action.

To delete multiple saved searches:

1. In the table, select the checkbox to the left of each item you want to delete.

2. Above the table, under Actions, click . You are prompted to confirm that you want to delete the selected items.

3. Click Yes. The items are deleted.

 

See also

Using an Interaction Grid
Searching for Interactions
Call Lists
Browsing Interactions
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Home > Search > Call Lists

Call Lists

A Call List is a static list of calls that were added to the list manually by selecting them from an Interaction Grid. You can access
existing Call Lists and create new, empty Call Lists in the Call Lists tab. (Calls Lists can also be created on the fly in an Interaction Grid;
see Adding Calls to a Call List.)

Call Lists tab

To open the Call Lists tab:

In the Main Menu, under Search, select Call Lists. The Call Lists tab opens and displays a list of the Call Lists you have
created or other users have shared with you.

Columns in the Call Lists Table

The following columns appear in the Call Lists table: 

Column Description 

 Select the checkbox to include the Call List in a Delete action (see below).

Note: If you did not create the Call List, this option is not available.

Display Click the  icon to display the list of calls in an Interaction Grid at the bottom of the screen.

Delete Click the  icon to delete the Call List.

Note: If you did not create the Call List, this option is not available, and the icon appears as .

Name The name of the Call List.

Created
by

The name of the user who created the Call List

Sharing The names of the groups and users with whom the Call List is shared appear in the table beside the icon.

Click the  icon to open a dialog box in which you can select the groups and individual users with whom you want to
share the Call List. The members of the selected groups and the selected users will see the Call List listed in their Call
Lists tab, and will be able to see the contents of lists.

Note: You can only modify or delete Call Lists that you created.

Saved on The date on which the Call List was initially saved.

Coaching Click Add to add the Call List to a Coaching session.

Permalink Click Copy to create a Permalink to the Call List. You can copy the link to your clipboard and then paste it elsewhere
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as necessary. Later, you can use a browser to navigate to the Permalink address. When you do, the Call List will open
in the browser. For additional information, see Permalinks.

Note: Permalinks to Call Lists allow any user to open any of the calls in the list, even if the user does not have
permissions to open the partitions to which the calls belong.

Sorting the Columns

You can choose to sort the tables by any column that contains a call parameter.

To sort a table by a column:

Click the title of the column.

Note: Click the title a second time to reverse the sort order. 

Selecting the Number of Rows

You can choose how many rows to show in each of the tables.

To select the number of rows to display in a table:

At the bottom of the table, in the dropdown list, select the desired number of rows.

 

Selecting the number of rows to display at one time

Filtering a Table

If there are a lot of items in a table, you can find the items you are interested in by filtering the display. You can filter by item name
and/or by the name of the user who created the item.

To filter the items in a table by name:

At the top of the table, in the Name field, type a letter or sequence of letters that appears in the name of the item you are
looking for. The list is filtered as you type; only those names that contain the sequence you typed are displayed in the table.

To filter the items in a table by their creators:

1. At the top of the table, under Created by, click the . A Multi-Select box opens.

2. Select the users whose searches or Call Lists you want to see.

3. Click Close. The list is filtered; only those items that were create by users you selected are displayed in the table.

Note: For additional information about using the Multi-Select box, see Defining Search Criteria.

Collapsing a Table

If you do not want to display the table, you can collapse it. This may be convenient, for example, when an Interaction Grid is displayed
at the bottom of the screen. 

To collapse the table:

At the upper-left corner of the table, beside the name of the table , click .

To expand a collapsed table:
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Click the  beside the name of the table.

Creating a New Call List

New Call Lists can be created in one of two ways:

On the fly: You can create a new Call List on the fly in an Interaction Grid. The new Call List cannot be created empty - calls
must be selected in the Interaction Grid, and the selected calls are automatically added to the new Call List. For additional
information, see Using an Interaction Grid.

New empty Call List: You can create an empty Call List in the Call Lists tab. Calls can be added to the list from an Interaction
Grid later on, as necessary.

To create an empty Call List:

1. Above the Call Lists table, under Actions, click . You are prompted to enter a name for the new list.

2. Enter a name, and then click OK. The new Call List is created and added to the Call Lists table.

Removing a Call from a Call List

You can remove one or more calls from a Call List.

To remove calls from a Call List:

1. In the Call List table, click Display ( ) to display the list of calls in an Interaction Grid at the bottom of the screen.

2. Select the checkbox to the left of each call you want to remove from the Call List.

3. Under Batch Actions, select Delete from List. The selected calls are deleted from the list. 

Deleting Multiple Call Lists

You can delete multiple Call Lists in one action.

To delete multiple Call Lists:

1. In the table, select the checkbox to the left of each item you want to delete.

2. Above the table, under Actions, click . You are prompted to confirm that you want to delete the selected items.

3. Click Yes. The items are deleted.

  

See also

Using an Interaction Grid
Searching for Interactions
Saved Searches
Browsing Interactions
 

Home > Search > Browsing Interactions

Browsing Interactions

This section explains how to use the Content Browser to find interactions with the characteristics that interest you.

Content Browsing begins by selecting a classification base. This base defines how the interactions will be organized in the tree
structure.

Classification
Base

Description 

Categories The tree structure is based on Categories that are assigned to interactions. These Categories are defined in
the Category Manager and assigned automatically to interactions when the system processes them. Each
Category consists of a group of characteristics that identify the type of interaction and its content. When the tree
structure is based on Categories, interactions are listed under the Categories that were assigned to them. 
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Agents The tree structure is based on Workgroups and can be subdivided by agents. Workgroup and agent information is
metadata; for calls, it is collected by the recording system and relayed to SpeechMiner along with the recordings
of the calls; for e-mails and other texts, it is written in the database when the texts are imported. When the tree
structure is based on Agents, interactions are listed under the workgroups of the agents who handled the
interactions.

Programs The tree structure is based on Programs. These Programs are sets of processing instructions for interactions;
they are defined in SMART. When the tree structure is based on Programs, interactions are listed under the
Programs that were used by the system to analyze them. 

 

To open the Content Browser: 

In the Main Menu, under Search, select Content Browser. The Content Browser opens with the default base classification,
Category, selected. 

 

Content Browser

Key to Illustration:

Number Description 

 1 Classification base tab

 2 Filter By classification

 3 Filter By date range

 4 Tree structure 

 5 Collapsed node 

 6 Expanded node 

 7 Refresh button 

Filtering the Interaction Tree

When you first open the Content Browser, all interactions that are in the database are included in the tree structure. You can filter the
interactions in one of two ways:

Filter by classification: Show only those interactions that are in a particular subgroup of one of the classification types. For
example, show only interactions in Workgroup A.

Search . 66

 

SpeechMiner ® User Guide Release 8.0 © 2013, Genesys Inc. Unauthorized Reproduction is Prohibited



Filter by date range: Show only those interactions that took place during a specified period of time.  

 You can apply both types of filters simultaneously if you wish.

To filter by classification:

1. Under Filter By, in the first dropdown list, select the type of classification you want to filter by: Category, Workgroup, or
Program. 

2. In the second dropdown list, select the subgroup you want to see. The tree structure is updated. Only the interactions in the
selected subgroup appear in the tree structure.

To filter by date range:

Under Date Range, select a date range. The tree structure is updated. Only the interactions in the selected date range appear
in the tree structure. 

Selecting From the Filtered Interaction Tree

Once you have filtered the Interaction List, you can explore the tree structure to see which interactions interest you. You can then
select a node in the tree to see more details about the interactions listed in it in an Interaction Grid at the bottom of the screen.

Understanding the Tree Structure

The tree structure lists interactions in groups according to the classification base. Each line contains additional information about the
interactions in that group. The following information appears for each line:

Classification
Base

Column
Name

Description

All 
Number of
Calls 

The number of interactions grouped in the line 

 

Percentage The number of interactions grouped in the line as a proportion of the total number of interactions
included in the tree.

Note: This information is given as a percentage, in two forms: a bar illustrating the percentage,
and a number representing the percentage. 

Agent Last Call The recording time of the last interaction included in the group 

Note: This value is only defined for calls.

 
Number of
Agents 

The number of agents included in the group 

Program Priority The priority that is assigned to the Program 

 
Last
Updated 

The date on which the Program was last updated 

 Language The language of the Program 

 

Expanding and Collapsing the Tree Structure

You can expand or collapse the tree structure to see the level of detail that is most convenient for you. You can expand or collapse
individual nodes or the entire structure. 

To expand or collapse a node of the tree structure:

Click  to expand the node or  to collapse it.

Note: If a node does not have any levels below it,  appears beside it.

To expand or collapse an entire level of the tree structure:
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At the bottom of the tree structure, click the  button to expand the tree one level, or the 
button to collapse it one level. 

Viewing Category Details 

In the Category Browser, you can see a detailed definition of each Category that appears in the tree structure.

To see the definition of a Category:

In the tree structure, click the  icon beside the name of the Category. A window opens and displays the Category definition.

Category definition

Changing the Classification Base

When the Content Browser is open, you can change the classification base from within the page.

To change the classification base:

Click the appropriate tab to select the desired classification base. 

Viewing Interaction Details

You can view interaction details for the interactions in any line in the tree structure.

To view interaction details for a group of interactions:

In the tree structure, click the group of interactions. An Interaction Grid opens at the bottom of the page and displays detailed
information about the interactions.

Note: For detailed information about the Interaction Grid, including how you can listen to calls or view texts via the Interaction Grid,
see Using the Interaction Grid. 

Refreshing the Tree

If new interactions are added to the database while you are viewing the Content Browser, you can add them to the tree by refreshing
it.

To refresh the tree:

Above the tree, on the right, click  (#7 in the illustration above). 

 

See also

Using an Interaction Grid
Searching for Interactions
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Saved Searches
Call Lists

Search
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Home > Using the Media Player

Using the Media Player

The SpeechMiner Media Player is used to play the audio of recorded calls. It provides a range of call playback features that can help
you quickly and easily find the parts of calls that interest you, find information about call properties, view transcripts of calls, add
comments to calls and view the comments of other users. To open the Media Player, you simply click a Play button beside a call in
a Interaction Grid or an event in an Event Grid.

The Media Player is displayed as a timeline with various controls and information surrounding it. The center of the timeline is an audio
graph that visually indicates the level of sound in the call at any given moment, so you can skip over silence or find times when voices
were raised. If calls are recorded with two audio channels - for example, one for the agent and the other for the customer - the audio
channels are color-coded to clearly identify who was speaking at any given moment in the call.

Detected Events, both linguist and non-linguistic, are indicated by icons above the audio graph. User comments are indicated by icons
below the audio graph; the comments can be general or linked to specific times in the call. You can easily play calls back from the
moment that concerns you by clicking in the timeline at the time of interest.  

The illustration below shows the main elements of the Media Player, including some common icons.

 

Main Media Player elements   

Key to Illustration:

Number Description 

 1 Player controls: Play, Pause, etc. (see Playing Back a Call)

 2 Event bar containing icons that indicate where Events of various types were detected (see Event Icons)

 3 Audio graph showing the volume levels at every moment of the call. If the recording system uses two audio
channels, the channels are color-coded.

 4 Timeline indicating the offset from the beginning of the call

 5 Scrollbar indicating which part of the call is currently displayed. Drag the slider or click elsewhere in the
scrollbar to view other parts of the call.

Note: If the entire call is visible at one time, the scrollbar is not active and it does not have a slider.

Note: If the display is auto-synced, the scrollbar automatically moves so that the part of the call that is playing
is always visible (see Playing Back a Call).

 6 Event icon indicating an Event was detected at this location in the call (see Event Icons)

 7 Marker indicating the current location of playback. Click elsewhere in the audio graph to move the marker to
another location and begin playback from there.

 8 Comment icon indicating that a user added a comment at this location in the call (see Call Comments).

 9 Event icon indicating that a Topic was detected at this location in the call (see Event Icons)
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 10 Click to close the Media Player. 

 11 More Actions dropdown menu (see More Actions Options)

 12 New Comment button: Click to add a comment to the call (see Managing Comments).

 13 Content button: Click to open or close the Content panel, in which you can see the text of the call, the Events
that were detected, and user comments (see Viewing Call Content Details).

 14 Attributes button: Click to open or close the Attributes panel, in which you can see the attributes of the call
and assign manual Categories to the call (see Viewing Call Attributes).

 15 Slider indicating the part of the call that is currently displayed. Drag to view a different part of the call.

 16 Call information: The date and time at which the call took place, the ID of the call, the current time in playback
(offset from the start of the call), and the total length of the call

 17 Forms button: Click to select a form to fill out about the call, or to edit a form you have already filled out (see
Filling in Forms).

 18 Click to open the Media Player in a separate window (see Detaching the Player).

  

See also

Event Icons
Playing Back a Call
Viewing Call Content
Call Comments
Call Attributes
Filling in Forms
Detaching the Player
More Actions Options
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Event Icons

Icons indicating when Events were detected appear above the audio graph. Both linguistic and non-linguistic Events are
marked. You can see details about the Event that is represented by an icon by placing your mouse pointer on the icon. Event icons and
information also appear in the Content panel.

The following non-linguistic Event icons are in use:

Icon Description

 Dialtone

Ringback: A signal used in PSTN (Public Switched Telephone Networks - standard "land lines") to indicate that the
line is being called or an incoming call is present.

Silence

Silent period lasting more than 2 seconds (A  icon marks the beginning of the period, and an  icon marks
the end of the period.)

 Crosstalk: In dual-channel calls, a time when both speakers were talking simultaneously

Music and noise (A  icon marks the beginning of the period, and an  icon marks the end of the period.)

 Agitation
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Key press on a touch-tone phone. 16 keys can be identified using DTMF (Dual Tone Multi Frequency); the icon
indicates which key was pressed. 

The following linguistic Event icons are in use:

Icon Description

A Topic that was recognized by SpeechMiner

A Topic that was recognized by SpeechMiner and is relevant to the specific search the user executed

A deprecated Topic Event: the Topic definition has changed since it was found in this specific call

A deprecated Topic Event that is relevant to the specific search the user executed

A term that was found by an active search (after Active Search was selected in an Interaction Search)

An active search Event that is relevant to the specific search the user executed

 

 

See also

Playing Back a Call
Viewing Call Content
Call Comments
Call Attributes
Filling in Forms
Detaching the Player
More Actions Options
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Playing Back a Call

The Media Player opens above a Call or Event Grid when you select a call or Event for playback. For information about opening the
Media Player, see Playing a Call and Playing an Event. This section explains how to use the Media Player to play and manage the open
call. 

Playing Back a Call

You can play the open call from any point in the recording. Playback always begins from the location of the marker in the audio graph.
When you open a call from an Interaction Grid, the marker is placed at the beginning of the call. When you open a call from an Event
Grid, the marker is placed at the beginning of the Event. Playback begins automatically when the call is loaded.

To play a call from the current location of the marker:

Click Play ( ).

To play a call from the location of an Event:

Click the Event icon.

To play back a call from any location in the call:

Click the location in the audio graph. 

Playback Controls
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The playback controls are located on the left side of the Media Player. The following controls are available:

Playback controls 

Key to illustration:

Number Description 

 1 Play/Pause:

Play : When playback is paused, the Play button appears. Click the button to begin playback from
the current location of the marker in the audio graph.

Pause : During playback the Pause button appears. Click the button to stop playback and leave the
marker at its current location in the audio graph.

 2 Previous: Play the previous call in the Call or Event Grid.

 3 Next: Play the next call in the Call or Event Grid.

 4 Skip back: Restart playback from 5 seconds before the current location of the marker.

 5 Auto-Scroll: Turn this option on if you want the call to automatically scroll so that the part of the call that is
currently being played back is always visible. The scroll bar moves automatically to keep up with the playback.

Note: When the option is turned on, the center of the button is blue ( ); if it is off, the center of the button is

green ( ).

Note: This option has no effect if the entire call is visible at one time.

 6 Playback Speed: Click  to increase the playback speed, or  to decrease the speed.

Note: This option is not available in all systems. When it is available, the available speeds may vary. Typically,
they are 1.00, 1.25, 1.50, and 2.00.

 7 Mute: Turn the volume off

 8 Volume: Click a line in the icon to select the corresponding volume level.

Keyboard Shortcuts

The following keyboard shortcuts can be used in the Media Player:

Keys to Press Result 

Ctrl + Enter Toggles between Play and Pause

Ctrl + Shift + n Skips to the next call in the grid

Ctrl + Shift + p Skips to the previous call in the grid

Ctrl + Shift + t In an Event Grid, marks the current event as TP (True Positive) 
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Ctrl + Shift + f In an Event Grid, marks the current event as FP (False Positive)

Ctrl + Shift + s In an Event Grid, marks the current event as SFP (Sense False Positive) 

Ctrl + Shift + c In an Event Grid, clears an Event rating

Note: TP, FP, and SFP ratings are assigned to Events during the auditing process (see Using an Event Grid).

Filtered Content

Call audio and text may be filtered in your system to ensure confidential information cannot be accessed by users who do not have
permission to do so. Different users may have different permissions in this regard, so certain parts of a call may be filtered out for
some users but not others. Parts of a call that have been filtered out appear in the audio graph in gray (#1 in the illustration below)
rather than black. The text of the filtered parts in not included in the call Contents, and the Media Player skips these areas during
playback.

Filtered audio content

Filters can be implemented in the following ways:  

Sensitive Topics: Some Topics may be defined in your system as Sensitive. (This attribute is assigned to Topics in the
SMART application.) Only users with special permissions can hear the audio or see the text of Sensitive Topics.

Numbers: Numbers consisting of more than two digits may be filtered out of calls, in order to ensure unauthorized users do
not have access to credit card numbers and other confidential information. 

Comments-Only permission: Some users may only be able to access those parts of calls to which comments have been
attached.

For information about the filter rules in your system, consult your system administrator. 

Dual-Channel Audio

Some recording systems use two audio channels, one for the agent's side of a call and the other for the customer's side of the call. If
your recording system does this, SpeechMiner color-codes the channels in the audio graph so that you can tell who is speaking at any
given moment. Filtered audio content is still displayed in gray, as described above, so you may see as many as three different colors
in the audio graph, as in the figure below.

Dual-channel audio graph with filtered content

 

See also

Event Icons
Viewing Call Content
Call Comments
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Home > Using the Media Player > Viewing Call Content

Viewing Call Content

The Content panel can be used to view a transcript of the call that is open in the Media Player, as well as the Events that SpeechMiner
detected in the call and comments that were added to the call by users. The panel is divided into two panes. The right pane contains
the transcript of the conversation, with the Events marked, and the left pane contains a list of the Events that were found in the
call. You can choose to display or hide the comments that users added to the call. If you choose to display them, they are listed in the
left pane and also marked in their locations in the right pane. You can also adjust the size of the panels and the widths of the two
panes.

Content panel showing text and Events, with comments hidden  

In the transcript, the current playback location is indicated by a light-blue highlight, and the typeface of the text reflects how certain
SpeechMiner is that it correctly transcribed the conversation: the darker the text, the higher its accuracy. If your system employs
multiple audio channels, the speakers are identified in the transcript, and the text is color-coded to match the speakers.
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Content panel showing two audio channels 

Opening and Closing the Content Panel

You can open the Content panel when you want to see it, and close it when it does not interest you.

To open or close the Content panel:  

Click the Content button.

Docking the Content Panel

You can dock the Content panel - open it in its own section below the Media Player - whenever you wish. This may be convenient if
you want to use it for an extended period of time, because it provides a wider display and does not hide any other screen items you
may want to look at.

Content panel docked
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To dock the Content panel:

When the panel is open, in the upper-left corner of the panel, click Dock.

To undock the Content panel:

In the upper-left corner of the docked panel, click Undock.

Displaying or Hiding Comments

 When the Content panel is open, you can choose to display or hide the comments that users have attached to the call.

Content panel with Comments displayed

To display or hide the comments:

At the top of the Content panel, click Comments.

Hiding the Left Pane

You can hide the left pane to provide more space for the right pane.
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Content panel with the left pane hidden

To hide the left pane:

In the upper-right corner of the pane, click .

To display the left pane:

In the upper-left corner of the Content panel, click .

Adjusting the Sizes of the Panel and Panes

You can adjust the height and width of the Content panel and the sizes of the right and left panes.

To adjust the size of the panel:

Drag the bottom-right corner of the panel in any direction.

Note: Dragging right or left only affects the width of the right pane.

To adjust the widths of the right and left panes:

Drag the dividing line between the panes right or left. 

Working with Events 

The locations of Events are indicated in the transcript by numbered Event icons. The numbers match the Event numbers that appear in
the left pane. In either pane, you can see the text of a Topic Event by placing your mouse cursor on it. In the right pane, you can also
see the name of the Event by placing your mouse cursor on the text of the Event. (The names of the Events are displayed with their
icons in the left panel.)

Events in the transcript are preceded by an auditing rating selector. If the Event has already been audited, the audit value is bolded,
and the entire selector is color-coded, as follows:

Audit Value Description Color-coding 

TP True Positive green

FP False Positive peach 

SFP Sense False Positive pink 

For additional information, see Using an Event Grid.
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If you have auditing permissions, you can select or modify the audit ratings of Events in the call transcript.

To select an audit value:

Click the value.

To clear the selected audit value:

Click Clear

Viewing Related Words

You can run a Related Words report for any word in the call transcipt.

To run a Related Words report for a word:

1. Place your mouse cursor on the word. A pop-menu appears.

2. Select Related Words. The Related Words report results are opened in a new window.

Note: For additional information about this type of report, see Finding Related Words.

  

See also

Event Icons
Playing Back a Call
Call Comments
Call Attributes
Filling in Forms
Detaching the Player
More Actions Options
 

Home > Using the Media Player > Call Comments

Call Comments

Comments can be added to calls either as global comments, which relate to the entire call, or time-linked comments, which relate to a
particular time in the call. 

Comments are indicated in the Media Player by Comment icons. In the player area, the icons appear below the audio graph (nos. 1, 2,
and 3 in the figure below), and in the Content panel, they appear in the call transcript. The icons are color-coded to indicate whether
the comments are positive ( ), general ( ), or negative ( ). You can view the text of a comment by placing your mouse cursor on
the icon. In addition, the text of each comment appears in the left pane of the Content panel along with the name of the user who
inserted the comment. Global comments appear at the beginning of the call (nos. 1, 4, and 5 in the figure) and time-linked comments
appear in their appropriate locations (nos. 2, 3, 6, and 7 in the figure).  

Note: If you cannot see the call comments in the Content panel, at the top of the left pane of the panel, click Comments. For
additional information, see Viewing Call Content.
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Call comments

Adding a Comment to a Call

You can add global and time-linked comments to a call, and indicate whether the comments you add are positive, negative, or
general. 

To add a comment to a call:

1. Click New Comment. The New Comment box opens.

New Comment box

2. If you want to add a time-linked comment, select the checkbox beside the Time field.

Note: The time in the Time field is automatically set to the time at the location of the cursor in the audio graph. Modify the
time if you wish.

3. In the text area below the Time field, type your comment.

4. Select one of the following:

Option Description 

Good Positive comment 

General Neutral comment 

Bad Negative comment

5. Click Add. The comment is added to the call. 

Editing an Existing Comment
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You can modify the text and rating (Good, General, or Bad) of any comment you added to a call. If you have the required permissions,
you can also modify other users' comments in this way. You cannot change a global comment into a time-linked comment, or vice-
versa, and you cannot change the time of a time-linked comment. You also cannot delete a comment entirely.

To edit a comment:

1. In the Content panel, click Edit at the end of the comment. The Edit Comment box opens.

Edit Comment box

2. Modify the text of the comment as required. 

3. Change the rating of the comment, if necessary.

4. Click Update. The comment is modified.

 

See also

Event Icons
Playing Back a Call
Viewing Call Content
Call Attributes
Filling in Forms
Detaching the Player
More Actions Options

 

Home > Using the Media Player > Call Attributes

Call Attributes

The Attributes panel can be used to view the attributes of the call that is open in the Media Player. In addition, you can use it to assign
manual Categories to the call.
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Attributes panel

The following types of call attributes are displayed in the Attributes panel:

Call processing time

Workgroups

Agents

Metadata values

Manually assigned Categories

Automatically assigned Categories

Opening and Closing the Attributes Panel

You can open the Attributes panel when you want to see it, and close it when it does not interest you.

To open or close the Attributes panel:  

Click the Attributes button.

Docking the Attributes Panel

You can dock the Attributes panel - open it in its own section below the Media Player - whenever you wish. This may be convenient if
you want to use it for an extended period of time, because it provides a wider display and does not hide any other screen items you
may want to look at.
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Attributes panel docked

To dock the Attributes panel:

When the panel is open, in the upper-right corner of the panel, click Dock.

To undock the Attributes panel:

In the upper-right corner of the docked panel, click Undock.

Assigning Manual Categories

 When the Attributes panel is open, you can assign manual Categories to the call that is open in the Media Player. 

 

Attributes panel with manual Categories selected
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To assign a manual Category to a call:

In the Attributes panel, under Manual Categories, select the checkbox beside the Category.

To remove a manual Category from a call:

Clear the checkbox beside the Category.  

 

See also

Event Icons
Playing Back a Call
Viewing Call Content
Call Comments
Filling in Forms
Detaching the Player
More Actions Options
 

Home > Using the Media Player > Filling in Forms

Filling in Forms

You can fill in a form about the call that is opened in the Media Player. For example, you could fill in a form rating the agent's handling
of the call, if a form of that type is in use in your system.

Only one form can be filled out by each user for each call. If you have already filled out a form, you can edit it if you wish. If you want
to fill out a different form, you must first delete the first form.

Note: For information about creating forms, see Forms.

Filling in a New Form

If you have not yet filled in a form for the call, you can select the form to fill in and then fill it in.

To fill in a new form:

1. Click Form. The Select Form dialog box opens and displays a list of available forms.

2. Click the form you want to fill out. The form opens in a new window.

3. Fill in the form and then click Submit Changes. The values you chose are saved in the system.

4. To close the form, click Close.

Editing a Form

If you have already filled in a form for the call, it automatically opens when you click the Form button. You can edit or delete the form
at this stage. If you want to fill out a different form, you must first delete this form. 

To edit a form: 

1. Click Form. The form opens in a new window.

2. Modify the form as necessary, and then click Submit Changes. The changes are saved. 

3. To close the form, click Close.

Deleting a Form

You can delete a form you have already filled out as necessary.

To delete a form: 

1. Click Form. The form opens in a new window.

Using the Media Player . 84

 

SpeechMiner ® User Guide Release 8.0 © 2013, Genesys Inc. Unauthorized Reproduction is Prohibited



2. Click Delete. You are prompted to confirm that you want to delete the form. 

3. Click Yes. The form is deleted and the window closes.

 

See also

Event Icons
Playing Back a Call
Viewing Call Content
Call Comments
Call Attributes
Detaching the Player
More Actions Options
 

Home > Using the Media Player > Detaching the Player

Detaching the Player

If you wish, you can detach the Media Player - remove it from the SpeechMiner interface and open it in a separate window. You can
then move the window to any location on your screen that you find convenient.

Detached Media Player

To detach the Media Player:

In the lower-left corner of the Media Player, click .

To reattach the Media Player:

Click  or close the Media Player window. 

 

See also

Event Icons
Playing Back a Call
Viewing Call Content
Call Comments
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Call Attributes
Filling in Forms
More Actions Options
 

Home > Using the Media Player > More Actions Options

More Actions Options

The Media Player provides the following additional options for the call that is currently open in it:

Export: Save the call in a file.

Forward: Send other users a link to the call.

Add To: Add the call to a Call List.

Delete From List: Remove the call from the current Call List. (This option is only available if you opened the Media Player
from a Call List.)

Permalink: Create a Permalink to the call.

Similar Calls: Find calls that are similar to the call.

Reprocess Call: Run event analysis again on the call.

These options can be accessed from the More Actions menu in the lower-left corner of the Player, as explained below.

Exporting the Call

If you want to save the call or send it to someone else, you can export it. Exporting the call creates a ZIP file that contains the
following:

A CSV file containing information about the call. This file can be opened using a spreadsheet application such as Microsoft
Excel.

A WAV file - a playable audio file of the call (optional)

To export the call:

1. Under More Actions, select Export. A dialog box opens and asks if you want to include the audio files with the export.

2. Select Yes if you want to export the audio along with the CSV file, or No if you only want the CSV file.

3. A dialog box opens and asks if you want to open or save the ZIP file.

4. Select the desired option. If you select Open, the file opens in the application that is configured to open ZIP files on your
computer. If you select Save, a Save As dialog box opens.

5. If you selected Save, navigate to the folder in which you want to save the file, and then click Save. The file is saved in the
selected location.

Forwarding a Link to the Call

You can send a link to the call to other users in the system. The link is sent in a Call message that appears in the recipient's My
Messages widget in the Views page. When the recipient clicks the message, a SpeechMiner Media Player opens above the widget and
plays the call. 

If you wish, you can also send the recipient an e-mail notification with a link to the call. When the recipient clicks the link, the Media
Player opens in a new browser tab or window and plays the call. If the recipient is not already logged into SpeechMiner, they are
prompted to do so before the Media Player opens.

To send a call link to another user:

1. Under More Actions, select Forward. A dialog box opens.
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Forward dialog box

2. Under Subject, modify the subject text if you wish. 

3. Under Please Select the Recipient, select the user you want to send the link to, in one of the following ways:

In the text field, type part of the name or username of the recipient. As you type, names and user names containing
those letters are displayed in a dropdown list. Select the recipient from the list.

Click the ... button ( ) beside the text field. In the dialog box, select the user from the list of users in the relevant
workgroup.

4. If you want to send a notification to the user's e-mail address as well as to their My Messages box, select Send Email
Notification.

5. Click Send. A Call message is sent to the recipient's My Messages box. If you chose to send the user an e-mail notification, it is
also sent. 

Adding the Call to a Call List

A Call List is a list of calls that is saved for later use. SpeechMiner supports two types of Call Lists: global Call Lists and coaching-
session Call Lists. You can see existing global Call Lists in the Calls page in the Call Lists tab, under Call Lists. Coaching-session Call
Lists can only be viewed within the coaching session. For additional information about coaching sessions, see Coaching.

You can add calls to an existing Call List or a new list. You can select an existing Call List from a list of global Call Lists or select a
coaching-session Call List from those that are attached to the Coaching session. If you wish, you can add a new Coaching session
directly from the Interaction Grid, and then add calls to a Call List that is attached to that session.

To add the call to a Call List: 

Under More Actions, select Add To and then select one of the following:

To Select Result 

Create a new Coaching session and
a new coaching Call List within that
session, and add the calls to the
new Call List

Coaching > New A New coaching session dialog box opens. Specify the name
and other settings of the Coaching session, and then click Save.
The dialog box closes, and a new Call-List dialog box opens. 

In the text field, type a name for the Call List, and then click OK.
The Coaching session and Call List are created, and the calls are
added to the Call List.

Create a new coaching Call List
within an existing Coaching session,
and add the calls to the new Call
List

Coaching >
[existing
Coaching session]
> New

A Call-List dialog box opens. In the text field, type a name for
the Call List, and then click OK. The new coaching Call List is
created and attached to the Coaching session, and the calls are
added to the Call List.

Add the calls to an existing
coaching Call List that is attached to
an existing Coaching session

Coaching >
[existing
Coaching session]
> [existing Call
List]

The calls are added to the selected coaching Call List.

Add the calls to a new Call List Call List > New A Call-List dialog box opens. In the text field, type a name for
the Call List, and then click OK. The new Call List is created and
the calls are added to it.
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Add the calls to an existing Call List  Call List>
[existing Call List]

 The calls are added to the selected Call List.

 

Deleting a Call from a Call List

If you opened the current call from a Call List, you can remove it from the Call List using the Media Player.

To delete the call from a Call List:

Under More Actions, select Delete From List. The call is removed from the Call List.

Generating a Permalink to the Call

You can generate and save a Permalink to the call, which can later be used to open the call in the Media Player. To play the call, you
need only open the link in a browser.

Note: For additional information, see Permalinks.

To create a Permalink to the current call:

Under More Actions, select Permalink. A Permalink dialog box opens and displays the Permalink.

Finding Similar Calls

You can search for calls that are similar to the current call in terms of their subject matter and the phrases they contain. When you
do, a new window opens and displays a list of the calls that were found, arranged in order of how similar they are to the original call.
The terms in the calls that the system identified as being similar to terms in the current call are highlighted in the list. Calls in the list
can be played in the Media Player in the window. (For additional information about playing calls in the Media Player, see Playing Back
a Call.) The maximum number of calls that can be included in the list is defined in your site's system variables.

List of similar calls displayed in a new window

To find similar calls:

Under More Actions, select Similar Calls. A new window opens and displays the list of calls.

Reprocessing the Call

You can run event analysis again on the call. The system may produce different results when you do this, if the definitions in SMART
have been modified or call auditing has fine-tuned the speech analysis system since the call was originally processed.

Note: For information about reprocessing batches of calls, see Reprocessing Calls and Managing Audits.

To reprocess the call:
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Under More Actions, select Reprocess Call. 

 

See also

Event Icons
Playing Back a Call
Viewing Call Content
Call Comments
Call Attributes
Filling in Forms
Detaching the Player
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Home > Explore

Explore

The Explore page is designed to help managers monitor calls, identify and explore issues that arose in calls, and spot unexpected
trends and problems. The page contains configurable exploration reports that show the distribution of terms in calls. The data
is based on automated analyses of the transcripts of calls, without any input from users about what terms should be sought. For this
reason, it can help you identify issues and trends that were not predicted or planned.

In the exploration analyses, a term is a short series of words (usually, two to six words) that were detected together in calls.
SpeechMiner attempts to identify the most significant words and phrases in the terms it detects, and groups the terms into clusters
based on these words and phrases. Thus, for example, if the terms "I lost my credit card," "my credit card was stolen," and "I can't
find my credit card" were all found in calls, SpeechMiner would identify "credit card" as the significant phrase in each of the terms. It
would group the terms together into a term cluster called "credit card."  

 

See also

Overview of the Explore Page
Setting the Filters
Identifying Term Trends
Finding Common Terms
Using a Trend Graph
Finding Related Words

Welcome
Getting Started
Workflows
Views
Action Items
Search
Using the Media Player
Quality Monitoring
Coaching
Reports
Tools
Permalinks
Appendix A: Standard Reports
 

Home > Explore > Overview of the Explore Page

Overview of the Explore Page

The Explore page is divided into three areas: a filter area and two analysis areas. The filter area is used to specify which data to
include in the reports, by selecting the time period and language. The analyses in the other two areas show information about the
term clusters that were discovered by SpeechMiner in the data from the time period and language selected in the filter area:

Term Trends: The data in the upper-right of the page highlights the changes in the distribution of terms in calls. It lists the
clusters for which there was the greatest difference between their prevalence in the selected time period and in the previous
time period.

Common Terms: The bottom of the page identifies the term clusters that were most common in the selected time period.

Additional analysis of term clusters and their prevalence in the selected time period can be viewed in a Related Words report. This
report graphically shows which terms are commonly found within the same or similar term clusters as a specified term, and
how frequently the terms are found together in a cluster. The report enables you to explore terms and term clusters actively, by
selecting and zeroing in on the terms that are of interest to you.

You can to drill down from any term cluster in the page or in the Related Words report to see additional details, such as a list of calls
in which it is found.
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Explore page 

 

See also

Setting the Filters
Identifying Term Trends
Finding Common Terms
Using a Trend Graph
Finding Related Words
 

Home > Explore > Setting the Filters

Setting the Filters

The data in all of the Explore page covers a single time period and language - the time period and language selected in the filter area
in the upper-left part of the page. You can choose any day as the base day for the filter period, and then choose the time period
relative to that day. For example, if you choose Friday, May 25th as your base day, and then choose the time period Last week,
the common-terms data at the bottom of the page will be generated for the week preceding May 25th (May 13th-19th), and the term
trends data on the right side of the page will compare those seven days with the preceding seven days (May 6th-12th).

Note: You can run a Related Words report from the filter area or from any of the term clusters on the page.
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Filter area

To set the filters for the exploration analysis:

1. In the upper-left part of the Explore page, in the calendar, select the base date for the filter period.

2. Below the calendar, under Time Period, select one of the following:
Last 7 Days: Includes data from the last seven full calendar days prior to the base date - i.e., not including the base
date

Last Week: Includes data from the beginning through the end of the last full week preceding the base date.

Today: Includes data from the base date

Week to Date: Includes data from Sunday of the week of the base date through the day preceding the base date

Yesterday: Includes data from the day preceding the base date

3. Under Languages: Select the language of the calls you want to include in the analysis.

Note: The term-cluster data on the page is updated automatically whenever you change any of the filter values.  

 

See also

Overview of the Explore Page
Identifying Term Trends
Finding Common Terms
Using a Trend Graph
Finding Related Words
 

Home > Explore > Identifying Term Trends

Identifying Term Trends

The right side of the Explore page contains a histogram that shows the term clusters whose prevalence in calls differed the
most between the current time period and the baseline period. The report indicates how the percentage of calls containing each
cluster changed from the baseline period to the current period. The current period is selected in the filter area, and the baseline is the
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preceding period of the same type. For example, if the currently selected time period is a week, the baseline would be the week
preceding it.

Histogram displaying term-trend information

 The following columns appear in the histogram:

Column Description

Terms
Cluster

Term cluster

Percent
Change

How much more or less common the cluster was in the current period as compared with the baseline period. Both the
bar and the number represent the same value. If the cluster was more common in the current time period, the bar
representing the percent change is green and the number value is positive. If the cluster was more common in the
baseline period, the bar is blue and the number is negative. For example, 66.1% means the cluster appeared in 66.1%
more of the calls in the current than it did in the calls of the baseline period, and -24.1% means the cluster appeared in
24.1% fewer of the calls in the current period than it did in the baseline period.

+/- The difference between the number of calls in which the cluster was found in the current period and in the baseline
period. If the number is positive, the cluster appeared more in the current period than it did in the baseline period. If
the number is negative, the cluster appeared in more calls in the baseline period than it did in the current period. For
example, -5 means that the cluster was found in five more calls in the baseline period than it was in the current period.

Percent
of Calls

The percentage of calls in the current time period in which the term cluster was found. Both the bar and the number
represent the same value.

Viewing Additional Information about a Term Cluster

You can see additional information about a term cluster that appears in the histogram.

To see additional information about a term cluster in the histogram:

1. Place your mouse on a cluster. The cluster appears in red, and a pop-up menu opens for it. 
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Pop-up menu

2. Click one of the following, as required:

Calls Search: Opens an Interaction Grid that lists calls containing the term cluster. The Interaction Grid opens in a
separate window.

Trend: Opens a Trend Graph for the term cluster in place of the histogram.

Related Words: Opens a Related Words report for the term cluster in a separate window. 

 

See also

Overview of the Explore Page
Setting the Filters
Finding Common Terms
Using a Trend Graph
Finding Related Words
 

Home > Explore > Finding Common Terms

Finding Common Terms

The bottom part of the Explore page contains a graphic depiction of the distribution of term clusters in the calls that are included in
the analysis (as specified in the filter area). The font used to print each cluster indicates how common the term was in the calls; the
more frequently a term cluster was found, the larger it appears. In addition, every cluster has a pop-up menu that provides additional
options.

Distribution of common term clusters
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Viewing Additional Information about a Term Cluster

You can see how many times each term cluster appears in the data set, and access additional information about the cluster.

To see additional information about a term cluster:

1. Place your mouse on a cluster. The cluster appears in red, and a pop-up menu opens for it. 

Pop-up menu

2. Click one of the following, as required:

Calls Search: Opens an Interaction Grid that lists calls containing the term cluster. The Interaction Grid opens in a
separate window.

Trend: Opens a Trend Graph for the term cluster in place of the cluster-distribution information.

Related Words: Opens a Related Words report for the term cluster in a separate window. 

 

See also

Overview of the Explore Page
Setting the Filters
Identifying Term Trends
Using a Trend Graph
Finding Related Words
 

Home > Explore > Using a Trend Graph

Using a Trend Graph

The Trend Graph is a line graph showing changes over time in how often a term cluster was found. The graph shows the percentage
of calls that contained the cluster in the current time period and in the preceding weeks. The term cluster appears in black above the
graph.

 

Trend Graph

The Trend Graph can be opened for any term cluster that currently appears in the Explore page. 
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To open the Trend Graph for a term cluster:

In the Explore page, in the pop-up menu of a term cluster (see Identifying Term Trends and Finding Common Terms), select
Trend.

To close the Trend Graph and return to the histogram from which it was opened:

Click Back.

 

See also

Overview of the Explore Page
Setting the Filters
Identifying Term Trends
Finding Common Terms
Finding Related Words
 

Home > Explore > Finding Related Words

Finding Related Words

The Related Words report graphically illustrates which other terms are commonly found with a specified term, and how frequently
they are found together, in the current sample of calls (as specified in the filters). 

Each specified term is presented as the center of a wheel whose related terms are arrayed around it along the rim.  The font used to
print each related term indicates how frequently the related term was found near the central term; the more frequently a term cluster
was found, the larger it appears in the diagram. In addition, every term in the diagram has a pop-up menu that provides additional
options. 

Related Words report

Opening a Related Words Report

The Related Words report can be opened in one of three ways: 

Entering a search term manually in the Explore page
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Selecting Related Words in the pop-up menu of a term cluster in the Explore page (see Identifying Term Trends and Finding
Common Terms)

Selecting Related Words in the pop-up menu of a word in the Content panel of the Media Player

To enter a term manually in the Explore page:

1. In the filter area, in the Related Words field, enter one or more terms.

2. Click Search. The Related Words search is performed, and a diagram of the results appears in a new window.

The results window is a modal window - a child window of the browser window. To continue working with the parent window, you
must close the report. To keep the results open, but also interact with the SpeechMiner interface in other ways, you can convert the
modal window into a standalone window.

To close the report-results window:

In the upper-right corner of the window, click .

To convert the window into a standalone window:

In the upper-right corner of the window, click . 

Moving the Diagram Around

You can move the diagram around the Related Words window as necessary. This can help you see hidden parts of the diagram, and is
especially helpful if you have expanded the diagram.

To move the diagram within the Related Words window:

Hold down either your left or right mouse button and drag the mouse cursor over the diagram.

Enlarging the Diagram

You can make the diagram larger or smaller.

To make the diagram larger or smaller:

Roll your mouse wheel up or down over the diagram.

Additional Options

Every term in the wheel has a pop-up menu providing additional options. The pop-up menus of the related words on the rim of the
wheel contain the following items: 

Expand: Creates an additional wheel in the Related Words window with the rim term as its center (see Expanding the Diagram
below)

Merge: Creates a new wheel in the Related Words window in which the central term of the existing wheel is combined with
the rim term (see Merging Terms below)

Search: Performs a term search for calls in which the central term and the rim term appear (see Searching for Terms below)

Number of Calls: The number of calls in the  sample that contained both the central term and the rim term
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Related Words pop-up menu

The pop-up menu of the central term only has one option, Search, which performs a search for the central term, as well as
information about the number of calls in the sample in which the central term was found.

Pop-up menu for central word

To open the pop-up menu for a term:

Place your mouse cursor on the term.

Expanding the Diagram

Additional wheels can be added to the diagram to show the terms that are related to any of the terms on the rim. This can provide
additional information about important terms in the calls and their relationships. For example, the figure below shows an expanded
diagram. The original diagram mapped the related words of the term "call." The diagram was expanded to also show the related
words of the term "before."
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Expanded diagram

To expand the diagram for a rim term:

In the pop-up menu of the rim term, select Expand [term]. 

Merging Terms

The existing diagram can be replaced by a new diagram illustrating the related terms for a central term consisting of the original
central term and one of the rim terms. For example, in the figure below, the original central term "call" was replaced by a new central
term composed of the original term plus the rim term "before." 

Merged terms in new diagram 

To merge the central term with one of the rim terms:

In the pop-up menu of the rim term, select Merge '[rim term]' with '[central term]'. 

Searching for Terms

You can perform a call search for any term in the diagram. If you perform the search for the central term, SpeechMiner finds calls in
the sample in which all of the words in the term are found. If you perform the search for a rim term, SpeechMiner finds calls in the
sample in which all of the words in the both the central term and the rim term are found. The call search opens in a separate window.
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Call Search for rim term "before" with central term "call"

 

See also

Overview of the Explore Page
Setting the Filters
Identifying Term Trends
Finding Common Terms
Using a Trend Graph
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Home > Quality Monitoring

Quality Monitoring

The Quality Monitoring system is designed for use by supervisors, who can use it to assign tasks to their quality managers, track their
progress in performing these tasks, and monitor trends. It has two modules:

Queues: The Queues screen is used to create lists of calls for quality analysts to review. The user designs the lists by
selecting types and quantities of calls; the system automatically generates lists of calls that meet the criteria.

Forms Manager: The Forms Manager screen is used to create feedback forms for quality analysts and other users to fill in
after they have listened to calls.

 

See also

Queues
Forms Manager

Welcome
Getting Started
Workflows
Views
Action Items
Search
Using the Media Player
Explore
Coaching
Reports
Tools
Permalinks
Appendix A: Standard Reports
 

Home > Quality Monitoring > Queues

Queues

The Queues page is used to create and manage sets of search criteria for use by quality managers. The system automatically
generates lists of calls for each set of criteria, so that the quality analyst can listen to them. The generated lists are randomized. That
is, the system does not just take the first calls in the database that match the search criteria; rather, it randomly selects calls from all
those calls that meet the criteria. For example, if the quality analyst needs to listen to a random selection of calls that belong to a
particular program, and a random selection of calls that were handled by each agent, you would create two queues, one for the calls
from the program and another for calls per agent.

The Queues page is designed to be used in conjunction with the My Queues and the Recently QAed widgets on the Views page. The
queues are created and managed in the Queues page; the quality analyst works with the generated lists in the My Queues widget,
and the supervisor can keep tabs on what calls have been dealt with in the Recently QAed widget.

A new queue is automatically assigned to the person who created it, and appears in that person's My Queues list. You can choose to
share a queue you create with one or more other users. When you do this, the queue appears in the Queues page in read-only form,
and in their My Queues widget. Supervisors can assign queues to quality managers by sharing the queues with them. Thus, for
example, if you want Joe to handle Queue 1 and Ellen to handle Queue 2, you would share Queue 1 with Joe and Queue 2 with Ellen.

To open the Queues page:

In the Main Menu, in the Quality dropdown menu, select Queues.
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Queues page

The Queues page lists all of the queues that you created and that were shared with you. You can only edit, share, or delete the
queues that you created. The checkbox and Action links of queues that someone else created and shared with you are not available.

Columns in the Queues List

The Queues List contains the following columns:

Column Description

Queue The name of the queue

Description The description of the queue

Quota The number of calls that should be reviewed, per agent in each time period specified by the queue

Reviewed\Total The number of calls that have already been reviewed (in the current time period, if one is defined), and, if a
time period is defined, followed by the total number of calls that were included in the queue for the current time
period.

Action Click one of the links to select an action (see Managing Queues).

Sorting the Columns 

You can sort the rows of the Queues List by any of the columns (except the Action column).

To sort the list by a column: 

Click the column heading. (To reverse the sort order, click the column heading again.) 

 

See also

Creating a New Queue
Managing Queues

Forms Manager
 

Home > Quality Monitoring > Queues > Creating a New Queue
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Creating a New Queue

In addition to a name and optional description, each queue consists of two parts:

Search criteria

Quota

The search criteria are defined using a standard Search form.

To create a new queue:

1. In the Queues screen, click Add Queue. The New Search screen opens.

New Search screen

2. In the left column, select the search criteria for the queue. For additional information, see Defining Search Criteria.

Note: If you specify a time period in the quota definition (see below), the date range defined in the call search criteria is
overridden.

3. At the upper-right corner of the screen, click Save As Queue. The New Queue dialog box opens.
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New Queue dialog box

4. Under Name, enter a name for the queue.

5. Under Quota Type, select the type of quota, as follows:

Quota Type Description

Opportunity No quota: When the quality analyst chooses to review a call that matches the search criteria, the system
retrieves an appropriate call, but there is no specific requirement for how many calls to review.

Calls in date
range per
agent

For each time period, the system retrieves the required number of calls for each agent. The fields
required to define the settings are added to the dialog box.

Quality Monitoring . 104

 

SpeechMiner ® User Guide Release 8.0 © 2013, Genesys Inc. Unauthorized Reproduction is Prohibited



Fields added to dialog box

6. If you selected Calls in date range per agent, under Calls, enter the number of calls from the specified time period that
should be reviewed. (This is the number per agent, not the total number.):

Note: The Per Agent field is not currently in use.

7. Under Description, enter a description for the queue (optional).

8. Click Save. The queue is added to your list of queues in the Queues screen and in your My Queues widget.

Note: If you want to assign the queue to other users, you must share it with them (see Sharing a Queue).

 

See also

Managing Queues
 

Home > Quality Monitoring > Queues > Managing Queues

Managing Queues

If you created a queue, you can edit it, share it with other users, delete it, or make a copy of it.

Editing a Queue

You can edit the quota settings, search criteria, and sharing settings of a queue.

To edit the quota settings of a queue:
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1. In the Queues screen, in the Queues List, under Action, click Edit. The Edit Queue dialog box opens, with the name of the
queue in its title and the quota and search settings displayed below:

Edit Queue dialog box

2. Modify the quota settings and description as required.

3. Click Save to save the changes or Save & Share to save the changes and open the Sharing Queue dialog box (see below).

Note: If you modified the quota settings and/or the description, and you also want to change the search criteria, click Save to
save the quota and description settings, and then open the Edit Queue dialog box again to modify the search criteria, as
explained below.

4. If you selected Save & Share, modify the sharing settings as required, and then click Save. The settings are saved.

To modify the search criteria:

1. In the Queues screen, in the Queues List, under Action, click Edit. The Edit Queue dialog box opens.

2. In the middle of the dialog box, click . The New Search screen opens.

3. Modify the search criteria as necessary.

4. At the upper left in the New Search screen, click Save. The changes are saved in the queue.

Sharing a Queue

If you want to assign responsibility for a queue to other users, you must share the queue with them. When you share a queue with
someone, the queue appears in their Queues screen in read-only form, and in their My Queues widget. When anyone sharing a
queue reviews a call in the queue, the queue record (calls reviewed/left) is updated for all of those sharing the queue. 

To share a queue:

1. In the Queues screen, in the Queues List, under Action, click Share. The Share Queue dialog box opens, with the name of
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the queue at the top:

 

Share Queue dialog box

2. To share the queue with one or more groups, select the groups.

3. To share the queue with one or more users, select the users. To filter the list of users, in the Filter by text box, type a
sequence of letters that appears in the name or user name of the user, only those users whose names contain the sequence
appear in the list.

4. Click Save. The queue is shared with the selected groups and users.

Deleting Queues

When you no longer need a queue, you can delete it. If you want to delete a number of queues at one time, you can delete them all in
one action.

To delete a single queue:

1. In the Queues screen, in the Queues List, under Action, click Delete. You are prompted to confirm that you want to delete
the queue. 

2. Click Yes. The queue is deleted.

To delete multiple queues:

1. In the Queues screen, in the Queues List, select the checkbox at the left of each queue you want to delete.

2. At the top of the list, click Delete. You are prompted to confirm that you want to delete the queues. 

3. Click Yes. The queues are deleted.

Copying a Queue

If you want to create a new queue that is very similar to an existing queue, you can do so quickly by copying the existing queue and
modifying its settings.
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To create a new queue:

1. In the Queues screen, in the Queues List, under Action, click Copy. You are prompted to provide a name for the new queue.

2. Enter an name and click OK. A copy of the queue is added to the list of queues. All of its properties are identical with the queue
from which it was copied, except its name.

Note: Once you have created a queue by copying an existing one, you can modify it as you would any other existing queue, as
explained above.

 

See also

Creating a New Queue
 

Home > Quality Monitoring > Forms Manager

Forms Manager

The Forms Manager is used to create forms for users to fill in after they have reviewed calls or participated in coaching sessions.
After a form is filled out, SpeechMiner automatically analyzes it and extrapolates an overall score from the user's answers to the
questions it contains. The system can also generate statistical analyses from collections of filled-in forms (see QM Agent Summary).
For example, you can see the average score of a particular type of form. 

Forms can contain multiple questions of various types, including yes-no questions, multiple-choice questions, and questions requiring
free-text responses. Each question can be either required or optional, and questions can be grouped. Conditional forms, which are
incorporated into other forms only when certain conditions are met, can also be defined. 

The system has two Forms Managers, one for the Quality Monitoring system and one for the Coaching system. Both managers work in
the same way, which is described in this section. The only exception is that the Coaching system does not support conditional forms.
For information on filling in forms after listening to calls, see Filling in Forms; for information about filling in forms after taking part in
coaching sessions, see Taking Part in a Session.

To open the Forms Manager:

For the Quality-Monitoring system: In the Main Menu, in the Quality dropdown menu, select Forms Manager.

For the Coaching system: In the Main Menu, in the Coaching dropdown menu, select Forms Manager.

Forms Manager (Quality-Monitoring system)

The Forms Manager lists all of the forms that exist in the system, divided into two groups: general forms and conditional forms.

Columns in the Forms List

The Forms List contains the following columns:

Column Description
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Name The name of the form

Description The description of the queue

Creator The name of the user who created the form

Created The date and time at which the form was created

Modified The date and time at which the form was last modified 

Calls The number of calls for which the form has been filled in 

Active The status of the form:

 - Active form - available for users to fill in
 - Inactive form - not available for users to fill in

Note: Inactive forms are only visible when View Inactive is selected at the top of the list.

Actions Click one of the links to select an action (see Managing Forms).

Sorting the Columns 

You can sort the rows of the Forms List by any of the columns (except the Actions column).

To sort the list by a column: 

Click the column heading. (To reverse the sort order, click the column heading again.)

  

See also

Creating a New Form
Managing Forms

Queues
Taking Part in a Coaching Session
Filling in Forms in the Media Player

 

Home > Quality Monitoring > Forms Manager > Creating a New Form

Creating a New Form

Each form has a name, optional description, notes, and a list of questions. The questions can be grouped, and multiple-choice
questions can have numbered or textual answers. In addition, each question can be defined as required or optional, and Yes/No and
multiple-choice questions can be assigned weights.

The weight of each question is used to calculate the overall score of the form when a user fills it in. For example, a form could contain
three questions, one in which the user is asked to rate the agent's handling of the caller, a second in which the user is asked to rate
how difficult the caller was to handle, and a third in which the user is asked to type comments. The first two questions could be
required, while the third was optional. Users would not be able to save the form if they did not answer the first two questions, but
they could leave the third blank if they chose. The first two questions could be weighted 65% and 35% respectively, and the overall
score on the form would be calculated based on these weights.

Two types of multiple-choice questions are supported. Standard multiple-choice questions with 3, 5, 7 or 10 options only permit one
answer to be selected; Multiple-Response questions, can offer between two and ten options, and the user can select as many of them
as they wish. Multiple-Response questions cannot be assigned weights; normally, their weight is "0%." However, any or all of
their answers can be marked "auto-fail." If the user selects an auto-fail answer, the weight of the question become 100%, and the
score of the entire form becomes "0." That is, the auto-fail option can be used to override the scores of all the other questions on the
form. 

In a form, answers to standard multiple-choice questions are arranged horizontally in a row and have round checkboxes, while
answers to Multiple-Response questions are arranged vertically and have square checkboxes. Auto-fail questions appear in the form in

109 . Quality Monitoring

 

SpeechMiner® User Guide Release 8.0  © 2013, Genesys Inc. Unauthorized Reproduction is Prohibited



red with an asterisk (*) beside them. For example, in the form below, Q1 is a Multiple-Response question for which answer 6 is an
auto-fail answer, and Q2 and Q3 are standard multiple-choice questions. 

Two types of forms are supported by the system:

General forms: Stand-alone forms that contain questions that are relevant to all types of calls or coaching sessions

Conditional forms: Forms that contain additional questions and are automatically added to general forms when a call belongs
to specified Categories (Quality-Monitoring only; not available for Coaching forms) 

Forms and their contents are automatically saved in the system as you design them. New forms are inactive until you activate them.
Users can only see and fill in active forms.

A form can be selected as the default for one or more Programs. When it is, and it is active, it appears at the top of the list of forms
available to users when they are reviewing calls from the selected Programs. Users can still select other forms to fill out if they need
to do so.

Opening a Blank Form

The first step in creating a new form is opening a blank form. When the blank form is opened, it contains no questions and is not
active. However, it is automatically saved in the system. If you choose to display inactive forms in the Forms List, it will appear there,
even if you do not add any questions to it. 

Note: You can also create a new form by making a copy of an existing form and editing the copy as necessary.

To create a blank form:

1. In the Forms Manager screen, click New. The New Form dialog box opens.
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1. In the Forms Manager screen, click New. The New Form dialog box opens.

New Form dialog box

2. Fill in the fields as follows:

Field Description

Name Type a name for the form.

Description Type a description for the form (optional).

Note Add additional notes as necessary (optional).

Type 
Select the type of form (General or Conditional).

Note: This field is not available for Coaching forms, whose type is automatically set to Coaching. 

3. 

4. Click Save. The Form Designer opens and displays a blank form.

Blank form in the Form Designer
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Adding Questions to a Form

The following types of questions can be added to a form:

Yes/No: Questions that should be answered with either yes or no. 

Multiple Choice (3): Multiple choice questions with three possible answers (the user can select no more than one answer)

Multiple Choice (5): Multiple choice questions with five possible answers (the user can select no more than one answer)

Multiple Choice (7): Multiple choice questions with seven possible answers (the user can select no more than one answer)

Multiple Choice (10): Multiple choice questions with ten possible answers (the user can select no more than one answer)

Free Text: Questions that are answered by typing in free text

Multiple Response: Multiple choice questions with between 2 and ten possible answers that allow the user to select as many
answers as they wish

Each question is automatically included in a group, and has a title as well as the actual text of the question. The possible answers to
multiple choice questions can be edited as required. New questions are initially added at the end of the form, but can be moved to
other locations later on. 

Adding a Question to a Form

You can add questions to a form as necessary. The questions are added at the end of the form. You can move them to other
locations at any time (see below). 

To add a question to a form:

1. At the lower left of the Form Designer, click the type of question you want to add. A blank question of the selected type is
added to the form. It is automatically added at the bottom of the form, and included in the last group in the form. The first
question inserted into a blank form is included in the default group, which is initially called New Group. For information about
changing the name of a group, see below. 

New Yes/No question

2. Click Insert question title to modify the question title. The title becomes a text field.

Question Title text field

3. Edit the title and then click Save to save the new title.

4. Click Insert question text to modify the question text. The text becomes a text field.
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Question Text text field

5. Edit the text and then click Save to save the new text.

6. If the question is required, select the Required checkbox.

7. For multiple-choice and Multiple-Response questions, if you want to replace the default numbers with text, edit the answers as
explained below.

Editing Multiple-Choice Answers

When you add a multiple-choice or Multiple-Response question to a form, each of the possible answers is assigned a number. You can
replace the numbers with text as necessary.

To edit multiple-choice or Multiple-Response answers:

1. Below the answers, click Edit answers. A text box opens, and displays each of the answers on a separate line.

Multiple choice answers in text box

2. Edit each line as necessary.
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Editing multiple-choice answers

3. For Multiple-Response questions, mark all auto-fail answers with {x}. (They are displayed in the form with an asterisk after
them.)

Multiple-Response question with answer #6 marked with {x} to indicate it is an auto-fail answer

4. Click Save. The edited answers replace the default numbers.

Edited multiple-choice answers

Moving Questions within a Form

New questions are automatically added at the end of the form. You can move them to other locations in the form as required.

To move a question to a different location:
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Drag the  icon that appears to the left of the question title. The question moves up or down in the form as you drag it.
Release your mouse button to drop the question when it is in its intended location. 

Managing Question Groups

All of the questions in a form are included in question groups. When  you add the first question to a form, a default group, called New
Group, is automatically added to the form, and the question is included in it. You can change the name of a question group, add
additional question groups, and rearrange existing question groups as required. The system can analyze the responses for each group
separately in the QM Agent Summary report.

Changing the Name of a Question Group

 You can change the name of any question group in the form.

To change the name of a question group:

1. Click the name of the group. The name becomes a text field.

Group Name text field

2. Edit the name

3. Click Save to save the new name.

Adding Question Groups to a Form

You can add question groups to a form as necessary. For example, you could have one group of questions call "Caller" containing
questions about the caller and another group called "Agent" containing questions about how the agent handled the call. Questions can
be moved from one group to another as necessary (see above).

To add a question group to a form: 

At the top of the form, click Add group. A new group is added at the bottom of the form.

Changing the Order of Question Groups in a Form

You can move existing question groups up or down in a form.

To move a question group up or down in a form:

In the upper right corner of the group, click  to move the group up or  to move it down.

Managing Question Weights

Weights are assigned to Yes/No and multiple-choice questions in a form. The weights indicate the relative importance of each
question, and are used by the system to calculate the score of the form when it is filled in by a user. The sum of all the weights in a
form must be 100%. 

The Forms Designer shows the current sum of the weights in the left column under Total Weight. A form cannot be activated if the
sum of the weights is not 100%. You can modify the weights assigned to questions in one of two ways:

Automatically, by assigning equal weights to all questions 

Manually, by editing the weights of individual questions

115 . Quality Monitoring

 

SpeechMiner® User Guide Release 8.0  © 2013, Genesys Inc. Unauthorized Reproduction is Prohibited



Automatically Assigning Weights to Questions

You can assign equal weights to all of the Yes/No and multiple-choice questions in a form.

To assign equal weights to all of the questions in a form:

1. In the left column of the Forms Designer, under Total Weight, click Rebalance Weights. You are prompted to confirm that
you want to rebalance the weights. 

2. Click Yes. The weights of all the questions are reset such that they all are equal and the total is 100%.

Manually Editing Weights

You can manually modify the weight of any Yes/No or multiple-choice question in a form. 

Note: Make sure that the total of all of the weights is 100% before you try to activate the form.

To manually edit the weight of a question:

1. In the upper-right corner of the question area, click the weight. The weight becomes a text field.

Weight text field

2. Edit the weight as necessary.

3. Click Save. The weight is updated.

Previewing a Form

As you add questions and question groups to a form, you may want to see how the form would look to users. To do this, you can open
a preview of the current form in a separate window. In the preview window, you can collapse question groups if you wish. 

To see a preview of the form that is open in the Form Designer:

In the upper-left corner of the Form Designer, click Preview. A window opens and displays the form as it would look to users. 
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Preview window

To collapse or expand question groups in a Preview window:

Click the name of the group. 

Collapsed question groups in a Preview window
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Saving a New Form

The changes you make to a form as you design it are automatically saved in the system. During the design process, you can close the
form at any time, and the changes you made to it are saved. You can edit it later to continue the design process.

While a form is being designed, it is not active, and is not available to users. When you want to make a form available to users, you
must activate it. Furthermore, many form-editing features are not available when a form is active. For example, you must deactivate it
to change the locations of questions and question groups.

You can select a Program default for a form. When you do so, the form appears at the top of the user's list of available forms when a
call from the selected program is being reviewed.

Activating a Form

While you are designing a form, it is deactivated. When you have finished designing a form, you can activate it. Once the form is
activated, it appears in the list of forms available to users. In addition, you can only choose the conditions for a Conditional form after
it is activated. The activation status of a form appears on the left side of the Form Designer, under Is Active.

Note: Inactive forms are only listed in the Forms Manager if the View inactive option is selected (see Forms Manager).

To activate a form:

On the left side of the Form Designer, under Is Active, click Activate.

Closing the Form Designer

You can close the Form Designer at any time. Changes you have made to the current form are automatically saved when you close the
Form Designer.

To close the Form Designer:

At the upper-right of the screen, click Back to Forms Manager.

Note: If the form is note active, you are asked whether you want to activate the form. Click Yes to activate the form or No to
leave it deactivated.

Selecting Default Programs for a Form 

Once a Quality-Monitoring form is activated, you can select Programs for which it is the default form if you wish. When users open the
list of forms for calls belonging to these Programs, the form appears at the top of the list of available forms.

Note: This option is not available for Coaching forms.

To select Programs for which a form is the default:

1. In the Forms Manager, under Actions, select Programs. A Program-selector dialog box opens.
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Program-selector dialog box for default form

2. Select the Programs for which you want the form to be the default.

3. Click Save. The form becomes the default for the selected Programs.

Selecting the Conditions for a Conditional Form

Once a Conditional form is activated, you can select Categories for which it is to be used. When a user opens a general form for a call
that belongs to any of these Categories, the Conditional form is added to the general form.

Note: This option is not available for Coaching forms.

To select Categories for which a conditional form should be used:

1. In the Forms Manager, in the list of Conditional forms, under Actions, select Categories. A Category-selector dialog box
opens.
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Category-selector dialog box for Conditional form

2. Select the Categories for which you want the form to be used.

3. Click Save. The conditions are set.

 

See also

Managing Forms
 

Home > Quality Monitoring > Forms Manager > Managing Forms

Managing Forms

Existing forms can be edited, activated, deactivated, or deleted. In addition, in the Quality-Monitoring system, the Programs for which
a form is the default, and the Categories associated with a Conditional form, can be modified.

Copies of existing forms can also be created as necessary. This can be useful when a new form is required that is similar to an
existing form. The copy can be edited as necessary after it is created.

Editing a Form

You can edit any of the items in a form. Note, however, that some items can only be edited when a form is deactivated, as explained
below.

To edit a form:

1. In the Forms Manager, under Actions, select Edit. The form opens in the Form Designer.

2. To modify the form's name, description, or notes, the name of a question group, the title, text, or weight of a question, click
the text. The text becomes a text field. Edit the text field as required, and then click Save. 

3. To modify the text of multiple-choice answers, click Edit answers. The answers open in a text box, with one answer per line.
Modify the lines as required, and then click Save.
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Note: For additional information about the Form Designer, see Creating a New Form.

Activating or Deactivating a Form

Forms are only available to users when they are activate. Many editing features are only available for deactivated forms. The
following items can be edited without deactivating a form:

Name

Description

Notes

Question-group names

Question titles

Question text

The following items cannot be edited without deactivating a form:

Locations of questions and question-groups

Text of answers to multiple-choice questions

Required status

Weight

Forms can be activated or deactivated in the Forms Manager or in the Form Designer. If you use the Forms Manager, you can activate
or deactivate a batch of forms at one time. If you use the Form Designer, you can only activate or deactivate the open form. The
current activation status appears in the Forms Manager under Active, and in the Form Designer, on the left side, under Is Active.

To activate or deactivate one or more forms in the Forms Manager:

1. In the list of forms, select the checkbox to the left of each form you want to activate or deactivate.

2. At the top of the list, click Batch Actions, and then, in the dropdown menu, select Activate or Deactivate.

To activate or deactivate a form in the Form Designer:

On the left side of the Form Designer, under Is Active, select Activate or Deactivate.

Deleting Forms

In the Forms Manager, you can delete forms individually or in a batch.

To delete a single form:

1. In the list of forms in the Forms Manager, under Actions, select Delete. You are prompted to confirm you want to delete the
form.

2. Select Yes. The form is deleted.

To delete a batch of forms:

1. In the Forms Manager, select the checkbox to the left of each form you want to delete.

2. At the top of the list, click Batch Actions, and then, in the dropdown menu, select Delete. You are prompted to confirm that
you want to delete the selected forms.

3. Click OK. The selected forms are deleted.

Modifying Default Program Selections

You can modify the list of Programs for which a Quality-Monitoring form is the default.

To modify the list of Programs for which a form is the default:

1. In the list of forms in the Forms Manager, under Actions, select Programs. A Program-selector dialog box opens, with the
current selections selected.

2. Modify the selections as necessary.

3. Click Save. The changes are saved. 
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Modifying the Categories of Conditional Forms

You can modify the list of Categories associated with a Conditional form. 

To modify the list of Categories associated with a Conditional form:

1. In the list of conditional forms in the Forms Manager, under Actions, select Categories. A Category-selector dialog box
opens, with the current selections selected.

2. Modify the selections as necessary.

3. Click Save. The changes are saved. 

Copying a Form

You can make a copy of any active form. Once you have done so, you can edit the copy as necessary to create a new form.

To copy an existing form:

1. In the list of forms in the Forms Manager, under Actions, select Copy. You are prompted to give a name to the new form.

2. Enter a name for the form, and then click OK. The copy is created and appears in the list. (The copy is not activated, and only
appears in the list if View inactive is selected.)

 

See also

Creating a New Form
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Home > Coaching

Coaching
The coaching system is designed to help managers, supervisors, quality-monitoring personnel, and agents with training processes. In
the system, coaching sessions are created for trainees to take part in. The sessions consist of lists of calls that the trainee is asked to
listen to, either in part or in their entirety. In addition, they may include notes, Action Items, and links to other sites. While anyone with
the required permissions can open a new coaching session, it is the session's coach who designs the session by defining the
Interaction Lists, Action Items, and links, and by adding notes to guide the trainee through the session. 

Both novice and experienced personnel can benefit from taking part in a training session; new employees can be introduced to their
jobs through a coaching session, and veterans can be encouraged to fine-tune their techniques by means of coaching sessions that
highlight specific aspects of their jobs.

 

See also

Working with the Coaching Session List
Taking Part in a Session
Creating a New Coaching Session
Coaching Session Reports
Managing Session Types

 

Home > Coaching > Working with the Coaching Session List

Working with the Coaching Session List
The coaching Sessions screen lets you see which coaching sessions exist, gives general information about each session, and enables
you to access the Session Details screen in which you can manage or take part in individual sessions.

To open the Sessions screen:

In the Main Menu, under Coaching, select Sessions.  
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Sessions screen

The left side of the Sessions screen contains the session list, a table that lists the existing sessions. Below the session list is a
calendar that shows when the sessions are scheduled. The right side of the screen displays details about the session that is selected
in the table. 

Columns in the Sessions

The session list contains the following columns:

Column Description

Status The status of the session. (See below for a list of possible statuses.)

Schedule Date The beginning of the time range when the trainee is meant to take part in the session

Name The name of the session

Coach The username of the coach 

Trainee The username of the trainee

Actions Click one of the buttons to select an action. (See below for a list of actions.) 
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Session Statuses

Session statuses are indicated by icons in the Session List and by color-coding in the calendar. The following session statuses are
defined:

Status Description  Icon Color-coding 

Scheduled The session has been created, but was not yet started.   Yellow

In Progress The trainee is currently taking part in the session.   Yellow

On Hold The session was paused after the trainee began taking part in it.   Red

Completed The trainee has finished taking part in the session.   Green

Action Options

The Actions column contains buttons that you can use to perform an action related to a session in the list:

Button Description

 Adds the session to the Outlook calendar on your local computer

 Resends the e-mail notification about the session to the coach and the trainee

 Creates a Permalink to the session.

 Opens the Session Details screen in Setup mode so that you can add content to the session or modify the session
properties or content 

Note: Only available to the creator and coach; the trainee cannot open the Session Details in Setup mode

 Generates a report containing statistical information about all of the sessions assigned to the trainee of the selected
session

 

Filtering the List

You can use filters to limit the sessions that are displayed in the list to those that meet criteria you specify. Two types of filters are
available:

General filters, which allow you to filter the list based on user and date, and let you choose whether to include completed
sessions in the list.

Column-based filters, which allow you to filter the list based on session status and trainee

General Filters

The general filter controls are located at the top of the session list. The following filters are available:

Filter
Type

Description

User Select All Sessions to display all sessions that you have permissions to see. Select My Sessions to include only
view sessions in which you are either the creator, the coach or the trainee.

Date
Range

Under From, select the beginning of the period to include in the list. Under To, select the end of the period to include
in the list.

Completed Select the Completed checkbox to include sessions that were completed in the list. Clear the checkbox to only
include sessions that were not yet completed.
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Column-Based Filters

Column-based filters are located in the column headings of the Status and Trainee columns.

To use the Status filter:

In the heading of the Status column, in the dropdown list, select the status you want to include in the session list. Only
sessions with the selected status are displayed in the list. To view sessions with any status, select All.

To activate the Trainee filter:

In the text box to the right of the Trainee heading, type part of the name or username of the trainee you want to include in the
list. As you type, names and user names containing those letters are displayed in a dropdown list. Select the trainee from the
list. Only sessions with the selected trainee are displayed in the list.

To deactivate the Trainee filter:

Delete the text in the text field and then press Enter. Sessions for all trainees are displayed in the list.

Sorting the Columns

You can choose to sort the session list by any column.

To sort the session list by a column:

Click the title of the column.

Note: Click the title a second time to reverse the sort order. 

Working with the Calendar

The lower left part of the screen contains a calendar in which you can see when the sessions that appear in the list are scheduled to
take place. You can choose a monthly, weekly, or daily display. You can also open the Session Details screen for a session directly
from the calendar.
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Monthly calendar display

Weekly calendar display
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Daily calendar display

To select the type of calendar display:

At the upper-right of the calendar area, click month, week, or day. The calendar display changes to the selected type.

To choose the time period to display:

In the upper-left of the calendar area, click  to display the previous time period (e.g., if you are displaying a weekly calendar,
the previous week), or  to display the next time period.

To open the Session Details screen for a session that appears in the calendar:

Click the session in the calendar.

Viewing Session Details

You can view a summary of the properties and contents of a session in the Sessions screen.

To view session details in the Sessions screen:

In the session row, click anywhere in the text except for the name of the session. The session details are displayed on the right
side of the screen. 
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Session Details 

The display includes five boxes:

Box Description

General
Details

The status and properties of the session. If the trainee has already begun to take part in the session, the start time, end
time, and duration of their participation appears. Otherwise, only the Due Dates appear.

Notes Lists all public notes that are attached to the session, and all private notes that you attached to the session.

Call
Lists

Lists all Call Lists that are attached to the session. For each Call List, indicates how many calls have comments, and how
many calls are in the list. For example, (1,3) indicates that one call in the list has comments, and the list contains three
calls.

If a call has comments, the comments appear below the Call Listing.

Action
Items 

An Action Items box in which all Action Items associated with the session appear

Links Lists all links that are included in the session, and indicates whether the trainee has opened them yet 

 

Opening the Session Details Screen

The Session Details screen is used by the creator or coach to manage an individual session - adding Call Lists and notes and
modifying properties (see Creating a New Coaching Session) - and by the trainee to take part in the session by listening to the calls
(see Taking Part in a Session).

Note: The creator or coach can also open the Session Details screen in Setup mode, as explained above.
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To open a session in the Session Details screen:

In the session list, click the name of the session. 

Creating a New Session

You can create a new session from the Sessions screen.

To open a new session:

1. At the top of the list, click New Session. The New coaching session dialog box.

2. Follow the instructions under Creating a New Coaching Session. 

Deleting Sessions

You can delete one or more coaching sessions.

To delete coaching sessions:

1. Select the checkbox to the left of each session you want to delete.

2. At the top of the list, click Delete Session. You are prompted to confirm that you want to delete the sessions.

3. Click OK. The sessions are deleted, and a confirmation message appears. 

 

See also

Taking Part in a Session
Creating a New Coaching Session
Coaching Session Reports
Managing Session Types
 

Home > Coaching > Taking Part in a Session

Taking Part in a Session

Trainees take part in a coaching session by opening the session in the Session Details screen. In this screen, they can listen to the
calls, read the notes, open the links, and manage the Action Items attached to the session. When they have completed the session,
they can fill in a feedback form, as appropriate.

Accepting a Session 

When you receive an invitation to a session, you can accept the session (available only for the trainee). When you do so, the invitation
is erased from your message list.

To accept a session:

In the Views page, in the My Messages widget, in the session-invitation line, click Accept.

Opening a Session 

When you are ready to take part in a session, open it in the Session Details screen. 

To open a session in the Session Details screen, do one of the following:

In the Views page, in the My Messages widget, click the subject of the message inviting you to the session.

In the Sessions screen, in the session list, click the name of the session.
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Session Details screen 

Overview of the Session Details Screen 

When you first open it, the Session Details screen contains the following elements:

Element Description

Session
controls

Bar across the top of the screen that contains a link to the Sessions screen, session status information, and
session controls 

General
Details

Call Lists and links attached to the session

General Session properties

Call Lists Summary information about each Call List attached to the session. For each Call List, indicates how many calls have
comments, and how many calls are in the list. For example, (1,3) indicates that one call in the list has comments, and
the list contains three calls.

If a call has comments, the comments appear below the summary information.

Action
Items 

Action Items box listing all Action Items linked to the session. For information about using the Action Items box, see
Managing Action Items.

Links Summary information about the links that are attached to the session.

Notes Lists all public notes that are attached to the session, and all private notes that you attached to the session.

Progressing Through the Session

Once the session is open, click Start Session to begin taking part in it. The start time of the session is recorded, and the status is
changed to In Progress. During the session, click Pause Session to temporarily stop taking part. Click End Session when you have
completed the session.

Note: The coach can also pause the session or mark it as completed.

During the session, use the session notes to guide you through the session. Listen to the calls in the Call Lists and pay special attention
to those parts that are mentioned in the notes. 

Listening to Calls 

The Call Lists attached to the session can be opened in a Interaction Grid, and the calls can be played back in a Media Player, in
the Session Details screen.
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To view a Call List:

On the left side of the screen, under General Details, click the name of the Call List. An Interaction Grid opens on the right
side of the screen, in place of the General, Call Lists, and Notes boxes, and lists all of the calls in the list. For detailed
information about Interaction Grids, see Using the Interaction Grid.

To play back a call:

In the Interaction Grid, click the Play button ( ) in the call's row. The Media Player opens below the grid and begins to play the
call. For detailed information about the Media Player, see Using the Media Player.

Filling in a Form

The trainee can fill in a form related to the coaching session. For example, the trainee can fill in a feedback form, or a short quiz
about the session.

Only one form can be filled out for each session. If you have already filled out a form, you can edit it if you wish. If you want to fill out
a different form, you must first delete the first form. If you have not yet filled out a form for the session, the Fill Form button appears
at the top of the screen. If you have already filled out a form, the form is displayed in the Session Details screen below the Notes
section, and the Edit Form button appears in place of the Fill Form button.

Note: For information about creating forms, see Forms.

To fill in a form:

1. At the top of the screen, click Fill Form. The Select Form dialog box opens and displays a list of available forms.

2. Click the form you want to fill out. The form opens in a new window.

3. Fill in the form and then click Submit Changes. The values you chose are saved in the system, and the form is displayed in
the Session Details screen below the Notes section.

4. To close the form, click Close.

To edit a form: 

1. At the top of the screen, click Edit Form. (Alternatively, in the title bar of the form, click Edit.) The form opens in a new
window.

2. Modify the form as necessary, and then click Submit Changes. The changes are saved. 

3. To close the form, click Close.

To delete a form: 

1. At the top of the screen, click Edit Form. (Alternatively, in the title bar of the form, click Edit.) The form opens in a new
window.

2. Click Delete. You are prompted to confirm that you want to delete the form. 

3. Click Yes. The form is deleted and the window closes.

 

See also

Working with the Coaching Session List
Creating a New Coaching Session
Coaching Session Reports
Managing Session Types
 

Home > Coaching > Creating a New Coaching Session

Creating a New Coaching Session

This section explains how to open a new coaching session, set it up by adding Call Lists, notes, Action Items, and links to the session,
and manage its contents once it is set up.

Note: New coaching sessions can be opened in a number of ways:
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In the Coaching page

In the Views page, in the My Messages widget

In a Interaction Grid or an Event Grid, from the More Actions menu

This section explains how to open a new session in the Coaching page. For information about opening a coaching session in one of
the other ways, please refer to the relevant sections of this manual. Regardless of how you open the coaching session, you will most
likely want to add Call Lists, notes, and other items to the session, as explained in this section.

Opening a New Session

When you open a new coaching session, you specify the name of the session, the coach, the trainee, and the date and time when the
trainee should take part in the session. If you wish, you can also add either a public or private note. The session then appears in the
list of sessions, but it does not have any content.

To open a new coaching session:

1. In the Main Menu, in the Coaching dropdown menu, select Sessions. The Sessions screen opens.

Sessions screen

2. At the top of the Sessions List, click New Session. The New coaching session dialog box opens.
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New coaching session dialog box

3. Fill in the fields as follows:

Field Description

Session Name Type a name for the session.

Schedule Date Click the calendar icon ( ) to select the date and time period during which you want the trainee to take
part in the session.

Coach 
Select the coach in one of the following ways:

In the text field, type part of the name or username of the coach. As you type, names and user
names containing those letters are displayed in a dropdown list. Select the coach from the list.

Click the ... button ( ) beside the text field. In the dialog box, select the user from the list of users
in the relevant workgroup.

Trainee
Select the trainee in one of the following ways:

In the text field, type part of the name or username of the trainee. As you type, names and user
names containing those letters are displayed in a dropdown list. Select the trainee from the list.

Click the ... button ( ) beside the text field. In the dialog box, select the user from the list of users
in the relevant workgroup.

Type Select the type of coaching session from the list. 

Public/Me If you are adding any notes in the Notes field, select Public if you want the notes to be visible to anyone
who can access the session or Me if you only want the notes to be visible to you.

Notes Type any notes you want to attach to the session. Public notes can be used to help the trainee and/or the
coach with the session.
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4. Click Save. The coaching session is opened; it appears in the Sessions List and in the schedule below it. It is selected in the
Sessions List and its details are displayed in the Sessions screen, to the right of the Sessions List. An invitation message is
sent to the My Messages boxes of the coach and the trainee. In addition, if their user profiles include e-mail addresses,
notifications are sent to their e-mail addresses. The notification e-mails include an iCal file. When this attachment is opened,
the session is automatically added to the user's Outlook calendar.

Adding and Managing Session Call Lists

Once a coaching session is open, you can add calls to it. Calls are added as Call Lists. Two types of Call Lists can be added:

Saved Searches: Sets of call search criteria that can be used to retrieve lists of calls.

Call Lists: Lists of calls that were created manually by adding specific calls. The calls can be added from a Call or Event grid or
from a Media Player.

Note: For additional information about the two types of Call Lists, see Saved Searches.

Call Lists can be added in the Session Details screen, in setup mode. Once they have been added, the lists can be modified by
adding more calls and removing existing calls. Modifications that are made to a Call List in the Coaching page do not affect the original
Call List.

To open the Session Details screen:

1. In the Main Menu, under Coaching, select Sessions. The Sessions screen opens.

Note: For additional information about the Sessions screen, see Managing the Coaching Session List.

2. In the session list, under Actions, click the Setup button ( ) of the session. The Session Details screen opens for the
session, and Session is in setup mode appears above the session-details area.

Session Details screen in setup mode

Adding Existing Global Call Lists to a Session 

The simplest way to add Call Lists to a coaching session is to select existing global Call Lists and copy them to the session. When a
global Call List is added to a coaching session, a copy of the original list is made and attached to the session. The copy becomes a
coaching-session Call List, and is not linked to the original global Call List. It can only be viewed from the coaching session. From
within the coaching session, you can add or remove calls from an attached Call List and change the search criteria of a Saved Search.
These modifications do not affect the original, global Call Lists or Saved Searches.

To add a Call List to a coaching session:

1. In the Session Details screen, on the left side of the screen, under General Details, click the + sign ( ) beside Calls. A
list of global Call Lists and global Saved Searches appears.

2. Select a Call List. The list closes. A copy of the Call List is created and attached to the session, and appears in the relevant
section (Call Lists or Searches) under General Details.

Note: You can also add existing Call Lists to a coaching session from the Saved Searches page.

Creating New Call Lists within a Session

You can create additional coaching-session Call Lists within a session. You can do this by performing a call search within the session
or by opening a Call List that is already attached to the session and saving some of the calls in a new Call List.
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To perform a call search:

1. In the Session Details screen, on the left side of the screen below the Calls list, select New Search. A Call Search form
opens on the right side of the screen.

2. Fill in the search criteria. For additional information, see Creating a New Call Search.

3. Click Search. The search results appear to the right of the form.

To save the search criteria as a Saved Search: 

1. In the upper-left of the Call Search form, click Save. You are prompted to provide a name for the Saved Search.

2. Fill in a name for the Saved Search and click OK. The search is saved in the coaching session and appears under Searches in
the General Details.

To save some or all of the calls in a coaching-session Call List:

1. Select the checkbox next to each call you want to add to the Call List.

2. At the top of the list, under Batch Actions, select Add To and then select one of the following:

If you want to Select Result 

Create a new Coaching session
and a new coaching Call List
within that session, and add the
calls to the new Call List

Coaching >
New

A New Coaching session dialog box opens. Specify the
name and other settings of the Coaching session, and then
click Save. The dialog box closes, and a new Call-List dialog
box opens. 

In the text field, type a name for the Call List, and then click
OK. The Coaching session and Call List are created, and the
calls are added to the Call List.

Create a new coaching Call List
within an existing Coaching
session, and add the calls to the
new Call List

Coaching >
[existing
Coaching
session] > New

A Call-List dialog box opens. In the text field, type a name for
the Call List, and then click OK. The new coaching Call List is
created and attached to the Coaching session, and the calls
are added to the Call List.

Add the calls to an existing
coaching Call List that is attached
to an existing Coaching session

Coaching >
[existing
Coaching
session] >
[existing Call
List]

The calls are added to the selected coaching Call List.

Add the calls to a new Call List
(Will not be linked to a specific
coaching session)

Call List >
New 

A Call-List dialog box opens. In the text field, type a name for
the Call List, and then click OK. The new Call List is created
and the calls are added to it.

Add the calls to an existing Call
List (Will not be linked to a
specific coaching session)

 Call List>
[existing Call
List]

 The calls are added

 

Modifying Session Call Lists

Once a Call List is attached to a Coaching session, you can add calls to it or remove them as necessary. Calls can be added to a Call
List from any Call or Event Grid or from the Media Player. You can also remove calls from a list. If the Call List was copied from a
global list, the global list is not affected by changes you make to the coaching-session list.

To remove calls from a Call List:

1. Under General Details, click the name of the Call List. The list opens in an Interaction Grid on the right side of the screen.

2. Select the checkbox to the left of each call you want to remove from the Call List.

3. Under Batch Actions, select Delete From List. The selected calls are removed from the list.
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Removing a Call List from a Session

You can remove Call Lists from a session. 

To remove a Call List:

1. Under General Details, click the x ( ) to the right of the name of the Call List. You are prompted to confirm that you want to
remove the Call List from the session.

2. Click OK. The Call List is removed from the session.

Adding and Managing Session Notes

Session notes can be defined as public or private.

Public notes are visible to everyone who accesses the session. They are generally intended to help trainees understand the
purpose of the coaching session and draw their attention to the aspects of the calls that need to be highlighted.

Private notes are only visible to the person who writes them. You can use them to add reminders or comments to yourself.
For example, when you create a session, you can leave yourself a note reminding you to add a link later, when you have the
URL of the link.

Notes can be added to a session when it is first opened (see above) or at any other time. The notes are displayed in the Session
Details that can be viewed beside the session list in the Session List screen and in the Session Details screen. You can also edit
and delete existing session notes.

To add a note to a coaching session: 

1. In the Session Details screen (see above), in the title bar of the Notes box, click New. A blank New Note form opens.

Note: If the Notes box is not visible, in the upper-left corner of the screen, click General Details.

2. Type the note in the text field.

3. In the dropdown menu, select Public if you want the note to be visible to anyone who can access the session or Me if you only
want the notes to be visible to you.

4. Click Add. The note is added to the session.

To edit or delete a note:

In the Session Details screen (see above), in the Notes box, select Edit or Delete as necessary.

Adding and Managing Action Items

You can add Action Items to a coaching session. For example, if you want the trainee to perform a particular task as part of a
coaching session, you could open an Action Item in that coaching session to specify that task. When you open an Action Item within a
coaching session, the Action Item appears in the coaching session and can be managed from there. It also appears in the general
Action Items box, like other Action Items, and can be managed from there as well.

Note: For detailed information about working with Action Items, see Action Items.

To create an Action Item in a coaching session:

1. In the Session Details screen, click the Action Item button ( ). The Action Item dialog box opens.

2. Fill in the fields and then click Save. The Action Item is opened and appears in Action Items box in the Session Details
screen. In addition, it is added to both your general Action Items box and in the assignee's general Action Items box.

Note: For information about the fields of the Action Item dialog box, see Creating a New Action Item.

Adding and Managing Links

You can add links to external files, websites, and SpeechMiner Permalinks to a coaching session. For example, if you want the trainee
to look at a relevant website, you can add a link to the website. During the coaching session, when the trainee clicks the link, a new
window is opened and the link is displayed. For example, if you add a link to a website, a new browser window opens and displays the
website.

To add a link to a coaching session:
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1. In the Session Details screen, on the left side of the screen, under General Details, click the + sign ( ) beside Links. An
Add Link to Session dialog box opens

Add Link to Session dialog box

2. Under Description, enter a description for the link.

3. Under Link Text, enter the location of the link. For example, to add a link to Google, type http://www.google.com. 

4. Click OK. The dialog box closes, and the link is added to the list of links that appears under General Details under Links. 

To edit a link:

1. Under General Details, under Links, click the  beside the link you want to edit. An Add Link to Session dialog box opens.

2. Modify the Description and Link Text as required. 

3. Click OK. The dialog box closes, and the link is modified. 

To go to a link:

Under General Details, click the link. A new browser window opens and displays the link.

To delete a link:

1. Under General Details, click the x ( ) beside the link you want to delete. You are prompted to confirm that you want to
remove the link from the session.

2. Click Yes. The link is deleted

Managing Session Properties

Session properties - name, schedule date, trainee, coach, session type - are defined when you open a new session (see above). You
can modify these properties as necessary.

To modify session properties: 

1. In the Session Details screen (see above), in the title bar of the General box, click Edit.

Note: If the General box is not visible, in the upper-left corner of the screen, click General Details.

2. The properties of the session become text fields. Modify the text fields as necessary.

3. Click Save. The changes are saved.

 

See also

Working with the Coaching Session List
Taking Part in a Session
Coaching Session Reports
Managing Session Types
 

Home > Coaching > Coaching Session Reports

Coaching Session Reports
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Coaching session reports provide statistical information about the coaching sessions in the Session List. The reports break down the
sessions by status and indicate how many have not yet been started by their trainees, how many are in progress, and how many have
been completed. In addition, they show how long trainees already spent, on average and in total, on the sessions in each category.

Additional details about the sessions included in the report appear in the lower half of the report. The details are divided into groups
by trainee. You can expand a session to see additional information about it. You can also open its Session Details screen directly
from the report.

Coaching session report

Generating a Report

Coaching reports can be generated in the Sessions screen. Two forms of the report are available:

General report: This report includes all coaching sessions that are included in the set defined by the Session List's general
filters. For example, if the general filter specifies My Sessions for Sept. 1st through Sept. 30th, and included Completed
sessions, all session that meet these criteria are included in the report. (Column filters do not affect the criteria.)

User report: This report includes all sessions that are included in the set defined by the Session List's general filters and
belong to a specific user. That is, if the user is either the creator, coach, or trainee of a session, the session is included in the
report.

To generate a general coaching report:

In the Sessions screen, at the top of the list, click the Run Report button. The report is generated and is displayed in a new
browser window.

To generate a user coaching report:

In the Sessions screen, in a row in which the user is the trainee of the specified session, under Actions, click . A report for
all sessions in which the trainee is either the creator, the coach, or the trainee, is generated and is displayed in a new browser
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window.

Viewing Report Details

The lower part of a generated report lists the sessions that were included in the report. The sessions are grouped by trainee. The
name of each session, the name of the coach, the date it was scheduled to take place or the date on which its status was last
changed, the status, and, if the session was already begun or completed, the amount of time the trainee spent on it so far, are
displayed. You can view additional details about the session, listen to calls that the trainee listened to during the session, and open the
Session Details screen for the session.

To view additional details about a session:

Click the + beside the session name. Notes and resources (links) included in the session are displayed below the session name,
as well as links to all the calls that the trainee listened to during the session.

Expanded session showing details

To play a call that appears in the expanded list:

Click the call link. The Media Player opens in the window, and plays the call.

Note: To return to the report, press Backspace.

To open a session in the Session Details screen:

Click the name of the session. The Session Details screen opens in a new browser window.

 

See also

Working with the Coaching Session List
Taking Part in a Session
Creating a New Coaching Session
Managing Session Types
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Home > Coaching > Managing Session Types

Managing Session Types

Each coaching session has a type assigned to it. The type can help identify the purpose of the session and the type of trainee it is
intended for. By default, one session type, General, is defined. You can add additional session types as appropriate for your
organization.

Once a session type is saved, you cannot delete it. However, you can deactivate it if you do not want it to be available at present. (The
General type cannot be deactivated.) In addition, you can modify the name of an existing session type as necessary.

Note: For information about assigning session types to coaching sessions, see Creating a New Coaching Session.

To manage session types:

 In the main menu, under Coaching, select Edit Session Types. The Session Type Manager opens and displays a list of the
session types that are currently defined and their statuses.

Session Type Manager

To add a new session type:

1. Under New Type, type the name of the new session type.

2. Click Add. The session type is added to the list and its status is set to Active.

3. Click Save. The Session Type Manager closes, and the new session type is included in the list of available session types.

To activate or deactivate a session type:

1. Under Is Active, click the checkbox beside the session type to select or clear it. The session type is active when a checkmark
appears in the checkbox.

2. Click Save. The Session Type Manager closes, and the change is implemented.
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To modify the name of a session type:

1. In the list of session types, modify the name as necessary.

2. Click Save. The Session Type Manager closes, and the change is implemented.

 

See also

Working with the Coaching Session List
Taking Part in a Session
Creating a New Coaching Session
Coaching Session Reports
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Home > Reports

Reports

Reports are summaries and analyses of call, speech, and external metadata. You can view reports in your browser, print them, or
send them via e-mail.  To help you monitor your business, SpeechMiner offers a wide range of standard reports. Most reports are
provided as templates that can be customized, if necessary, to better suit your needs. Depending on the type of report, the results
may be presented as lists of data and/or in graphic form. In many cases, you can drill-down within a report to see additional details
about a particular item.

This section explains how to use the Reports page to select a template, customize its settings, run reports, and manage report
results. For additional information about specific parameters and a list of available report templates, see Appendix A: Standard
Reports. 

See also

Selecting a Template for a Report
Creating a Custom Report
Managing Saved Reports
MRS Library

 

Home > Reports > Selecting a Template for a Report

Selecting a Template for a Report

There are a number of ways to select a template for a report. If you do not know which template is most suitable for your purpose,
you can start by doing one of the following:

In this manual, skim over the catalog of available templates in Templates.

In the SpeechMiner interface, in the Main Menu, under Reports, select Templates. The Templates tab opens and lists all of

the available report templates. Place your mouse pointer over the Preview icon ( ) of each template to see a sample of its
results.

Once you know which template you want to use, select it in one of the following ways:

In the Main Menu, under Reports, in the Templates tab, click the Edit ( ) icon beside the template.

In the Main Menu, under Reports, in the Edit Report tab, in the Template dropdown list, select the template.

The selected template opens in the Edit Report tab. For information about using this tab to customize and run the report, see
Creating a Custom Report. For information about customizing reports for display in the Views page, see Managing Widgets.

See also

Creating a Custom Report
Managing Saved Reports
MRS Library
 

Home > Reports > Creating a Custom Report

Creating a Custom Report
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This section explains how to use the Edit Report tab of the Reports page to create and run custom reports.

Edit Report tab 

Customizing the Settings of a Report 

When a report template is selected in the Edit Report tab of the Reports page, the fields that can be used to customize the report
are displayed. Each report template has a different set of fields.

All templates include the following fields:

Field Description

Report Name The name of the report in SpeechMiner. This name identifies the report in the list of saved reports.

Report Title The title of the report, displayed above the report results

 

Each template includes other fields as appropriate. The fields are divided into two categories:

Data Set Filters: Parameters that limit or define the body of calls that should be used as the data set for the report. For
example, a data-set filter could limit the data to a specific date range or workgroup.

Items on Report: Parameters that will be graphically represented in the report. For example, the items on report could be a
list of agents that you select. Each agent could be represented in the report by a bar in a graph.

To customize the settings of a report:

1. In the Edit Report tab, under Template, select the required template.

2. On the left side of the screen (under Calls Filter), select the Data Set filters. These filters are configured in the same way that
the filters of the New Search screen are configured (except that Text Mode is not available). For additional information about
the filters and how to use them, see Common Parameters and Defining Search Criteria.

3. On the right side of the screen, under Items on Report, select the parameters you want to include in the report results.

Note: The symbol  beside a field indicates that selections for the field are made using a Multi-Select dropdown menu. This kind of

menu allows you to select multiple values for the field. Click the  symbol to open the menu. Select the required items one by one,
or right-click any item in the list to access global selection options. When you have selected all the required items, click  to close the
dropdown menu. The number of selected items is displayed in the text field. When no items are selected, Any appears. This means
the parameter is not taken into account at all during report preparation. For additional information about working with Multi-Select
boxes, see Defining Search Criteria.

When you are not configuring the Data Set filters, you can hide the left panel of the screen if you wish.

To hide or show the Data Set filter panel:

In the upper-right corner of the panel, click .
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Analyzing Data from the "Current User"

Report templates that include the Agents Data Set filter can be configured to analyze data for the current user or workgroup rather
than a specific workgroup. In this case, when the report runs, the data set it uses changes depending on which user runs it. For
example, if the user is agent 12, the report will only include calls that were handled by agent 12.

This feature will only work if the user's profile includes a mapping. If the user is an agent, the mapping gives the name of the agent,
and reports that are filtered for the "current user" only include data about that agent. If the user is a manager, the mapping gives the
name of the workgroup they manage, and the reports that are filtered for the current user include data for the entire workgroup. For
additional information about user profiles and mapping users to agents or workgroups, see Managing Users.

To configure a report to analyze data for the current user: 

In the Data Set filters on the left side of the screen, under Agents, select Current User, and then click Add.

Once the report is configured in this way, you can enable different users to make use of it if you save it, as explained below, and then
share it with the users, as explained under Managing Saved Reports.

Running a Customized Report 

Once the settings of the customized report are specified, you can run the report. Reports can be run in a number of ways:

Run the report and view the results in the browser

Run the report and send the results as an e-mail attachment to specified recipients. The results are sent as an MHT file. This
file opens in a browser and is linked to the SpeechMiner system. As a result, the data drill-down feature can be used in the file.

Run the report and export the results as a PDF or Excel file

Note: You do not have to save a report in order to run it.  

To run the report and view the results in the browser:

1. If you want to view the results in a new browser window, at the top of the form, select the Open in new window checkbox. If
you want to view the results in the Customize Report tab, below the template form, clear this checkbox.

2. Click Run ( ). The report runs, and the results are displayed as you requested.

To run the report and send the results via e-mail:

1. At the top of the form, click E-mail ( ). A dialog box opens.

2. Under To, fill in the e-mail addresses of the recipients. Separate multiple addresses with semi-colons (;).

3. Under Notes, type any text you want to include in the body of the e-mail.

4. Click Send. The report runs, and the results are sent to the recipients you specified. A confirmation message appears when
the results are sent.

To run the report and export the results: 

1. At the top of the form, click  to export the results to a PDF file or  to export the results to an Excel file. A dialog box opens
and asks you if you want to open or save the file.

2. Select the desired option. If you select Open, the file opens in the application that is configured to open files of the selected
type on your computer. If you select Save, a Save As dialog box opens.

3. If you selected Save, navigate to the folder in which you want to save the file, and then click Save. The file is saved in the
selected location.

Using Report Results

Depending on the type of report, the results may be in the form of a graph, a histogram, or a table. 

You can drill down to the underlying data on which any graphic component of a report (graph bars, lines, or table headers) is based.
When you do this, you will be presented with a new report which is based on the data point you clicked on.

To drill down to the underlying data of a report component:

Click the component. 
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To play back a call from a drill-down list:

Under Open, click the  icon. The Media Player opens in a new browser window and begins to play back the call.

To close the drill-down list and return to the report results:

If the report was displayed in the Customize Report tab, at the bottom of the form, click Back ( ).

If the report was opened in a separate window or tab, use the browser's Back button or press Backspace.

Data in tables can be sorted by any column.

To sort data in a table:

Click the heading of the column by which you want to sort the table. (To reverse the sort order, click the heading again.)

Saving a Customized Report 

If you want to run a report with the same settings in the future, you can save it. In addition, if you have edited the settings of a saved
report, you can either save the new settings with the original name using the Save option or save the new settings as a different
report using the Save as option. 

Note: You do not have to save a report in order to run it.  

To save a customized report:

At the top of the form, click Save ( ).

To save the current report settings under a new name:

At the top of the form, click Save as ( ).

 

See also

Selecting a Template for a Report
Managing Saved Reports
MRS Library
 

Home > Reports > Managing Saved Reports

Managing Saved Reports

Saved reports are customized report templates that you can run as often as needed. They can be run on demand, or according to a
schedule. You can access saved reports and configure their schedules in the Saved Reports tab.

To open the Saved Reports tab:

In the Main Menu, under Reports, select Saved Reports. The Saved Reports tab opens.
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Saved Reports tab

Note: Unlike the other saved reports in the list, the System alert report is automatically generated and saved by the system. For
additional information, see System Alerts.

Columns in the Saved Reports Tables

The following columns appear in the Saved Reports tables: 

Column Description 

Run Click the  icon to run the report and display the results at the bottom of the screen. For information about working
with the results, see Creating a Custom Report.

Edit Click the  icon to open the report in the Custom Report tab, where you can change the parameters and settings
and make use of all of the other features of the Custom Report tab.

Delete Click the  icon to delete the report.

Note: You can also delete a number of reports at once, as explained below.

Name The name of the report

Template The template on which the report is based

Created
By 

The name of the user who created the report

Sharing A  icon appears for reports that you created. A  icon appears for reports that other users created and shared
with you. The names of the groups and users with whom the report is shared appear in the table beside the icon.

Click the  icon to open a dialog box in which you can select the groups and individual users with whom you want to
share the report. The members of the selected groups and the selected users will see the report listed in their Saved
Reports tab and will be able to run the report.  

Note: You can only modify reports that you created. If you want to modify other reports, you must save them
under new names.

Schedule Indicates whether the report has a schedule defined for it, and, if so, what kind of schedule. Click the  icon to
activate, deactivate, create, or modify the schedule. For additional information, see Scheduling a Report below.

Last
Modified

The date on which the report settings were last saved

Permalink Click Copy to create a Permalink to the report. You can copy the link to your clipboard and then paste it elsewhere as
needed. Later, you can use a browser to navigate to the Permalink address. When you do, the report will open in the
browser. For additional information, see Permalinks.

Sorting the Columns
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You can choose to sort the tables by any column that contains a report parameter.

To sort a table by a column:

Click the title of the column.

Note: Click the title a second time to reverse the sort order. 

Selecting the Page Size

When the list of saved reports is long, it is divided into pages. The Page field of the page navigator at the bottom of the grid shows
which page is currently being displayed. 

 

Page navigator

You can use the page navigator to go to a particular page in the list and to select the page size - the maximum number of reports
to display in a single page. 

To navigate to a different page in the list of saved reports:

In the page navigator. select one of the following:

Option Description 

 Go to the first page

Go back one page

Page Type the required page number in the field, and then press Enter.  

Go forward one page

Go to the last page

To select the page size:

In the page navigator. in the dropdown list on the right, select the page size. The available options are 20, 40, 60, 80, and
100.  

Filtering the List

You can use filters to limit the saved reports that are displayed in the list to those that meet criteria you specify. The filter controls are
located at the top of the list. The following filters are available:

Filter
Type

Description

Name Enter a sequence of characters. Only those saved reports whose names contain the sequence you enter are displayed.

Template Click the  icon to open the Multi-Select box. Select the report templates to include in the list, and then click Close to
activate the filter. Only those saved reports that are based on the selected templates are displayed.

Created
By

Click the  icon to open the Multi-Select box. Select the users to include in the list, and then click Close to activate
the filter. Only those saved reports that were created by the selected users are displayed.

Sharing Click the  icon to open the Multi-Select box. Select My Reports to display only those reports that you created, or
Shared Reports to display only those reports that were created by other users and shared with you. Click Close to
activate the filter.
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Scheduling Reports

You can schedule reports to run automatically at specified times or in response to specified Events. The results are automatically sent
via e-mail to the recipients you specify. The current schedule setting of each saved report is indicated in the Schedule column as
follows:

Deactivated: The report does not run on a schedule.

Time Based: The report runs automatically at specified times.

Event Based: The report runs automatically when specified Events are detected

Note: You can only create or modify the schedules of reports you created.

You can create reports schedules individually for specific reports or globally for a number of selected reports. You can also deactivate
active schedules in either of these ways.

To configure the schedule for a single report:

In the report table, in the report's row, click Schedule ( ). The scheduling dialog box opens (see below). Follow the
instructions below to select the schedule options you require.

To configure the schedule of a group of reports: 

1. Select the checkbox to the left of each report you want to include in the schedule. To select all of the reports in the list, select
the checkbox in the column title.

2. At the top of the list, to the right of the filters, click Schedule ( ). The scheduling dialog box opens (see below). Follow the
instructions below to select the schedule options you require. 

 

Scheduling Dialog Box
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Scheduling Reports to Run at Specified Times

If you want to see report results on a routine basis, you can schedule the reports to run at specified intervals.

To schedule the selected reports to run at specified times:  

1. At the top of the scheduling dialog box, select Active. The scheduling settings in the dialog box become available.

2. In the Schedule tab, under Schedule Type, select Time Based. The options for configuring the schedule are displayed.

3. Under Date Range, select the start and end dates for the schedule to be implemented.

4. Select the time period - Hour, Day, Week, Month, Once - you want to use to schedule the reports. For example, if you want
to run the reports every weekday, or on Mondays and Thursdays, select Day.

5. In the box beside the units, fill in the desired schedule.

6. Fill in the Recipients tab and save the settings as described below.

Scheduling Reports to Run in Response to Events

Event-based scheduling enables you to keep track of potentially significant trends and/or to be alerted when significant changes in
agent or customer behavior occur. In this context, the term Event does not refer to an individual occurrence of an Event but to a
specified number or percentage of calls in which the Event was detected. For example, the detection of caller agitation in more than
10% of calls could be an Event that causes a report to be generated. 

To schedule the selected reports to run in response to Events:

1. At the top of the scheduling dialog box, select Active. The scheduling settings in the dialog box become available. 

2. In the Schedule tab, under Schedule Type, select Event Based. The fields required to configure the schedule are displayed

 

Scheduling Dialog Box: Event-Based Schedule 
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3. In the Condition line, under Categories, click . A Category Multi-Select box opens. Select the Categories that must be
identified in the calls. When you have selected the Categories, click  to close the Category selector. (For additional
information about using the Multi-Select box, see Defining Search Criteria.)

4. In the next field, select one of the following:
Exceeds (>) if you want the selected reports to run when the selected Categories are identified in more than a
specified number or percentage of calls

Equals (=) if you want the selected reports to run when the selected Categories are identified in a specified number or
percentage of calls

Drops Below(<) if you want the selected reports to run when the selected Categories are identified in fewer than a
specified number or percentage of calls

5. Under Values, fill in the number or percentage of calls.

6. In the next field, select Calls if the value refers to a number of calls, or % of calls if the value refers to a percentage of calls.

7. Under Duration, fill in the number of time periods (of the unit specified in the next field) in which the condition must be met.
For example, type "2" if the condition must be met within a 2-day period (and then select Days in the next field).

8. Select the unit of time for the duration value you entered in the previous field.

9. Fill in the Recipients tab and save the settings as described below.

Recipients Tab

Regardless of which type of schedule you create, you must specify the recipients of the reports.

To specify the recipients of scheduled reports: 

1. In the scheduling dialog box, in the Recipients tab, fill in the fields as follows: 

Field Description

To The e-mail addresses of the report recipients. Separate multiple addresses with semi-colons (;). 

From The sender address to use 

Subject The text that should appear in the subject line of the e-mail. 

Report
Format

Select Web archive to format the results as an MHT file (which can be opened in Internet Explorer). Select
PDF to format the results as a PDF file.

Priority Select the desired priority level for the e-mail message.

2. Click Schedule. The reports are scheduled as specified in the Schedule tab and the recipients are set as specified in
the Recipients tab.

Deactivating a Schedule

If you want to stop running one or more active schedules, you can deactivate them.

To deactivate active schedules:

1. At the top of the scheduling dialog box, clear the Active checkbox.

Note: If you selected a group of saved reports before you opened the scheduling dialog box, the Active checkbox is cleared
already when the scheduling dialog box opens.

2. Click Schedule.

Running a Report and Working with the Results

You can run a report and view the results in the Saved Reports screen. Once the results are open, you can drill down to view
additional details, as you would if you ran the report in the Edit Report screen. You can also e-mail the results or export them as PDF
or Excel files.

To run the report and view the results in the browser:

Click Display ( ). The report runs, and the results are displayed at the bottom of the screen.
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To drill down to the underlying data of a graphic report component:

Click the component. 

To play back a call from a drill-down list:

Click the  icon. The Media Player opens in a new browser window and begins to play back the call.

To close the drill-down list and return to the report results:

At the bottom of the list of saved reports, click Back ( ). 

To e-mail the displayed results:

1. At the bottom of the list of saved reports, click E-mail ( ). A dialog box opens.

2. Under To, fill in the e-mail addresses of the recipients. Separate multiple addresses with semi-colons (;).

3. Under Notes, type any text you want to include in the body of the e-mail.

4. Click Send. The report runs, and the results are sent to the recipients you specified. A confirmation message appears when
the results are sent.

To export the displayed results: 

1. At the bottom of the list of saved reports, click  to export the results to a PDF file or  to export the results to an Excel
file. A dialog box opens and asks you if you want to open or save the file.

2. Select the desired option. If you select Open, the file opens in the application that is configured to open files of the selected
type on your computer. If you select Save, a Save As dialog box opens.

3. If you selected Save, navigate to the folder in which you want to save the file, and then click Save. The file is saved in the
selected location.

Deleting Saved Reports

You can delate reports individually for a specific report or globally for a number of selected reports.

Note: You can only delete reports you created.

To delete a single report:

In the report table, in the report's row, click Delete ( ). You are prompted to confirm you want to delete the report.

Click Yes. The report is deleted.

To delete a group of reports: 

1. Select the checkbox to the left of each report you want to delete. To select all of the reports in the list, select the checkbox in
the column title.

2. At the top of the list, to the right of the filters, click Delete ( ). You are prompted to confirm you want to delete the reports. 

3. Click Yes. The reports are deleted.

 

See also

Selecting a Template for a Report
Creating a Custom Report
MRS Library

 

 

Home > Reports > MRS Library

MRS Library
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The MRS Library is a dll that provides support for various report features. If you are having problems running reports, it is worthwhile
that the correct version of the MRS Library is deployed in your system. You will not generally have to do this unless Genesys technical
support asks you to.

To find out the version number of the MRS Library:

1. In a browser, navigate to the Report Manager page. This page is accessed on the report server at the URL
http://[report server]/reports. (Replace [report server] with the name of your report server.)

2. Select the database folder. A list of the contents of the folder opens.

3. Select MRSLibrary_Version. The MRS version number is displayed.

MRS version (7.2.4060.0)

 

See also

Selecting a Template for a Report
Creating a Custom Report
Managing Saved Reports
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Home > Tools

Tools

The Tools page provides access to an array of global SpeechMiner functions and management features. Depending on your
permissions, you may be able to use these features to manage Categories, Preset Views, and user accounts and permissions; to
monitor and manage the system and its servers; and view information about the definitions of Topics, Programs, and Categories that
are defined in the system and used by SpeechMiner to analyze calls. 

 

See also

Category Management
User Management
System Administration
Elements Explorer

 

Home > Tools > Category Management

Category Management

This section explains how to use the SpeechMiner Category Manager to manage the collection of Category definitions that exist in your
system. It explains what Categories are and describes how to create new Categories, define their properties, activate and deactivate
Categories, apply Categories to the system so that they are included in routine processing of calls, and modify or delete Categories.

The Category Manager can be opened either in the SpeechMiner browser-based interface or in the SMART application. Both locations
provide the same functionality, and they are synchronized automatically, so it does not matter which way you open the Category
Manager. Nonetheless, the interfaces are slightly different. This section explains how to use the Category Manager interface that is in
the SpeechMiner web interface. For information about working with the Category Manager in SMART, please refer to the SMART user
manual.

Note: The permissions for the Category Manager in the SpeechMiner web interface are set in the permissions for SMART. That
is, every user has the same permissions for the Category Manager in SMART and in the web interface. Permissions for the Category
Manager are configured under Tools > User Management > Administer Roles in the SMART tab. For additional information, see
Managing Roles.

To open the Category Manager in the SpeechMiner web interface:

In the Main Menu under Tools, select Manage Categories. The Manage Categories screen opens and displays a list of the
Categories that are currently defined in your system. 

 

See also

User Management
System Administration
Elements Explorer
 

Home > Tools > Category Management > About Categories

About Categories

Categories are used to group calls with similar characteristics so that SpeechMiner users can find calls that require their attention for
particular reasons. The call characteristics that define a Category can be as simple as "calls in which the Topic of interest rates was
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found," but they can also be very complex, defining a very specific mix of characteristics. For example, a Category can be defined to
group calls in which the Topic Payments was mentioned by the agent, the customer displayed signs of agitation, and the call-center
supervisor was called in to deal with the customer during the last two minutes of the call.

SpeechMiner assigns calls to Categories after it has finished processing them. All the Categories in the system are global Categories
that can be applied to any call. When call processing is completed for a call, SpeechMiner goes one by one through the list of
Categories in the system and checks whether the call meets the conditions of the Category. If it does, the call is assigned to the
Category. A single call may not belong to any Categories, but it can also belong to many Categories.

Category assignment is intended to help reviewers find calls with particular characteristics so that they can analyze them and compare
them. For example, reviewers may wish to compare how different agents handled customer agitation during a particular sales
campaign. It also enables SpeechMiner to perform statistical analysis on calls. For example, SpeechMiner can check the percentage of
calls in September in which customers exhibited agitation.

Categories can be nested; a parent-Category can contain sub-Categories, and there can even be multi-tiered Categories, in which a
Category is a sub-Category of one Category and a parent-Category to other Categories. In this case, only the lowest-level Category in
the hierarchy is defined by specifying the characteristics of the calls that belong to it; the parent-Categories are defined as containers
for their sub-Categories. Thus, when SpeechMiner identifies a call as belonging to a sub-Category, it automatically identifies it as
belonging to the parent-Category as well. For example, a Category called Sales Campaigns could contain the sub-Categories Spring
Campaign and Summer Campaign, and each of these sub-Categories could contain a number of their own sub-Categories, such as
Supervisor Required, Customer Agitated, and Customer Agreement. Any call that was included in the Supervisor Required Category of
the Spring Campaign would automatically also belong to the Spring Campaign Category and to the Sales Campaigns Category. Call
reviewers could use any of these Categories to find calls belonging to the Supervisor Required Category of the Spring Campaign.

Another type of Category is a Manual Category. These Categories have no criteria at all; users of SpeechMiner can use them to group
calls manually when they are reviewing them. For example, a manual Category could be Weekly Review, and a SpeechMiner user
could use it to save a list of calls to review during routine weekly staff meetings.  

 

See also

Overview of the Manage Categories Screen
Creating a Blank Category
Configuring Category Conditions
Saving and Applying Changes
Modifying a Category
Deleting Categories
Managing Version History
 

Home > Tools > Category Management > Overview of the Manage Categories Screen

Overview of the Manage Categories Screen
The Manage Categories screen is the Category Manager interface in the SpeechMiner web interface. In this screen, you can view a
list of the currently defined Categories in your system, see and modify their definitions, add and delete Categories, activate
and deactivate Categories, and apply Categories so that they are included in the interaction-analysis process.

The Manage Categories screen contains the following elements:
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Element Number in
Illustration

Description 

Tree-list
controls

 1 Controls for managing the items in the tree list and for filtering them

Tree
structure

 2 Expandable list of Categories

Expanded
Category

 3 Parent Category expanded to display its sub-Categories 

Selected
Category

 4 Category that will be affected when one of the tree-list controls (#1 in the illustration) is used (e.g.,
to open it or to move it up or down in the tree list)

Open
Category 

 5 Category whose definition is open on the right side of the screen 

Locked
Category 

 6 Category that is locked and cannot be modified

Categories are automatically locked when they are opened for editing by any user (yourself or
someone else). Users with the required permissions can unlock definitions that were locked by
other users.

Note: Permissions for overriding locks is configured under Tools > User Management > Administer
Roles in the SMART tab. For additional information, see Managing Roles.

Manual
Category 

 7 Category that includes interactions that are manually assigned to it by users

Selection
options 

 8 Menu of global selection options for the tree list

Category
definition
pane 

 9 The right panel of the Category Manager, in which the properties of the Category, including the
logical expression that defines the conditions for inclusion in the Category, are defined

Save button  10 Click to save changes that were made to the displayed Category; changes are saved but not applied
(see Implementing Changes).

Open
Category tab

 11 Tab of a Category that is open but not currently displayed

Click the tab to display the Category.

Operator
elements

 12 Drag an operator to insert it into the logical expression.

Displayed  13 Tab of the currently displayed Category
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Category tab 
Multiple windows can be open at one time in the screen. Click a tab to view the desired window. 

Category
elements

 14 Drag an element to insert it into the logical expression.

Expression
area 

 15 Box containing a logical expression that defines the conditions for inclusion in the Category that is
open and selected in the right panel  

Sharing
settings 

 16 Displays the current sharing settings of the Category

Click the  button at the right of the field to open a dialog box in which you can edit the sharing
settings of the Category.

Apply link  17 Click to implement changes in SpeechMiner (see Implementing Changes)

  

See also

Context Menu
Icons and Typefaces
Filtering the List of Categories

About Categories
Creating a Blank Category
Configuring Category Conditions
Saving and Applying Changes
Modifying a Category
Deleting Categories
Managing Version History
 

Home > Tools > Category Management > Overview of the Manage Categories Screen > Context Menu

Context Menu

A pop-up menu is available in the Category tree list on the left side of the Manage Categories screen. This menu includes many of
the options that are available in the tree-list controls (#1 in the illustration above) as well as some additional options for working with
individual Categories in the list.

To open the context menu:

Right-click a Category in the tree list.
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Context menu

 

See also

Icons and Typefaces
Filtering the List of Categories
 

Home > Tools > Category Management > Overview of the Manage Categories Screen > Icons and Typefaces

Icons and Typefaces

In the Manage Categories screen, icons and alternative typefaces are used to identify the type and the current status of each of the
Categories, as follows:

Icon/Typeface Description 

 Normal Category (parent or regular)

 Manual Category

 Locked Category 

 Normal typeface Active Category

 Gray typeface Inactive Category
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 Italic typeface Modified Category - changes not yet applied

 Bold typeface Open Category (i.e., open on the right side of the screen) 

 

See also

Context Menu
Filtering the List of Categories
 

Home > Tools > Category Management > Overview of the Manage Categories Screen > Filtering the List of Categories

Filtering the List of Categories

Filtering the tree list enables you to hide items that are not of interest so that they are temporarily not included in the list. The filter
controls are located in the tree-list controls at the top of the tree list. They consist of the Filter text box, in which you can type a
sequence of characters, and the Filter dropdown menu, in which you can activate a filter that hides Categories based on their current
status (active, inactive, or updated). You can use one or both of the filter controls at a time; only those items that contain the specified
character sequence and also belong to the selected filter group are displayed. 

Filter controls

To use the Filter text box:

Type a sequence of one or more characters. Categories whose names do not contain the sequence are not displayed in the
tree list.

To use the Filter dropdown menu:

Click the arrow and select the desired filter. Categories that do not belong to the selected group are not displayed in the
tree list.

 

See also

Context Menu
Icons and Typefaces
 

Home > Tools > Category Management > Creating a Blank Category

Creating a Blank Category

A Category definition consists of a name, a description (optional), sharing properties, and, in some cases, a logical expression that
defines the types of calls to which the Category can be assigned. Three types of Categories exist in SpeechMiner:

Regular Categories: Categories that have conditions defined in the form of a logical expression. When SpeechMiner
processes a call, the call is automatically assigned to this type of Category if it matches the requirements that are defined in the
condition. These Categories can be independent (on the top level of the Category hierarchy) or they can be sub-Categories of
other, parent Categories. 

Parent Categories: Categories that contain other Categories. These Categories have a name and description, but do not
include a logical expression. Calls are assigned to them when they are assigned to any of their sub-Categories. Any Category
can be converted into a parent Category by adding sub-Categories to it. (When a regular Category is converted into a parent
Category, the logical expression that defined the Category is deleted.)

Manual Categories: Categories that have no conditions; SpeechMiner users manually assign calls to them as required.
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The sharing properties of a Category define which users will see it in the SpeechMiner interface. Users with whom a Category is
shared will see the Category in the lists of Categories available for selection in the Call Explorer and in Category filters. Sharing
settings are intended to remove "clutter" by hiding Categories that are not relevant to particular users. For example, if a
particular workgroup only deals with calls that relate to maintenance issues, you can choose not to share sales Categories with that
group. In this way, members of that workgroup will not have to encounter large numbers of Categories that do not concern them. In
addition, if you are creating a new Category, you may not want to share it with anyone else until you have fully tested it. Once the
testing process is complete, you can change the sharing settings and apply the change to SpeechMiner. 

By default, Categories are shared with all SpeechMiner users. You can change this by specifying groups, workgroups, and specific
users with whom a Category should be shared. 

Note: Category sharing does not affect which calls a user can see or play back.

To create a blank Category:

1. In the tree list, right-click All to create an independent Category, or right-click an existing Category to create the new Category
as a sub-Category of the selected Category. The Context menu opens.

Note: If you select an existing Category, the conditions defined for inclusion in the Category (its logical expression) are
automatically erased.

Note: If you want to create a manual Category, you must right-click All. Manual Categories cannot be sub-Categories of any
other Category.

Note: You can also move the Category to a parent Category later.

2. In the Context menu, click New Category to create a regular Category or Manual Category to create a manual Category.
The blank Category opens in the right panel.

Note: You can also create a new regular Category by selecting  in the tree-list controls, but to create a manual Category,
you must open the Context menu.

3. Under Category Name, enter a name for the Category.

4. If you want to limit the types of SpeechMiner users with which the Category is shared, to the right of the Shared with field,

click  (Edit). The Category Sharing dialog box opens.
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Note: If you do not want to change the sharing settings, skip to step 8 below.

5. Clear the Share with all checkbox. The sharing options become active.

6. Select the groups, and users with which the Category should be shared.

Note: To filter the list of users, type a sequence of characters that appears in the user name you want to find. The list is
filtered; only user names that contain the sequence you type are displayed.

7. Click OK. The sharing settings are displayed in the Shared with field.

8. Under Description, enter a description for the Category (optional).

9. On the upper-left of the right panel, click  (Save). The Category is saved.

Note: If the Category is a regular Category, you can configure its conditions, as explained under Configuring Category
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Conditions, before you save it. If the Category is a parent Category or a manual Category, it does not require any additional
configuration, and must be saved at this point.

  

See also

About Categories
Overview of the Manage Categories Screen
Configuring Category Conditions
Saving and Applying Changes
Modifying a Category
Deleting Categories
Managing Version History
 

Home > Tools > Category Management > Configuring Category Conditions

Configuring Category Conditions

An interaction is assigned to a regular Category if it meets the conditions that are defined for inclusion in the Category. The conditions
can include a wide variety of interaction characteristics, including the Program the interaction belongs to, Topics that were recognized
in it, non-linguistic Events that were detected in it (calls only), its metadata properties, and even other Categories to which it belongs. 

Logical Expressions

Configuring Category conditions is performed by defining a logical expression for SpeechMiner to evaluate. If the logical expression is
evaluated as True for a particular interaction, the interaction is assigned to the Category.

Logical expressions can consist of one or more elements. Each element is a statement, such as Date Of Interaction>1/19/2010
or Found topic "Reduction" at least once with Low Strictness. If a logical expression contains one element, it is True whenever the
condition defined in the element is true. For example, if a logical expression contains the element Date Of Interaction>1/19/2010, it is
True for any interaction whose metadata indicates that it took place on or after 1/19/2010.

Logical expressions can also contain multiple elements. When they do, the elements must be related to one another by logical
operators, such as AND and OR. For example, Date Of Interaction>1/19/2010 AND Found topic "Reduction" at least once with Low
Strictness is a logical expression that indicates both conditions must be met - the Topic must be found and the interaction must have
taken place in the specified time period - in order for the expression to be evaluated as True and the interaction to be assigned to the
Category.

The following operators can be used in logical expressions:

Operator Description 

 AND Both conditions must be met in order for the expression to be evaluated as True 

 OR At least one of the conditions must be met in order for the expression to be evaluated as True 

 NOT The expression should be evaluated as True only when the condition is not met.  

 ( Opens a group of conditions that are evaluated as a unit 

 ) Closes a group of conditions that are evaluated as a unit 

 -> Conditional AND: Both conditions must be met, but the second condition is dependent in some way on the first
(e.g., the second must occur within 30 seconds of the end of the first); this operator is used in conjunction with
the Secs Rel to Start of Prev or the Secs Rel to End of Prev position setting

Logical expressions can be quite complex, containing a number of elements, various logical operators, and parentheses, if necessary.
For example:

(Date Of Interaction>1/1/2011 AND Date Of Interaction<1/30/2011 AND Found topic "Payment Locations" at least once with
Low Strictness) OR (Date Of Interaction>1/31/2011 AND (Found topic "Time Frame" at least once with Low Strictness OR
Found topic "Payment Locations" at least once with Medium Strictness))

means the interaction should be assigned to the Category if it took place between Jan. 1st and Jan. 30th and the Topic "Reduction"
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was found, or if the interaction took place Jan. 31st or later and either the Topic "Time Frame" or the Topic "Payment Locations" was
found.

Defining Logical Expressions

The logical expressions that are used as Category conditions are configured by incorporating elements and logical operators to create
the conditional statement. 

Inserting Elements into an Expression

Elements of the following types can be included in a logical expression:  

Interaction metadata

Non-linguistic Event information about a call

The Program to which the interaction belongs

Topics that were or were not found in the interaction

Other Categories to which the interaction belongs

Whether or not a speaker of a particular type (e.g., agent, supervisor) participated in a call (not available in all systems)

Text that was or was not found in the transcript of the interaction

To add an element to a logical expression:

Drag the button of the type of element you want to add to the expression from the condition button area to the logical
expression. For example, to add a Topic element to the expression, drag the Topic button to the logical-expression area. If
there are already other elements in the logical expresson, drag the button to the position in the expression in which you want it
to appear.

Dragging the Topic button to the logical-expression area

When you release the button in the logical-expression area, a dialog box opens in which can configure the element. For
information about the settings and options of each type of element, see:

Configuring Metadata Elements

Configuring Non-Linguistic Event Elements

Configuring Program Elements

Configuring Topic Elements

Configuring Category Elements

Configuring Speaker-Type Elements

Configuring Text Elements  

Inserting Operators into an Expression

You can add logical operators (see Configuring Category Conditions) to the expression as necessary to define the relationships
between the elements of the expression.

Note: There is no precedence among the logical operators in an expression. For example, NOT does not take precedence over AND,
as it may in other environments. Thus, NOT A AND NOT B does not mean the same as (NOT A) AND (NOT B); rather it means the
same as NOT (A AND NOT B). For this reason, it is important to use parentheses to ensure that the operators define the condition as
you intend them to. By contrast, the internal NOT, which is an element property, always relates just to the element that follows it.
Thus, Not A AND Not B does mean the same as  (NOT A) AND (NOT B).
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#_Anchor_configuring_category_conditions#negative_condition


Inserting AND, OR, NOT, and Conditional AND Operators into an Expression

AND, OR, NOT, and Conditional AND (->) define the relationship between two consecutive elements in an expression. You can add
these operators to an expression as required.

To insert AND, OR, NOT, or Conditional AND into an expression:

Drag the button of the type of operator you want to add to the expression from the operator-button area to the position in the
logical expression in which you want it to appear. For example, to add an And operator to the expression, drag the And button
to the logical-expression area.

 

Inserting Parentheses into an Expression

Parentheses can be inserted into an expression to group elements together for evaluation as a single unit. Complex expressions often
require parentheses to break them into smaller expressions so that the relationships between the expressions are clear. For example,
if a Topic must be found in interactions handled by one of two agents, and you wrote 

Workgroup\Agent=workgroup 1/agent a OR Workgroup\Agent=workgroup 1/agent b AND Found topic
"New Account" at least once with Low Strictness 

it would not be clear whether the Topic must be found in interactions handled by both agents or only in interactions handled by agent
b. If you add parentheses like this

(Workgroup\Agent=workgroup 1/agent a OR Workgroup\Agent=workgroup 1/agent b) AND Found
topic "New Account" at least once with Low Strictness

the Topic would have to be found in interactions handled by one of the agents. But if you write

Workgroup\Agent=workgroup 1/agent a OR (Workgroup\Agent=workgroup 1/agent b AND Found

topic "New Account" at least once with Low Strictness)  

the Topic would only be required in interactions handled by agent b.

Logical expression with parentheses

To insert parentheses into an expression:

Drag the parentheses buttons from the operator-button area to the positions in the logical expression in which you want them
to appear.
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Defining a Negative Condition

A negative condition is a condition that must not be met if an expression is to be evaluated as True. For example, a condition that
states that an interaction must not have taken place in the month of January is a negative condition. Negative conditions can be
specified for a single element of an expression or a group of elements that are contained in parentheses.

Two methods are available for creating a negative condition for a single element:

Insert a NOT operator before the element.

Select the Not or Not found option in the element's conditions.

In the following two examples, a negative condition is created in each of these ways. The meanings of the two conditions are
identical: the condition is True as long as the date is not on or before January 1st, 2011.

Negative condition created using the NOT operator

Negative condition created using the Not option

An expression containing multiple elements can only be marked as a negative condition using the NOT operator.  For example, in the
illustration below, the NOT operator is attached to a multi-element condition. The condition is True for all workgroups except
workgroup a and workgroup d.

   

 NOT operator used to create a negative condition with multiple elements 

To insert a NOT operator before an element or expression:

1. If the condition is an expression that contains multiple elements, make sure it is contained in parentheses.

2. Drag the Not button from the operator-button area to the position immediately before the element or expression. 

To select the Not option for an element:

1. If the properties of the element are not displayed, in the expression area of the Category definition, double-click the element. A
dialog box opens and displays the element's properties.

2. In the properties, select Not or Not found. 

3. Click OK. The setting is implemented in the element.

Copying Elements of an Expression from One Category to Another

You can copy one or more elements of an expression from a Category and paste them into another Category. After you paste them,
you can edit them as necessary, just as you would edit any other expression (see Modifying a Category). 

To copy the elements of an expression from one Category to another:

1. In the source Category, select the elements of the expression that you want to copy. To select multiple elements, hold down
the Shift or Ctrl keys as you select them.
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Selected elements of an expression (shaded)

2. Above the logical-expression area, click Copy. 

3. In the target Category, above the logical-expression area, click Paste. The selected elements of the source expression appear
in the logical-expression area of the target.

  

See also

About Categories
Overview of the Manage Categories Screen
Creating a Blank Category
Saving and Applying Changes
Modifying a Category
Deleting Categories
Managing Version History
 

Home > Tools > Category Management > Configuring Category Conditions > Configuring Metadata Elements

Configuring Metadata Elements

Metadata is information about interactions that is gathered by the external recording systems and relayed to SpeechMiner along with
the interaction data (call audio, e-mail contents, etc.). Each system receives different sets of information about the data that is passed
to it for processing. For example, metadata for calls could include the name of the agent for each call, the location of the customer,
and the duration of the call.

You can define metadata conditions based on any of the metadata values available in your system. The conditions you define can be
as simple as one metadata value or they can be complex expressions that specify the relationships among a number of types of
metadata. Consider, for example, a sales campaign that is undertaken in Wyoming and in Texas. Certain agents in each location
target senior citizens, while others target families with teenage children. To assign senior-citizen calls to a Category, you could define
a condition that specifies either Agent1 or Agent2 if the customer is in Wyoming and Agent3 if the customer is in Texas.

When you add a metadata element to an expression (see Inserting Elements into an Expression), a dialog box containing the
configuration settings of the element automatically opens. You can configure it as explained below. In addition, you can reopen the
element's configuration settings for further modification at any time by double-clicking the element in the expression. 

To configure a metadata element:  

1. Under Metadata, select the type of metadata. 

2. In the remaining fields, specify the condition. In some cases, you can select an operator (<, >, or =) in the second field
and specify a value in the third; in other cases, you only specify a value (and the = operator is assumed). You can specify a
value by selecting it from the list or by typing it manually into the third text field.
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Note: Some of the value options may be arranged hierarchically. For example, if you select Workgroup\Agent, a list of
workgroups is displayed. You can select a workgroup, or click the + beside the name of a workgroup to expand the list and
display the names of the agents in the workgroup. If you select a workgroup, all members of the workgroup are included in the
condition; if you expand a workgroup and select an agent, only that agent is included.

3. If you want the condition to include all interactions except those that match the condition, select Not found. (For additional
information, see Configuring Category Conditions.) 

4. Select OK. The dialog box closes, and the element appears in the logical-expression with the settings you configured.

Configured Metadata element

 

See also

Configuring Non-Linguistic Event Elements
Configuring Program Elements
Configuring Topic Elements
Configuring Category Elements
Configuring Speaker-Type Elements
Configuring Text Elements
 

Home > Tools > Category Management > Configuring Category Conditions > Configuring Non-Linguistic Event Elements

Configuring Non-Linguistic Event Elements

Non-linguistic Events include various sounds that SpeechMiner detects in a call, such as busy tones, key presses, and music or noise.
Depending on the Program settings of the call, non-verbal indications of agitation may also be detected. In addition, the non-linguistic
Event called Cross Talk is identified when two speakers are talking at the same time. This type of Event can only be identified
in systems in which dual-channel recording is employed.

In some cases, an element can include more than one type of related Event. For example, you can select Silence, Busy Tone, and
Dial Tone together, but you cannot select Agitation along with other types of Events. When you select multiple types of non-linguistic
Events, if any of those Events is found in the call, it meets the condition.

When you add a non-linguistic Event element to an expression (see Inserting Elements into an Expression), a dialog box containing the
configuration settings of the element automatically opens. You can use this dialog box to select the type of non-linguistic Event and
specify what proportion of the call must contain this type of Event and when it must be detected in the call. You can configure these
settings as explained below. In addition, you can reopen the element's configuration settings for further modification at any time by
double-clicking the element in the expression. 

To configure a non-linguistic Event element:  

1. Under Choose Type, select the type of non-linguistic Event. Other types of non-linguistic Events, types that cannot be selected
along with the selected type, become inactive. If it is possible to select additional types, they remain active.
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If you selected DTMF, a dropdown menu appears. If you selected Silence, Busy Tone, Music/Noise, Dial Tone, Ring Back
Tone, or Cross Talk, the Amount area opens below the Position area.

2. If additional types of Events are active, select any of the other active types, as required. 

3. If you selected DTMF, in the dropdown menu beside the option, select any to accept any key press, or select a key from the
list.

4. If you selected Silence, Busy Tone, Music/Noise, Dial Tone, Ring Back Tone, or Cross Talk, in the Amount area, define
the amount of time that the selected types of non-linguistic Events must occupy in the total time of the call, as follows:

Field Description 

From Define the minimum amount of time that the selected types of non-linguistic Events must occupy in the
total time of the call in one of the following ways:

Seconds: The minimum number of seconds in the call in which the types of Events must be found

Percentage: The minimum proportion of the call in which the types of Events must be found,
expressed as a percentage. (Insert the % character after the value to indicate it is a percentage.)

To Define the maximum amount of time that the selected types of non-linguistic Events must occupy in the
total time of the call, as explained above.

Accumulated
Amount /
Continuous

Select one of the following:

Accumulated Amount: The values in the From and To fields refer to the total amount of time in
the call audio in which the selected types of Events were found, even if the total consists of more
than one distinct Event.
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 Continuous: The values in the From and To fields refer to individual Events in the call audio. That
is, an Event only meets the condition if it lasted at least as long as the value in the From field and
not longer than the value in the To field.

5. Modify the following settings as necessary:

Setting Description 

Not
found

Select this option if you want the condition to include all calls except those in which the selected types of non-
linguistic Events were found. (For additional information, see Configuring Category Conditions.)

From Define the earliest position in the call audio at which the non-linguistic Event may be found, in seconds, and
then select one of the following types of reference points:

Secs Abs: The number of seconds is defined relative to the beginning of the call

Secs Abs from End: The number of seconds is defined relative to the end of the call (i.e., the Event
must be found no earlier in the call than this number of seconds from the end of the call)

Secs Rel to Start of Prev: The number of seconds is defined relative to the beginning of the previous
item in the expression; this option will only work if the operator connecting the two elements is
Conditional AND (->). Otherwise, selecting this is the same as selecting Secs Abs.

Secs Rel to End of Prev: The number of seconds is defined relative to the end of the parent item; this
option will only work if the operator connecting the two elements is Conditional AND (->). Otherwise,
selecting this is the same as selecting Secs Abs from End. 

To Define the latest position in the call audio at which the non-linguistic Event may be found, in seconds, and
then select one of the types of reference points explained above.

 

See also

Configuring Metadata Elements
Configuring Program Elements
Configuring Topic Elements
Configuring Category Elements
Configuring Speaker-Type Elements
Configuring Text Elements
 

Home > Tools > Category Management > Configuring Category Conditions > Configuring Program Elements

Configuring Program Elements

A Program element specifies that an interaction must (or must not) belong to a Program in order for the interaction to be assigned to
the Category.

169 . Tools

 

SpeechMiner® User Guide Release 8.0  © 2013, Genesys Inc. Unauthorized Reproduction is Prohibited



When you add a Program element to an expression (see Inserting Elements into an Expression), a dialog box containing the
configuration settings of the element automatically opens. You can use this dialog box to select the Program and indicate if the
call must belong to the Program or must not belong to the Program in order to meet the requirements of the Category. You can
configure these settings as explained below. In addition, you can reopen the element's configuration settings for further modification
at any time by double-clicking the element in the expression.

To add a Program element:

1. Under Program, select the Program.

2. If you want the condition to include all interactions except those that belong to the Program, select Not. (For additional
information, see Configuring Category Conditions.) 

 

See also

Configuring Metadata Elements
Configuring Non-Linguistic Event Elements
Configuring Topic Elements
Configuring Category Elements
Configuring Speaker-Type Elements
Configuring Text Elements
 

Home > Tools > Category Management > Configuring Category Conditions > Configuring Topic Elements

Configuring Topic Elements

A Topic element specifies that a Topic must be found (or must not be found) by SpeechMiner in an interaction in order
for the interaction to be assigned to the Category.  

When you add a Topic element to an expression (see Inserting Elements into an Expression), a dialog box containing the configuration
settings of the element automatically opens. You can use this dialog box to select the Topic and specify its required number of
occurrences in the call, its strictness level, and its timing constraints. You can configure these settings as explained below. In addition,
you can reopen the element's configuration settings for further modification at any time by double-clicking the element in the
expression.

To add a Topic element:

1. Under Topic, select the Topic.

2. Modify the following settings as necessary:
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Setting Description 

Not found Select this option if you want the condition to include all interactions except those in which the Topic was
found. (For additional information, see Configuring Category Conditions.)

From
 

Define the earliest position in the audio of a call at which the Topic may be found, in seconds, and
then select one of the following types of reference points:

Secs Abs: The number of seconds is defined relative to the beginning of the call

Secs Abs from End: The number of seconds is defined relative to the end of the call (i.e., the Topic
must be found no earlier in the call than this number of seconds from the end of the call)

Secs Rel to Start of Prev: The number of seconds is defined relative to the beginning of the
previous item in the expression; this option will only work if the operator connecting the two elements
is Conditional AND (->). Otherwise, selecting this is the same as selecting Secs Abs.

Secs Rel to End of Prev: The number of seconds is defined relative to the end of the parent item;
this option will only work if the operator connecting the two elements is Conditional AND (->).
Otherwise, selecting this is the same as selecting Secs Abs from End.

Note: This field is only relevant to call interactions. 

To Define the latest position in the audio of a call at which the Topic may be found, in seconds, and then select
one of the types of reference points explained above. 

Note: This field is only relevant to call interactions.

At least __
occurrences

Specify the minimum number of times the Topic must have been found in the call in order for the condition
to be met.

At least __
Strictness

Select the minimum level of strictness for the recognition of the Topic; if the Topic recognition does not meet
this minimum, SpeechMiner proceeds as if the Topic was not found. Note that this only limits strictness
beyond the Topic's defined strictness.

Speaker
Type 

Select a speaker type if the Topic must be found when the selected type of speaker is speaking, or ANY to
include all speaker types.

Note: This field is only relevant to call interactions.

 

See also

Configuring Metadata Elements
Configuring Non-Linguistic Event Elements
Configuring Program Elements
Configuring Category Elements
Configuring Speaker-Type Elements
Configuring Text Elements
 

Home > Tools > Category Management > Configuring Category Conditions > Configuring Category Elements

Configuring Category Elements

A Category element specifies that an interaction must (or must not) belong to another Category in order for the interaction to be
assigned to the Category that is currently being configured.

When you add a Category element to an expression (see Inserting Elements into an Expression), a dialog box containing the
configuration settings of the element automatically opens. You can use this dialog box to select the Category and indicate if the
interaction must belong to the Category or must not belong to the Category in order to meet the requirements of the current Category.
Sub-Categories appear in the list of available Categories as separate Categories, and their parent Categories are indicated. For
example, a Category called Adjustments that is a sub-Category of a Category called Bill Inquiry appears in the list of Categories as Bill
Inquiry/Adjustments. You can configure these settings as explained below. In addition, you can reopen the element's configuration
settings for further modification at any time by double-clicking the element in the expression.

Although you can create circular Category references, the Categories in which they appear cannot be applied to SpeechMiner. For
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example, if Category A is an element of the expression that defines Category B, Category B cannot also be an element of the
expression that defines Category A. If they are, the circular references are indicated in the Apply dialog box, in the Message column
of each Category. For additional information about applying changes to SpeechMiner, see Saving, Activating, and Applying Categories. 

Note: Including a Category element in the expression that defines a Category is not the same as making one a sub-Category of the
other. For additional information about sub-Categories, see About Categories.

To add a Category element:

1. Under Category, select the Category.

2. If you want the condition to include all interactions except those that belong to the Category, select Not. (For additional
information, see Configuring Category Conditions.) 

 

See also

Configuring Metadata Elements
Configuring Non-Linguistic Event Elements
Configuring Program Elements
Configuring Topic Elements
Configuring Speaker-Type Elements
Configuring Text Elements
 

Home > Tools > Category Management > Configuring Category Conditions > Configuring Speaker-Type Elements

Configuring Speaker-Type Elements

A Speaker-Type element specifies that a speaker of a particular type must have taken part (or must not have taken part) in a call in
order for the call to be assigned to the Category. This information is gathered by the recording system and passed on to SpeechMiner
along with the call data. The exact type of information available depends on the recording system that is employed in your company.

Some recording systems also indicate the times in the call when each speaker was heard. In these cases, you can also specify the
times in the call when the type of speaker must have taken part in the call in order for the call to meet the condition. For example, you
could specify that a supervisor must have taken part in the last 120 seconds of the call. 

When you add a Speaker-Type element to an expression (see Inserting Elements into an Expression), a dialog box containing the
configuration settings of the element automatically opens. You can use this dialog box to select the Speaker-Type and specify its
timing constraints. You can configure these settings as explained below. In addition, you can reopen the element's configuration
settings for further modification at any time by double-clicking the element in the expression.

To add a Speaker-Type element:

1. Under Speaker-Type, select the type of speaker.
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1. If you want the condition to include all calls except those that match the condition, select Not. (For additional information, see
Configuring Category Conditions.)

2. Modify the following settings as necessary:

Setting Description 

From Define the earliest position in the call audio at which the speaker may be found, in seconds, and then select one
of the following types of reference points:

Secs Abs: The number of seconds is defined relative to the beginning of the call

Secs Abs from End: The number of seconds is defined relative to the end of the call (i.e., the Script
must be found no earlier in the call than this number of seconds from the end of the call)

Secs Rel to Start of Prev: The number of seconds is defined relative to the beginning of the previous
item in the expression; this option will only work if the operator connecting the two elements is
Conditional AND (->). Otherwise, selecting this is the same as selecting Secs Abs.

Secs Rel to End of Prev: The number of seconds is defined relative to the end of the parent item; this
option will only work if the operator connecting the two elements is Conditional AND (->). Otherwise,
selecting this is the same as selecting Secs Abs from End. 

To Define the latest position in the call audio at which the speaker may be found, in seconds, and then select one
of the types of reference points explained above.

 

See also

Configuring Metadata Elements
Configuring Non-Linguistic Event Elements
Configuring Program Elements
Configuring Topic Elements
Configuring Category Elements
Configuring Text Elements
 

Home > Tools > Category Management > Configuring Category Conditions > Configuring Text Elements

Configuring Text Elements

A Text element specifies that a phrase containing one or more words must be found (or must not be found) by SpeechMiner in
the text of an interaction in order for the interaction to be assigned to the Category. The phrase must be found exactly as it is entered
in the Text element definition to meet the condition, except that it is not case sensitive. For example, "i want to repay my loan" and "I
want to Repay My loan" are treated as identical phrases, but "I wanted to repay my loan" and "I want you to repay my loan" are
not identified as matching them.  

When you add a Text element to an expression (see Inserting Elements into an Expression), a dialog box containing the configuration
settings of the element automatically opens. You can use this dialog box to specify the phrase, its required number of occurrences in
the call, its strictness level, and its timing constraints. You can configure these settings as explained below. In addition, you can
reopen the element's configuration settings for further modification at any time by double-clicking the element in the expression.

To add a Text element:
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1. Under Text, enter the phrase. The phrase should consist of a sequence of one or more whole words. The words should be
separated by single spaces, and no punctuation or other symbols should be included in the sequence. The text is not case-
sensitive. 

2. Modify the following settings as necessary:

Setting Description 

Not found Select this option if you want the condition to include all calls except those in which the phrase
was found. (For additional information, see Configuring Category Conditions.)

From
 

Define the earliest position in the call audio at which the phrase may be found, in seconds, and then select
one of the following types of reference points:

Secs Abs: The number of seconds is defined relative to the beginning of the call

Secs Abs from End: The number of seconds is defined relative to the end of the call
(i.e., the phrase must be found no earlier in the call than this number of seconds from the end of the
call)

Secs Rel to Start of Prev: The number of seconds is defined relative to the beginning of the
previous item in the expression; this option will only work if the operator connecting the two elements
is Conditional AND (->). Otherwise, selecting this is the same as selecting Secs Abs.

Secs Rel to End of Prev: The number of seconds is defined relative to the end of the parent item;
this option will only work if the operator connecting the two elements is Conditional AND (->).
Otherwise, selecting this is the same as selecting Secs Abs from End. 

Note: This field is only relevant to call interactions. 

To Define the latest position in the call audio at which the phrase may be found, in seconds, and then select one
of the types of reference points explained above. 

Note: This field is only relevant to call interactions. 

At least __
Occurrences

Specify the minimum number of times the phrase must have been found in the call in order for the condition
to be met.

At least __
Confidence

Select the minimum level of confidence for the recognition of the phrase; if the Confidence level does not
meet this minimum, SpeechMiner proceeds as if the phrase was not found.

Speaker
Type 

Select a speaker type if the phrase must be found when the selected type of speaker is speaking, or ANY to
include all speaker types.

Note: This field is only relevant to call interactions.  

 

See also

Configuring Metadata Elements
Configuring Non-Linguistic Event Elements
Configuring Program Elements
Configuring Topic Elements
Configuring Category Elements
Configuring Speaker-Type Elements
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Home > Tools > Category Management > Saving and Applying Changes

Saving and Applying Changes

Implementing changes you have made in the Category Manager is a two-stage process. As you add and modify definitions, you must
save your changes. When you do so, the changes are saved in the Category Manager, but they are not implemented in SpeechMiner.
Changes are only implemented in SpeechMiner when you apply them. When changes are applied, SpeechMiner incorporates them into
its list of Category definitions, and then reprocesses all the interactions in the database using the updated set of definitions.

If a Category definition has been saved in the Category Manager, but it has not yet been applied to SpeechMiner, the name of the
Category appears in the tree list in italics. 

Saving Changes 

When you create a blank Category, it is saved automatically in the Category Manager. If, after you create the Category, you modify its
name, description, conditional expression, or sharing settings, you must save the Category manually. Similarly, if you modify any of
the properties of any Category in the system at any time, you must manually save the Category in order to save the changes in the
Category Manager.

To save a Category:

1. To the upper-left of the right panel, click  (Save). The Category is saved, and a confirmation message appears.

2. In the confirmation message, select OK.

Applying Changes

Applying changes is a two-stage process. When you select Apply, the process begins. During the first stage, the Category Manager
lists all of the changes that were made since the last time changes were applied. In addition, SpeechMiner checks each of the changes
in the list to ensure that it is ready to be applied, and marks all problematic items. For example, if it discovers a new regular Category
that has no logical expression defining its properties, it lists the Category in its list of modified Categories, but it marks it as a problem.
Some types of problems must be corrected before you can apply a Category that is marked as problematic, while others can be
ignored if you choose. 

During the second stage, you select the changes in the list that you want to apply to SpeechMiner, and then initiate the actual
application process. When this process is completed, the changes are included in the Category definitions that are used by
SpeechMiner when it assigns interactions to Categories, and the interactions that are currently in the database are reprocessed using
the updated set of definitions.

In most systems, SpeechMiner allows you to save backup copies of the existing definition set in SpeechMiner before applying any
changes. If you do this, you can later choose to roll back the definition set to an older set, if necessary. (For additional information,
see Managing Version History.)

Before you apply a new Category to SpeechMiner, make sure it is active and unlocked. Active Categories appear in the tree list in

normal type; inactive Categories appear in gray type. Locked Categories have an icon with a padlock beside their names ( ). Inactive
Categories can be applied, but interactions are not assigned to them. Locked Categories cannot be applied, so they are not included in
the list of modified Categories. If you want to apply a Category that is locked, unlock it before you select Apply. (If the Category was
locked by another user, you may have to ask them to unlock it; some users have permissions to unlock Categories that were locked by
other users, but others do not.)

Applying changes to Categories does not affect manual Categories; any items that SpeechMiner users assigned to a manual Category
remain assigned to it even after changes to Categories are applied.

To apply changes to SpeechMiner:

1. In the upper-right corner of the right panel, click Apply. The Apply changes to system dialog box opens and displays a list
of changes that were saved in the Category Manager but were not yet applied to SpeechMiner. 

The checkbox in the Apply column (indicating that they will be applied) is selected by default for all changes with the status OK
(indicating that they can be applied). 
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2. If there are problems that require correction before you apply the changes, close the dialog box and correct the problems.
Then, open the dialog box again, as described above.

3. If you want to save a backup copy of the existing set of definitions in SpeechMiner (all Category, Program, and Topic
definitions) before the new set is applied, select Backup Apply, Comment. (In some systems, this option is always
implemented, or not available.) Modify the text field below the option as required, to specify the comment that will be attached
to the backup.  

4. If you do not want to apply a particular item, in the Apply column, clear the checkbox. (The checkbox is not available for items
that cannot be applied.)

5. Click OK. The process of applying the changes begins. The process may take a few minutes. When it is completed, an "Apply
succeeded" message appears.

 

See also

About Categories
Overview of the Manage Categories Screen
Creating a Blank Category
Configuring Category Conditions
Modifying a Category
Deleting Categories
Managing Version History
 

Home > Tools > Category Management > Modifying a Category

Modifying a Category

Modifying an existing Category includes the following tasks:

Modifying the definition of the Category:

Changing the logical expression that defines the conditions of the Category, by adding, modifying, or removing elements
or operators

Changing the sharing settings of the Category

Changing the name or description of the Category
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Activating or deactivating the Category

Moving the Category within the tree list

Modifying the Definition of a Category

You can modify all parts of the definition of a Category - its name, description, and the logical expression that defines the conditions
for assigning an interaction to a Category. To modify any aspect of a Category, you must open the Category in the right panel. When
you have finished making changes to the Category, you must save the Category (see Saving and Applying Changes).

To open a Category:

In the Manage Categories screen, in the list of existing Categories is displayed in the left panel, double-click the Category, or

select the Category and then click  (Open Category). The Category opens in a tab in the right panel.

Changing the Sharing Settings of the Category

You can change the sharing settings of the Category as necessary.

To change the sharing settings of the Category:

1. To the right of the Share with field, click  (Edit Sharing). The Category Sharing dialog box opens.

2. Modify the settings as necessary. For additional information, see Creating a Blank Category.

3. Click OK. The Share with field is updated.

Changing the Name and Description of the Category

You can change the name and description of the Category as necessary.

To change the name or description of the Category:

Modify the Name and Description fields as necessary.

Adding Elements and Operators to the Expression

For information about adding elements to the expression, see Inserting Elements into an Expression. For information about adding
operators, see Inserting Operators into an Expression.

Modifying the Properties of an Element

You can change the properties of any of the elements that are already included in the expression. For additional information about
logical expressions, see Configuring the Category. 

To modify the properties of an existing element:

1. In the text area, click the element. Its properties open below the text area.

2. Change the properties as required. For additional information about the properties of each type of element, see:

Configuring Metadata Elements

Configuring Non-Linguistic Event Elements

Configuring Program Elements

Configuring Topic Elements

Configuring Speaker-Type Elements

Configuring Text Elements

3. Click Update. The properties are modified.

Removing Elements and Operators from the Expression

You can remove any element or operator from the expression.

To remove elements or operators from an expression:
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1. Select the elements and operators you want to delete. (To select multiple items, hold down the Shift or Ctrl keys as you select
each of the items.)

2. At the top of the right panel, on the right side, click Delete. The selected items are deleted from the expression.

Saving Changes

Whenever you modify a Category, you must save the changes in order for them to be implemented in the Category Manager. For
additional information about saving changes in the Category Manager and implementing them in SpeechMiner, see Saving and
Applying Changes.

To save changes to the Category:

To the upper-left of the right panel, click  (Save). 

Activating or Deactivating a Category

A saved Category can be active or inactive. When an active Category is applied to SpeechMiner, interactions can be assigned to it.
When an inactive Category is applied, it is saved in SpeechMiner but interactions cannot be assigned to it.

This feature allows you to temporarily stop using a Category when it is not relevant. When SpeechMiner processes an interaction, it
checks every active Category to see if it should be assigned to the interaction. Because of this, it is a good idea to deactivate
Categories that are not needed because it makes interaction processing faster and more efficient. For example, if you only use a
particular Program during certain sales campaigns, you can deactivate Categories that require the Program when no sales campaigns
that use it are underway.

Activating or deactivating a parent Category causes all of its sub-Categories to be activated or deactivated along with it.

When you deactivate a Category that has been applied to SpeechMiner previously, you have to apply it to SpeechMiner in order to
deactivate it in SpeechMiner.

Active Categories appear in the tree list in normal type; inactive Categories appear in gray type.

To activate (or deactivate) a Category:

1. In the left panel, right-click the Category, and then select Activate (or Deactivate). The Category is activated (or
deactivated) in the Category Manager.

2. If you want to deactivate the Category in SpeechMiner, apply the Category. For additional information, see Saving and Applying
Changes.

Moving a Category Within the Tree List

The list of Categories appears in SpeechMiner in the same order and with the same structure as it does in the Category Manager. It is
therefore a good idea to organize the list in a way that is convenient for SpeechMiner users. You can do this by moving Categories up
or down in the tree list, and by changing the nesting of Categories.

Categories can be moved up and down within the tree list in one of two ways: by dragging them to the desired locations, or by
selecting them and then selecting Move Up or Move Down to move them up or down one position in the list.

The nesting of Categories can be modified by dragging Categories within the tree list. In this way, you can change any regular
Category into a parent Category or a sub-Category, or move a sub-Category from one parent Category to another.

Dragging a Category to Reposition it in the Tree List

When you drag a Category, you can drop it between two other Categories or on top of a single Category. If you drop it between other
Categories, it is placed between those Categories. If you drop it on top of another Category, it is converted into a sub-Category of the
Category on which it is dropped. As you drag the Category, an arrow indicates where it will be placed if you release it in its current
location: if the arrow points between two Categories, the Category you are dragging will be placed between the two Categories; if the
arrow points at a Category, the Category you are dragging will be inserted as a sub-Category of the Category identified by the arrow.
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Dragging a Category to a position between two other Categories

Dragging a Category to a position as a sub-Category of an existing Category

Bear in mind that if you drop a Category onto a regular Category - a Category that is defined by a logical expression - the logical
expression will be deleted from the Category's definition, and the Category will be converted into a parent Category. 

To move a Category in the tree list by dragging it:

In the tree list, drag the Category to the desired location. As you drag the Category, an arrow indicates where the Category will
be placed in the list if you drop it in its current location.

Note: If you drop the Category on an existing Category that was not previously a parent Category, a warning message
appears, indicating that any conditions that were defined for the regular Category are deleted when it becomes a parent
Category. Select Yes to delete those conditions and convert the Category into a parent Category.

Warning message

Moving a Category Up or Down in the Tree List

You can move a Category up or down in the tree list one row at a time using the Move Up and Move Down options that are
available both in the context menu of the Category and in the tree-list controls at the top of the list.

To move a Category up or down in the tree list using the Move Up and Move Down options in the tree-list controls:

1. In the tree list, select the Category.

2. In the tree controls above the tree structure, click  (Move Up) or  (Move Down) as many times as necessary to
move the Category to the desired location in the tree list. 

To move a Category up or down in the tree list using the context menu:
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In the tree list, right-click the Category, and then select either Move Up or Move Down. Repeat this process as many times as
necessary to move the Category to the desired location in the tree list.

 

See also

About Categories
Overview of the Manage Categories Screen
Creating a Blank Category
Configuring Category Conditions
Saving and Applying Changes
Deleting Categories
Managing Version History
 

Home > Tools > Category Management > Deleting Categories

Deleting Categories

You can delete Categories that are not required. When you apply the changes to SpeechMiner, the Categories you deleted from the
Category Manager are removed from SpeechMiner as well, and the Category assignments of all of the calls in the SpeechMiner
database are redone (see Saving and Applying Changes).

To delete one or more Categories:

1. In the left panel, in the tree structure, select the checkboxes beside each of the Categories you want to delete.

2. In the tree controls above the tree structure, click  (Delete). You are prompted to confirm that you want to delete the
selected Categories and any sub-Categories they may have. 

Category Deletion message

3. Click Yes. The Categories are deleted.

 

See also

About Categories
Overview of the Manage Categories Screen
Creating a Blank Category
Configuring Category Conditions
Saving and Applying Changes
Modifying a Category
Managing Version History
 

Home > Tools > Category Management > Managing Version History

Managing Version History

The version-management system is used to back up and restore previous definitions of individual Categories or of the entire set of
Category definitions. Two types of back ups are supported:

Tools . 180

 

SpeechMiner ® User Guide Release 8.0 © 2013, Genesys Inc. Unauthorized Reproduction is Prohibited



Item tags: Backups of the definitions of individual Categories

Definition sets: Backups of the entire set of Category, Topic, and Program definitions before an updated set is applied  

Item tags can be created in three ways:

Manually: You can manually create a tag for an item at any time.

On closing SMART: When SMART is closed, the system automatically creates a tag for each item definition that has been
changed and has not yet been applied.

On applying changes: When you apply changes to SpeechMiner, if you choose to create a backup, the system automatically
creates a tag for every item in the system; this tag contains the definition as it appears in SpeechMiner immediately before the
changes are applied

Each item tag includes the current definition of the item, the date and time the tag was created, your user name, and a comment.
When you manually create a tag, you can enter the comment text you want to attach to it. When you apply changes, if you added a
comment to the backup settings, the comment is attached to the tag of every item in the system. When SMART generates tags
automatically before it closes, the tags have blank comment fields.

This section explains how to manually create item tags and how to work with item tags and definition sets. For information about
creating definition sets, see Saving and Applying Changes. For information about managing definition sets, please refer to the SMART
User Guide.

Manually Creating Item Tags

You can create item tags for a Category at any time.

To create a tag for an item:

1. In the left panel, in the tree structure, right-click the item you want to tag, and then select Tag Category. A Comment for
tagging dialog box opens.

Comment for tagging dialog box for the "Benefits" Category

2. In the text field, enter a comment to attach to the tag.

3. Click OK. The tag is created.

Restoring a Tagged Definition

Any definition of an item that is stored in a tag can be restored to the Category Manager by rolling back the definition to the selected
tag. Note that this rollback process only restores the definitions within the Category Manager. If you want to restore the definitions to
SpeechMiner, you must apply them after they are restored in the Category Manager.

To restore a tagged definition:

1. In the tree structure, right-click the item, and then select History. The History dialog box opens and displays a list of available
tags for the item.
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History dialog box for "New Customer" Category

2. In the list, select the tag you want to restore.

Tag selected

3. Click Mark for Rollback. A rollback message appears at the bottom of the dialog box indicating that the item definition will be
restored in accordance with the selected tag.
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Rollback message

4. Click OK. The definition of the item in the Category Manager is restored to match the tagged definition.

Managing Tags

You can change the comment text of any tag that you created or have permissions to change, as well as for any tag that was created
when the SMART application was closed.

Note: Tags that were generated as a set during an apply process cannot be modified individually as described below. They can,
however, be modified or deleted globally, but only in the SMART application. For additional information, please refer to Rolling Back
the Definition Set in the SMART User Guide.

To change the comment of a tag:

1. In the tree structure, right-click the item whose comment you want to change, and then select History. The History dialog
box opens. 

2. Click the comment text that you want to change. The text becomes an editable text field.

3. Modify the text as necessary and then click outside the text field to close it.

4. Click OK. The change is saved.

 

See also

About Categories
Overview of the Manage Categories Screen
Creating a Blank Category
Configuring Category Conditions
Saving and Applying Changes
Modifying a Category
Deleting Categories
 

Home > Tools > User Management

User Management

All users in the SpeechMiner system are associated with groupings of various types. These groupings control which call and system
data the user can see and which permissions the user has to see and activate system features. The following user groupings are in
use in the system:

User Category Description

Role A set of permissions that define what features the user can access and use in the SpeechMiner system
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Workgroup The call center or department of a call center to which the user belongs

Partition Call data from a particular call center or department of a call center

Group A set of workgroups and/or partitions that identify the call data to which the user has access

Individual users can have multiple roles and belong to multiple workgroups, partitions, and groups. User profiles specify the roles,
groups, and partitions associated with each user.

Depending on your role, you may be able to modify some or all elements of your own profile. You may also be able to manage other
user accounts: creating new users, managing their profiles, managing groups, roles, and permissions. This section explains how to
manage user accounts if you have the required permissions.

Note: The user-management functions in the Tools page relate to users of the SpeechMiner browser-based interface, in which call-
data is accessed, as well as the SpeechMiner Administration Tool (SMART), in which the call analysis features are set up and
configured.

 

See also

Editing Your User Profile
Managing Users
Managing Groups
Managing Roles

Category Management
System Administration
Elements Explorer
 

Home > Tools > User Management > Editing Your User Profile

Editing Your User Profile
Your user profile includes your user name and password, your roles, workgroups, and partitions, and other personal information such
as your name, phone number, and e-mail address. Depending on your permissions, you may be able to view your user profile and edit
some or all of its properties.

To edit your user profile:

1. In the Main Menu under Tools, select User Management and then select Edit Profile. The Edit Profile screen opens and
displays your user profile.

2. Modify the settings and information as necessary. For detailed information about the fields, see Managing Users.

3. Click Save Changes. The changes are saved.

 

See also

Managing Users
Managing Groups
Managing Roles
 

Home > Tools > User Management > Managing Users

Managing Users

Managing users includes creating new user accounts, assigning roles, groups, and partitions to users, managing user passwords,
maintaining additional user information, and deactivating or deleting existing accounts.

The collection of information and group associations assigned to a user is called a user profile. This section explains how to create
user accounts and manage user profiles.
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Creating a New User Account

You can open an account for a new user and configure the user's group associations and permissions.

To open a new user account:

1. In the Main Menu, under Tools, select System Admin and then select Administer Users. The Administer Users screen
opens and displays a list of the existing user accounts.

2. Click New ( ). A blank Edit Profile screen opens.

Edit Profile Screen

3. Fill in the fields as follows: 

Field Description

Active Select this checkbox to make the account active. An account must be active for the user to log into it.

User Login Enter a username for the user.

Authentication Select SpeechMiner if you want to the username and password to be managed by SpeechMiner and
stored in SpeechMiner's database. Select Windows if the user will log into SpeechMiner using the same
username and password they use to log into Windows. The fields required to configure the selected option
are displayed.

Old Password This field is not relevant to new accounts.

Note: This field only appears if SpeechMiner is selected under Authentication.

New
Password

Type a password for the account.

Note: This field only appears if SpeechMiner is selected under Authentication.

Verify
Password

Type the password for the account again to ensure it was typed correctly.

Note: This field only appears if SpeechMiner is selected under Authentication.

User must Select this option to require the user to change their password the next time they log into SpeechMiner.
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change
password at
next logon 

Note: This field only appears if SpeechMiner is selected under Authentication.

Windows
Domain

Type the name of the Windows domain in which the user's account is managed.

Note: This field only appears if Windows is selected under Authentication.

User Roles Select the user roles to associate with the account. These roles define the permissions the user will have
in SpeechMiner. For additional information, see Managing Roles.

Note: If roles appear in the list but are not active, you do not have the permissions required to assign
these roles to users.

User Groups Select the groups to associate with the account. Each group represents a set of workgroups and/or
partitions that identify which call data the user will be able to access. For additional information, see
Managing Groups.

User
Partitions

If you want to enable the user to access call data from additional workgroups and/or partitions that are not
included in their groups, select them here.

First Name Enter the user's first name.

Last Name Enter the user's last name.

Title Enter the user's title.

Organization Enter the organization the user works for.

Phone Enter the user's phone number.

Email Enter the user's e-mail address.

Home Page Enter the address of any page in the SpeechMiner web interface to make that page the user's homepage.
Enter the address in the following format:

/pages/[page location]

You can copy the page address from the end of the Address field of the browser when the page is open.
For example, if you want to use the New Search page as the homepage, and the address of the New
Search page is
http://myserver/speechminer/pages/speechminer/pages/calls/querySettings.aspx,

you would remove the base of the address (enter http://myserver/speechminer) and

enter pages/calls/querySettings.aspx.

Note: If this field is left blank, the last View the user had open in their Views page is opened when they
log in.

Comments Enter any additional comments.

Mapping If the user is a call-center agent, select the user's name in the call center's recording system. If the user is
a call-center manager, select the name of the workgroup they manage. You can select the name or
workgroup in one of the following ways:

In the text field, begin typing the name of the agent or workgroup. A dropdown list of names that
contain the combination of letters you type appears. Keep typing until you see the name, and then
click it to select it.

Click . A list of workgroups opens. Click a workgroup to select it, or expand the relevant
workgroup and then click the name of the agent to select it.

Note: Mapping SpeechMiner users to call-center agents makes it possible to create a Saved Report for the
"current user." This means that a single Saved Report can be run by different users to retrieve report data
about themselves, or their subordinates. For additional information, see Creating a Custom Report.

Send Email
Notification

If you want to send the new user an e-mail message telling them that their account is open and explaining
how to access it, select this checkbox. The e-mail message is sent to the address specified in the Email
field.

 

4. Click Save Changes. The new account is created. The Edit Profile screen closes and the Administer Users screen is
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displayed. If you chose to send the user an e-mail notification, the e-mail is sent.

Managing Existing User Accounts

You can filter the list of existing users in a number of ways to help you find the accounts that interest you. You can also modify user
profiles and activate, deactivate, or delete user accounts.

To see the list of existing user accounts:

In the Main Menu, under Tools, select System Admin and then select Administer Users. The Administer Users screen
opens and displays the list. The list includes a summary of each user's profile: username, personal name, assigned roles,
groups, and partitions, account status, and last login date and time. 

Administer Users Screen 

Filtering The List of User Accounts

You can filter the list of user accounts by any combination of user name, role, and group. The filter controls are located above the list.

To filter the list of user accounts: 

1. If you want to filter by user name, in the Name field, type a letter or combination of letters. When the filter is activated (see
step 4), user accounts that do not include the specified combination of letters will be hidden from the list.

2. If you want to filter by role, click the  beside the Roles field to open the Roles Multi-Select box. In the box, select the role
or roles you want to include in the list. (For additional information about using the Multi-Select box, see Defining Search
Criteria.)

3. If you want to filter by group, click the  beside the Groups field to open the Groups Multi-Select box. In the box, select the
group or groups you want to include in the list. (For additional information about using the Multi-Select box, see Defining
Search Criteria.)

4. Click the OK button to the right of the Groups field. The filter is activated; accounts that do not match the filter settings are not
displayed.

Modifying User Profiles

You can modify user profiles in one of two ways:

Open an individual user's profile and modify it. For example, you could change a user's password.

Make global changes to selected profiles using the More Actions menu. For example, you could add a role to a number of
users' accounts.

To modify an individual user profile: 

1. In the Administer Users screen, in the Login column, click the user's name. The Edit Profile screen opens and displays the
user's current profile.

2. Modify the profile as required. For information about the various fields in the screen, see Creating a New User above.

Note: The User Login and Authentication fields cannot be modified. You may not be able to modify other fields if you do not
have permissions to do so.
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3. Click Save Changes. The profile is updated. The Edit Profile screen closes and the Administer Users screen is displayed.

To make global changes to selected profiles:

1. In the Administer Users screen, select the checkbox in the left column of each user profile you want to modify.

Note: To select all of the user profiles, select the checkbox at the top of the column.

2. Above the list, click More Actions. The More Actions dropdown menu opens.

3. Select the desired option, as follows:

Option Description

Mark as
Active

Activates the selected accounts.

Mark as
Inactive Deactivates the selected accounts. The users will not be able to log into their accounts.

Note: Inactive accounts can be reactivated later as necessary. When you click OK (see the next step), you will
be able to choose whether to delete all the user's saved searches, reports, and scheduled reports, or just to
stop all scheduled reports.

Add to
Role(s) Opens a list of the roles that exist in the system. Select the roles you want to add to the users' profiles, and

then click  to close the list.

Add to
Group(s)

Opens a list of the groups that exist in the system. Select the groups you want to add to the users' profiles, and
then click  to close the list.

Remove
from
Role(s)

Opens a list of the roles that exist in the system. Select the roles you want to remove from the users' profiles,
and then click  to close the list.

Remove
from
Group(s)

Opens a list of the groups that exist in the system. Select the groups you want to remove from the users'
profiles, and then click  to close the list.

4. Click the OK button to the right of the More Actions field. The changes are implemented.

Note: If you selected Mark as Inactive, when you click OK, you are prompted to choose whether to delete all the user'sNote: If you selected Mark as Inactive, when you click OK, you are prompted to choose whether to delete all the user's
saved searches, reports, and scheduled reports, or just to stop all scheduled reports. Select the desired action, and then click
OK. 

Deleting Users

You can delete existing user accounts as necessary. When an account is deleted, all saved searches, reports, and scheduled reports
created by the user are deleted. If you want to keep these items, but you do not want the user account to be accessible, you can
deactivate the account (see Modifying User Profiles above). When an account is deactivated, the user cannot log into it, but the profile
is saved and saved searches and reports can be retained. The account can be reactivated later on as necessary.

To delete user accounts: 

1. In the Administer Users screen, select the checkbox in the left column of each user account you want to delete.

2. Above the list, click Delete ( ). You are prompted to confirm that you want to delete the selected accounts.

3. Click OK. The accounts are deleted.

 

See also

Editing Your User Profile
Managing Groups
Managing Roles
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Home > Tools > User Management > Managing Groups

Managing Groups
Groups identify the call data that is associated with specific users. When a user belongs to a particular group, they have access to the
call data that is assigned to that group. All Interaction Lists, searches, and reports they access will only include data about the calls in
their group. For information about assigning groups to users, see Managing Users.

Each group is defined as a list of partitions and workgroups. Partitions identify call data using the identification system that was used
by the recording system. For example, a partition might include calls to phone number x, extension y. Workgroups are based on the
structure of the call center and identify the user's place in the enterprise's hierarchy. For example, a workgroup might be Denver
Center, ABC Bank. In most cases, certain partitions are associated with specific workgroups, so it is sufficient to select workgroups
and the partitions are automatically included. At times, it may be necessary to add partitions as well.

This section explains how to create and manage groups. Groups are managed in the Administer Groups screen.

To open the Administer Groups screen: 

 In the Main Menu, under Tools, select User Management, and then select Administer Groups. The Administer Groups
screen opens and displays a list of the groups that are already defined in the system. For each group, the workgroups and
partitions associated with the group are listed under Partitions.

Creating a New Group 

You can create new groups as necessary.

To create a new group:

1. In the Administer Groups screen, below the list of groups, click the New button. A group-definition dialog box opens.

Group-definition dialog box 

2. Under Group, type a name for the group.

3. In the tree area below the group name, select the partitions and workgroups to associate with the group. Click the plus sign (
) beside a node to expand a node or the minus sign ( ) to collapse it.

4. Click Save. The dialog box closes, and the group is created and added to the list.

Modifying Groups 

You can modify the list of partitions and workgroups associated with a group. 

To modify a group:
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1. In the Administer Groups screen, click the name of the group. A group-definition dialog box opens. The partitions and
workgroups that are currently associated with the group are selected. 

2. In the tree area below the group name, modify the selection of partitions and workgroups necessary. Click the plus sign (
) beside a node to expand the node or the minus sign ( ) to collapse it.

3. Click Save. The dialog box closes, and the group definition is modified.

Deleting Groups

You can delete groups from the system if no users are associated with them. 

To delete selected groups:

1. In the Administer Groups screen, in the list of groups, under Delete, select the checkbox of each group you want to delete. 

2. Below the list of groups, click the Delete button. You are prompted to confirm that you want to delete the groups.

3. Select OK. The groups are deleted.

 

See also

Editing Your User Profile
Managing Users
Managing Roles
 

Home > Tools > User Management > Managing Roles

Managing Roles
Roles are used to create sets of permissions that are appropriate for different types of users. For example, the role of Administrator is
a set of permissions that enables a user to access most system features, including user and system management and SMART
functionality. By contrast, the role of Regular User is a much more limited set of permissions that is designed to enable agents to see
call data that is relevant to them, to take part in coaching sessions, and to see the results of certain reports, but blocks access to
many system functions.

Users with different roles see different elements of the SpeechMiner interface. For example, a Regular User may not have permissions
to see the Tools page at all. In this case, Tools will not even appear in the Main Menu of a user who has this role. By contrast, a user
with an Administrator role will see all the pages and all the tabs and screens that belong to each page.

One or more roles can be assigned to each user. The user's permissions in the SpeechMiner system include all the permissions of all
their roles. 

Seven default roles are defined in the system. The default permission sets of these roles are designed to be appropriate for the
majority of SpeechMiner users.

Default
Role

Description

Regular User A standard set of permissions suitable for most users, this role permits viewing of most pages, playing back calls,
and adding comments to calls. It does not permit any access to SMART.

Power User An expanded set of permissions that includes the standard set of permissions assigned to Regular Users plus
permissions for user management.

SMART User A standard set of permissions suitable for most users of SMART.

SMART
Power User

An expanded set of permissions for SMART users that includes the standard set of permissions assigned to
SMART Users plus permission to release a program that is locked by another user, edit global variables and
directives, update program processing priority, activate and deactivate programs, and export and import
programs. 

Event Audit This Role is aimed at the auditing tasks required to check for the system's quality during the implementation of
new Topics.

Administrator Aimed at allowing for administrative tasks such as user and permissions management.
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Managing Roles

If you have the necessary permissions, you can modify the lists of permissions defined for each existing role, delete any role except
the Administrator role, and create new roles.

Roles are managed in the Administer Roles screen. 

To open the Administer Roles screen:

In the Main Menu, under Tools, select User Management and then select Administer Roles. The Administer Roles screen
opens and displays a list of existing roles.

 

Modifying a Role

You can modify the permissions that are assigned to any role.

To modify a role:

1. In the Administer Roles screen, click the name of the role. The role-configuration dialog box opens.
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 Role-configuration dialog box 

2. In the Grant Roles tab, select the roles that users with the current role can assign to other users.

For example, if you are configuring the Administrator role, you would probably choose all of the roles, but if you are
configuring the Power User role, you would probably not choose Administrator, SMART User, or SMART Power User, because
Power Users do not configure SMART user accounts and only an Administrator should be able to grant an Administrator role.

3. In the Web Site, Reports, SMART, and SMConfig tabs, select the permissions the role should have. 

In each tab, the permissions are divided into groups. To collapse a group, click the >> in the title bar of the group. Click
the << again to expand a collapsed group.

If you wish, you can filter the list of permissions in a tab. To do so, in the Filter by text field, type a character or sequence of
characters that are included in the names or values of the permissions you want to see. Permissions that do not include the
sequence of characters are hidden from the display as you type.

4. When you have finished modifying the permissions for the role, click Save. The modifications are saved and the dialog box
closes. 

Adding a New Role 

You can add new roles to the system as necessary. New roles can be added in one of two ways: by adding a new role and configuring
it directly, or by copying and existing role and then modifying the configuration of the copy as necessary.

To add a role:

1. In the Administer Roles screen, click the New button. The role-configuration dialog box opens.

2. Under Role, type a name for the role.

3. In the tabs, select the required permissions as described above.
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4. When you have finished selecting the permissions for the role, click Save. The role is saved and the dialog box closes.

To copy a role and modify it:

1. In the Administer Roles screen, in the line containing the role you want to copy, click Copy. You are prompted to enter a
name for the new role.

2. Enter a name for the role, and then click OK. The new role, with the attributes of the role from which it was copied, is added
top the list of roles.

3. Click the name of the role. The role-configuration dialog box opens.

4. Modify the permissions as required (see above).

5. When you have finished modifying the permissions for the role, click Save. The role is saved and the dialog box closes.

Deleting Selected Roles 

You can delete roles as necessary. 

To delete selected roles:

1. In the Administer Roles screen, in the list of groups, under Delete, select the checkbox of each role you want to delete. 

2. Below the list of roles, click the Delete button. You are prompted to confirm that you want to delete the roles.

3. Select OK. The roles are deleted.

 

See also

Editing Your User Profile
Managing Users
Managing Groups
 

Home > Tools > System Administration

System Administration
The System Administration tools are used to monitor and manage the system and its servers as well as some of its global features,
such as Preset Views and alerts.

See also

Managing Preset Views
Monitoring the System
Managing the Call Queue
Purging the System
Managing the Cache
Reprocessing Interactions and Managing Audits
System Configuration
Managing Alerts
System Alerts

Category Management
User Management
Elements Explorer
 

Home > Tools > System Administration > Managing Preset Views

Managing Preset Views
Views are sets of widgets in a particular layout that are visible in the Views page. Preset Views are Views that are designed by
administrators or managers for use by other users. They are designed in the Tools page and then published to the Views pages of
specified users.

If you have the necessary permissions, you can create, publish, and manage Preset Views, as explained in this section. For an
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overview of Views and the Views page, see Views.

Creating a New Preset View

You create a new Preset View by designing a layout for the View and publishing it to the Views pages of users with specified roles.
For each role you select, you also specify the permissions for the Preset View - whether a user with that role can modify or delete the
View in their Views page.

To design a new Preset View:

1. In the Main Menu, under Tools, select System Admin and then select Preset Views. The Preset Views screen opens.

2. Click New. A New Preset View dialog box opens.  

 

 New Preset View Dialog Box

3. Under Name, type a name for the Preset View.

4. Under Description, type a description for the Preset View. 

Note: Although you can add roles to the Preset View at this time, it is recommended that you design the view (add widgets
and set the layout) before adding the roles. When you have finalized the design, add the roles and publish the Preset View as
described below.

5. Click Save. A blank Preset View appears.

6. Use the Add Widgets and Change Settings options to create the View, and edit the settings of the widgets as necessary.
For detailed information about how to do this, see Managing Views and Managing Widgets.

7. When you have finished designing the Preset View, in the upper-right corner of the screen, click Back to Preset Views. The
Preset View closes, and the Preset Views screen is displayed. The new Preset View appears in the list of Preset Views in the
screen.

Once you have designed the Preset View, you can set the user roles to which you want to publish the Preset View and the permissions
each type of user will have to modify the Preset View.

1. In the Preset Views screen, in the list of Preset Views, click the name of the Preset View, or click Edit. The Edit Preset
View dialog box opens.

2. Under Permissions, under Role Name, select one of the user roles to which you want to publish the Preset View.

3. To the left of the selected role, click Add. A permissions row is added for the selected role. Checkboxes appear in the row for
each type of permission.

4. Select the checkbox of each permission you want to grant to users of the selected role.
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5. Repeat the previous three steps for each role to which you want to publish the Preset View.

6. Publish the Preset View as described below.

Publishing Preset Views

After you create a new Preset View or modify an existing one, you must publish the View in order for it to appear in users' Views
pages in its current form. Published Preset Views appear in the pages of all users whose roles appear in the View's permission
settings. If you republish a Preset View that was already published before, the new version overwrites the existing version in all
users' Views pages.

Note: When you republish a Preset View, all local changes to the View that were made by individual users are removed; the new
version of the View replaces all existing versions.

To publish Preset Views:

1. In the Preset Views screen, in the list of Preset Views, select the checkbox beside each Preset View you want to publish.

2. At the upper-left of the screen, click the Reset button. You are prompted to confirm that you want this version of each
selected Preset View to overwrite any previous versions of the same Views that may already be on users' Views pages.

3. Click OK. The new Preset View is published to the Views pages of all users with the roles you specified.

Editing Preset-View Settings

You can edit the name, description, and permissions of any of the Preset Views you created. The changes are implemented as soon
as you save them; you do not have to republish the Views after you change their settings.

To edit the permissions of an existing Preset View:

1. In the Preset Views screen, in the list of Preset Views, click the name of the View, or click Edit. The Edit Preset View dialog
box opens.

2. Modify the name, description, and permissions as required.

3. Click Save. The changes are saved and published to user's Views pages. If you removed a user's role from the list of
permissions, the View is removed from the user's Views page.

Editing Preset-View Layout

You can modify the layout and widget set of any of the Preset Views you created. Once you do this, you must publish the View again
to implement the changes on users' Views pages.

Note: When you republish a Preset View, all local changes to the View that were made by individual users are removed; the new
version of the View replaces all existing versions.

To modify the layout of an existing Preset View:

1. In the Preset Views screen, in the list of Preset Views, under Layout, click the  icon. The current Preset View is displayed.

2. Modify the layout and selection of widgets as required. For detailed information about working with the layout and widgets,
see Managing Views and Managing Widgets.

3. When you have finished designing the Preset View, in the upper-right corner of the screen, click Back to Preset Views. The
Preset View closes, and the Preset Views screen is displayed.

4. To publish the changes to user's Views pages, follow the instructions above.

Deleting a Preset View 

You can delete a Preset View. When you do so, the View is removed from the Views pages of all users and from the list of Preset
Views in the Tools page.

To delete a Preset View:

1. In the Preset Views screen, in the list of Preset Views, select the checkbox beside each Preset View you want to delete.

2. At the upper-left of the screen, click the Delete button. You are prompted to confirm that you want to delete the selected
Preset Views.

3. Click OK. The selected Preset Views are removed from all users Views pages and from the list of Preset Views.
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See also

Monitoring the System
Managing the Call Queue
Purging the System
Managing the Cache
Reprocessing Interactions and Managing Audits
System Configuration
Managing Alerts
System Alerts
 

Home > Tools > System Administration > Monitoring the System

Monitoring the System

The Monitor System screen provides information on the status of the different SpeechMiner modules and allows the user to stop or
run (restart) the system as necessary. In addition, the bottom of the screen can be used to view system messages.

To open the Monitor System screen:

In the Main Menu, under Tools, select System Admin and then select Monitor System. 

Monitor System Screen

Monitoring Module Status

The Monitor System screen presents a system status information, including:

All Calls - Calls currently in the SpeechMiner database

Not Processed - Number of calls waiting to be processed. These calls have been added to the system by the fetcher, but have
not gone through recognition yet.

Latest Call Time - The time of the latest call that was added to the system.

Log Errors, Log Warnings - Number of errors and warnings that haven't been handled yet. When there are errors, the
administrator can investigate using the information in this screen as well as by running the Monitor System report or using the
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ULogger utility directly on a server. 

Note: The system can be configured to send reports of errors via e-mail to specified recipients whenever errors arise. For
additional information, see System Alerts.

In Process - Number of calls currently being processed. These calls have started the recognition process and haven't been
completed yet.

Total Processed (24H) - Number of calls that were processed in the last 24 hours. This is an indicator of how well the
processing system is functioning

Waiting for Categorization -  This number includes calls that are waiting to processed (Not Processed) and calls that are
done processing but that are waiting to be picked up by the categorizer.

Total Categorized (24H) - Number of calls that were categorized in the last 24 hours. This is an indicator of how well the
categorization system is functioning.

Number of calls in queue waiting to be processed, broken down into the various phases
SpeechMiner - Calls already picked up by the fetcher and added to the system, waiting to be processed.

Input Folders - Calls in the input folders, waiting to be picked up by the fetcher.

Recording System - Calls in the recording system, waiting to be picked up by the UConnector (This information is only
available on certain systems, depending on the integration with the recording system).

Total - Summary of all numbers above. Reflects the known amount of processing ("backlog") to be done, in order to
catch up with current recording. A small total number is a healthy state. A total of 0 might indicate an idle system,
where UConnector has no remaining calls to pick up or UConnector is down.
On a system with high fluctuation in call volumes over the course of a day or a week, the total number will grow during
the peak volume period, and will gradually get smaller during the rest of the cycle. An ever growing total indicates a
problem.

Note: The UConnector can buffer a relatively large amount of calls (calls that are between the Recording System and
the Input Folders state). Such calls will be temporarily missing from the total count.

Status of the various sites

Folder status (Input, Filter, and Store): If available space is low, a warning or error is generated.

Starting or Stopping Machines

You can start of stop some or all of the machines in the system from the Monitor System screen.

To start or stop all the machines in the system:

Use the Start ( ) and Stop ( ) buttons on the right.

Note: Stopping the system does not turn off the UPlatform.exe service. To do that, you must run the SMConfig tool.

To start or stop a single machine in the system:

In the left panel, select the machine. Two new buttons appear under the system's Start ( ) and Stop ( ) buttons: Start

Machine ( ) and Stop Machine ( ).  Use these buttons to start or stop the selected machine.

Viewing System Messages

The bottom of the screen can be used to display system messages.

Note: You can also see system messages, as well as additional system-status information, by running the Monitor System report.

To view system messages:

1. At the bottom of the screen, in the Messages area, set the filters you want to apply to the message list.

2. Click Show. The messages are displayed below the filters.

To see the full text of a message:

Place your mouse cursor on the message text.

To mark all the messages that were retrieved as "read": 

Click Mark as Read.
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See also

Managing Preset Views
Managing the Call Queue
Purging the System
Managing the Cache
Reprocessing Interactions and Managing Audits
System Configuration
Managing Alerts
System Alerts

 

 

 

 

Home > Tools > System Administration > Managing the Call Queue

Managing the Call Queue

When SpeechMiner retrieves calls from the shared file system, it adds them to a queue of calls that are waiting to be processed. The
calls in the queue are processed in accordance with the priority levels of their Programs or, if the Program priorities are equal, in
accordance with the selected process order (older calls first or newer calls first).

Program priority levels are initially set in SMART, but they can be changed from within the SpeechMiner interface, either on a
permanent or a temporary basis. Changing the priority level permanently changes it for calls that are currently in the queue and for
calls that are added to the queue later. Changing it temporarily only affects those calls that are already in the queue. When new calls
are added to the queue, they are assigned the normal priority level of the Program to which they belong. In this way, calls that are
already in the queue can be moved up or down in priority without influencing how SpeechMiner will treat the next group of calls it
adds to the queue.

Only batches of calls belonging to a particular Program can be moved in the queue; individual calls cannot be moved.

The call queue settings are set in the Manage Call Queue screen.

Manage Call Queue screen 

To open the Manage Call Queue dialog box:

In the Main Menu, under Tools, select System Admin and then select Manage Call Queue.

To change the process order:

Under Process Order, select the required process order.

To permanently change the priority of a Program:

In the Program column, click Edit. In the dialog box, select the required priority level, and then click OK.

To temporarily change the priority of a Program:

In the Calls in Queue column, click Set Priority. In the dialog box, select the required priority level, and then click OK.
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To sort the table by a particular column:

Click the heading of the column. (Click it a second time to reverse the order.)

 

See also

Managing Preset Views
Monitoring the System
Purging the System
Managing the Cache
Reprocessing Interactions and Managing Audits
System Configuration
Managing Alerts
System Alerts
 

Home > Tools > System Administration > Purging the System

Purging the System

When old calls are no longer required, it is possible to safely remove them from the system. This will reduce the database size and
will result in better performance overall.

You can choose to delete all calls in the database or select a specific group of calls to delete. If you choose to delete a specific group,
you define the group in one of the following ways:

Date range

One or more Programs

Note: Calls that belong to static Interaction Lists or manual Categories are not deleted during a purge.

Note: It is possible to set up an automated purging job. For additional information, contact Genesys Telecommunications Laboratories
support.

To purge calls from the system:

1. In the Main Menu, under Tools, select System Admin and then select Purge System.

2. Select the desired options.

3. Click Delete. 

 

See also

Managing Preset Views
Monitoring the System
Managing the Call Queue
Managing the Cache
Reprocessing Interactions and Managing Audits
System Configuration
Managing Alerts
System Alerts
 

Home > Tools > System Administration > Managing the Cache

Managing the Cache

For performance reasons, many of the fixed elements of the interface, such as the names of Categories and Topics, or the list of
metadata types, are stored in a cache. The contents of this cache is automatically reset from time to time, and is also normally reset
whenever changes made in SMART are applied in SpeechMiner. Nonetheless, at times you may find it necessary to reset the cache
manually. For example, you may wish to do this when a new agent has begun working, so that the agent's name will appear in the
system.
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You can reset the entire cache or select specific parts of the cache to reset.

To reset part or all of the cache:

1. In the Main Menu, under Tools, select System Admin and then select Manage Cache. The Manage Cache screen opens.

Manage Cache screen

2. In the dropdown list, select the part of the cache you want to reset. 

3. Click Reset. The selected part of the cache is reset, and a confirmation message appears.

4. Click OK to close the confirmation message.

 

See also

Managing Preset Views
Monitoring the System
Managing the Call Queue
Purging the System
Reprocessing Interactions and Managing Audits
System Configuration
Managing Alerts
System Alerts
 

Home > Tools > System Administration > Reprocessing Interactions and Managing Audits

Reprocessing Interactions and Managing Audits

The Interactions Admin screen is used to perform a number of interactions- and audit-management tasks: deleting audits,
reprocessing interactions, and cleaning the database of information about terms that were removed from Topics. These tasks may be
necessary, for example, when Topic terms have undergone significant changes.

 

Interactions Admin screen

To open the Interactions Admin screen:

In the Main Menu, under Tools, select System Admin and then select Interactions Admin.

Deleting Audits

You can delete all the audits for a particular Topic or for all Topics.
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To delete audits:

1. In the Interactions Admin screen, in the Delete Audits tab, click the arrow ( ) to the right of the Audits field. A
dropdown list of Topics appears.

2. Select the Topics for which you want to delete the audits.

3. Click Delete. The audits are deleted for the selected Topics.

Reprocessing Interactions

You can run event analysis again on all interactions or for specified Topics or Programs. You can also specify the date range for which
you want to apply the reprocessing.

To reprocess interactions:

1. In the Interactions Admin screen, in the Reprocess Interactions tab, select the types of interactions you want to
reprocess.

2. Select a reprocessing option, as follows:

Option Description

All Reprocess all interactions. 

Topics Reprocess the selected Topics.

Programs Reprocess the selected Programs

Reprocess Interactions tab

3. If you selected Topics or Programs, click the arrow ( ) beside your selection, and then, in the Multi-Select box, select the
items you want to reprocess. (For additional information about using the Multi-Select box, see Defining Search Criteria.)

4. In the last field, click the arrow to open the dropdown list, and then select the range of dates for which you want to reprocess
the items.

5. Click Reprocess. The items are reprocessed.

Cleaning Orphaned Audits

If terms were deleted from Topics during the auditing and fine-tuning process, they should also be removed from the lists of terms
that are tracked in reports and in the Interaction and Event grids.

To remove deleted terms from the lists of tracked terms:

In the Interactions Admin screen, in the Clean Orphaned Audits tab, click Clean. The terms are deleted.

 

See also
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Managing Preset Views
Monitoring the System
Managing the Call Queue
Purging the System
Managing the Cache
System Configuration
Managing Alerts
System Alerts
 

Home > Tools > System Administration > System Configuration

System Configuration
The System Configuration page displays system configuration and security information. The configuration information is for viewing
only, but some of the security settings can be changed. 

 

See also

Viewing System Information
Managing Security Settings

Managing Preset Views
Monitoring the System
Managing the Call Queue
Purging the System
Managing the Cache
Reprocessing Interactions and Managing Audits
Managing Alerts
System Alerts
 

Home > Tools > System Administration > System Configuration > Viewing System Information

Viewing System Information

You can see a summary of information about the different components of the system. If you wish, you can embed this summary in
intranet sites that use wiki markup.

To view system-configuration information:

In the Main Menu, under Tools, select System Admin and then select System Configuration. The System Configuration
screen opens and displays the Default tab, in which the system-configuration information is displayed.
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Default tab

To embed the system-configuration information in an intranet site:

1. In the System Configuration screen, in the Wiki tab, select and copy the text.

2. In the intranet site, paste the text in the desired Wiki location.

  

See also

Managing Security Settings
 

Home > Tools > System Administration > System Configuration > Managing Security Settings

Managing Security Settings

SpeechMiner complies with the security standards defined in the PCI-DSS standard (Payment Card Industry Data Security Standard).
These standards are designed to prevent confidential information from being accessed by unauthorized individuals. For example, one
purpose of SpeechMiner security settings is to prevent unauthorized people from hearing calls that are stored in the database. Some
of the options that must be implemented in SpeechMiner in order for it to conform to the PCI-DSS standard are:

Call export is disabled for all users.

Anonymous Permalinks are disabled for all users.

Numbers are filtered out of all call playback.

All audio files are encrypted.

The password for encrypting audio files has been changed from its default value.

The password for the default user account (Administrator) has been changed from its default value.

Access to the SpeechMiner browser-based interface is only available using Windows authentication; SpeechMiner
authentication is disabled.

Access to the system is blocked after ten consecutive attempts to log in with an invalid password.

Permissions are set properly for all users and components of the system.

All web services use a secure API, and can only be accessed using a token that is supplied by the system upon user login.

Secure SSL connections are used for all connections to and between servers in the system.
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The SSL certificate is valid and includes all the domains used by the site.

All user events are logged.

Tracing is disabled on all web servers in the system.

The settings that must be configured in order to implement these options are defined in various locations in the system, including
SMConfig (the SpeechMiner configuration tool), the SpeechMiner web interface, and the configuration files of specific system
features.  In some cases, more than one setting must be configured in order for a requirement to be met. (For example, SSL
connection requirements must be configured separately for different servers in the system.) The Security Center lists all of the PCI-
related settings in your system and, whenever possible, automatically checks the system to see if they conform to the standard. In
some cases, the system can correct an issue for you by changing the relevant settings; in other cases, you must manually correct the
settings. You can also choose not to implement some or all of the PCI requirements; you can manually change the settings as you see
fit.

The Security Center also contains a log of all security-related actions that were performed in the system. The log lists configuration
changes and failed login attempts. This information can be used to monitor the system for security breaches.

Note: The information in this section is intended to explain how to work with the Security Center interface.
It includes a general overview to the subject of PCI implementation in SpeechMiner. For comprehensive
information about securing your SpeechMiner environment, please follow the guidelines in the SpeechMiner PCI
Implementation Guide.

Note: Following these guidelines does not ensure that your entire system is PCI-DSS compliant, or guarantee the
confidentiality of your data. It is your company's responsibility to work with your IT department to ensure
that your hardware and network systems are secure from internal as well as external intrusions. Genesys
Telecommunications Laboratories makes no claims about the security of your network or the extent to which it
is PCI-DSS compliant.

Opening the Security Center

The Security Center is accessed from the System Configuration screen.

To open the Security Center:

In the System Configuration screen, click the Security Center tab.
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Security Center tab

The upper part of the tab contains PCI-compliance information. The lower part contains a log of security-related user actions. Both
tables can be sorted by any of the columns they contain.

To sort a list by a column:

Click the title of the column. (Click it a second time to reverse the order.)

Managing PCI-Related Settings

The PCI-DSS Recommended Configuration section contains a table that lists all of the PCI-related settings. The table has three
columns:

Column Description

Setting Name of the setting

Explanation Description of what conditions must be met in order for the setting to conform to the standard.

Note: If the system cannot check whether the setting meets the conditions, "Make sure that..." appears at the
beginning of the explanation.

Action The current status of the setting, and/or the type of action required to correct it:

Fixed: The setting conforms to the PCI requirements.

Fix: The setting does not conform, but the system can correct it.
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Manual: Either the setting does not conform, or the system cannot check whether the setting conforms.

To correct a setting that can be fixed automatically:

1. Under Action, click Fix. You are prompted to confirm that you want to change the setting.

2. Click Yes. The system corrects the setting and changes its Action status to Fixed.

To correct a setting manually:

Follow the instructions under Explanation to manually correct the problem. For additional information, please refer to the
SpeechMiner PCI Implementation Guide.

To correct all the settings that can be fixed automatically:

1. At the top of the list, click Reset. You are prompted to confirm that you want to change the settings.

2. Click Yes. The system corrects the settings and changes their Action status to Fixed.

Note: Settings that require manual correction are not changed when Reset is selected.

Monitoring the Security Log

The lower table in the Security Center lists system configuration changes and failed logins that occurred in a specified time period.
(System configuration changes are changes that are implemented using SMConfig, the SpeechMiner system configuration tool.)

To configure the display in the table:

1. At the top of the table, select the display options as follows:

Option Description

Last Enter the number of hours or days (prior to the current time) to include in the table

Time Unit Select Hours or Days

Failed Login Select this option to include failed logins in the list

Configuration Change Select this option to include configuration changes in the list

2. Click Refresh. The display in the table is updated to match the options you chose.

 

See also

Viewing System Information
 

Home > Tools > System Administration > Managing Alerts

Managing Alerts

You can configure SpeechMiner to send email alerts to specified people when groups of calls have certain unusual
or significant characteristics. For example, you can check for changes in the number of calls containing caller agitation, or how many
calls each agent handled per week.

The following types of alerts are available:

Change Alert: This type of alert is designed to tell you when the number of calls that meet a certain condition has changed
significantly from one time period to the next. For example, you could define a Change Alert to notify you when the number of
calls dealing with a particular Topic is more than ten percent higher that it was the previous week.

Threshold Alert: This type of alert is designed to tell you when a significant number of calls meet a certain condition. For
example, you could define a Threshold Alert to notify you when the number of calls handled by an agent falls below 1000 in a
given week.
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Trend Alert: This type of alert is designed to find significant changes over time in the numbers of calls that meet a certain
condition. For example, you could define a Trend Alert to notify you when the number of calls dealing with new accounts
decreases significantly for four weeks straight.

On Event Alert: This type of alert is designed to tell you when a particular type of event takes place in a specific number of
calls. For example, you could define an On Event Alert to notify you when your competitors are mentioned in more than ten
calls.

Change, Threshold, and Trend alerts are generated by the system once a day. That is, at a set time every day, the system checks
the preceding day's data to see which of the alert conditions were met, and sends notifications for those alerts that were generated.
On Event Alerts are generated whenever their conditions are met. The same On Event alert could be generated multiple times in the
same day, if the conditions were met multiple times.

Creating a New Alert

You can create new alerts as required.

To create a new alert:

1. In the Main Menu, under Tools, select System Admin and then select Alerts. The Alerts screen opens and displays a list of
the currently defined alerts.

Alerts screen

2. Below the list of alerts, click New. The Alert Type dialog box opens.

 

Alert Type dialog box

3. Select the type of alert you want to create, and then click Next. An Alert Parameters window opens. The fields vary slightly
depending on the type of alert you selected. 
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Alert Parameters window for a Change Alert

4. Under Details, in the Alert field, type a name for the alert.

5. Under Trigger the alert if, select the call-property conditions, as follows:

Field Description

Agent

(Not available in
Threshold Alerts)

If you want to limit the alert to calls that were handled by particular work groups or agents, click the 

 beside this field to open the Multi-Select box. Add the work groups and/or agents to the list of
selected agents, and then close the Multi-Select box. For additional information about using the Agent
Multi-Select box, see Defining Search Criteria.

Categories/Topics If you wish, you can limit the alert to calls that belong to particular Categories or that contain particular

Topics. To do this, in the dropdown list, select either Categories or Topics, and then, click the 
 beside the next field to open the Multi-Select box and select the Categories or Topics. For additional
information about using the Multi-Select box, see Defining Search Criteria.

6. Fill in the fields on the next line as follows. (Note that the fields vary depending on the type of alert.)

Change Alert:

Field Description

Change
Value

Enter the percentage of calls or the number of calls that should activate the alert. For example, if you want the
alerts to be sent out when the number of calls that match the conditions during the current time period is 20%
lower this week than it was last week, enter 20. Alternatively, if you want the alerts to be sent out if the number

of calls matching the conditions during the current time period is lower by 100 this week than it was last week,
enter 100.

calls/% If the Change Value is a number of calls, select calls. If it is a percent change, select %.

Time
Period In the first field, enter the quantity of days, weeks, or months to include in each time period. For example, if the

time period is two weeks, enter 2. 
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In the second field, select the type of time period: day(s), week(s), or month(s). 

Threshold Alert:

Field Description

Threshold
Position In the first field, select Above if the threshold you want to define is above a specified value, or Below if it is

below a specified value. For example, if you want the alerts to be sent out if the percentage of calls matching
the conditions during the current time period is greater than  20%, select Above.  Similarly, if you want the
alerts to be sent out if the number of calls matching the conditions during the current time period is greater
than 100, select Above.

In the second field, enter the threshold value (e.g., 20 for 20% or 100 for 100 calls).

calls/% If the Threshold Position is a number of calls, select calls. If it is a percent change, select %.

Time
Period In the first field, enter the quantity of days, weeks, or months to include in the current time period. For

example, if the time period is two weeks, enter 2. 

In the second field, select the type of time period: day(s), week(s), or month(s). 

Trend Alert:

Field Description

Trend
Direction

Select Up if you want the alerts to be sent out when an upward trend is identified, or Down if you want to
find downward trends. For example, if you want to be notified of an increasing number of calls involving
agitated callers, select Up. Alternatively, if you want to be notified when there is an apparent decrease in
calls about a particular Topic, select Down.

Time
Period 

Enter the quantity of days, weeks, or months to include in the trend test. For example, if you want to test for
monthly trends over the past six-months, enter 6.  

consecutive Select the type of time period: day(s), week(s), or month(s). For example, if you want to see trends over
the past six months, comparing month to month, select month(s).

On Event Alert:

Field Description

Send alert when Enter the number of calls in which the event must occur before an alert is sent.

7. Under When triggered, send an email to, specify the recipients of the alert by selecting any combination of roles and
groups, and adding individual users and email addresses, as follows:

Under Roles, select the roles that should receive the email alerts. For example, if you select Administrator and
Power User, any user with either of these roles will receive the alert.

Under Groups, select the groups that should receive the email alerts. Any user who belongs to one or more of the
selected groups will receive the alert.

Under Type email or User name, enter the email address or user name of the person that should receive the email
alerts. As you type, the system automatically displays a list of all usernames that contain the entire sequence of
characters you have typed thus far. If the user name you want to add appears in the list, select it and it is automatically
entered into the field. When the email address or user name appears in its entirety in the field, click Add to add it to the
list of recipients. The email address or user name is added to the list of recipients that appears below the field.

8. Click Save. The alert is created and is added to the list of alerts. When groups of calls matching the conditions you set are
identified by the system, email alerts are sent to the recipients you specified.
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Sorting the List of Alerts

You can sort the list of alerts by any of the columns.

To sort the list of alerts by a column:

Click the heading of the column. The selected column is identified by a  beside the heading.

Note: To change the sort order from ascending to descending, or vice-versa, click the heading a second time.

Editing an Existing Alert

You can edit the settings of an alert as necessary.

To edit the settings of an alert:

1. In the Alerts screen, in the list of alerts, click the name of the alert. The alert parameters window opens.

2. Modify the settings as necessary.

Note: To remove an individual user name or email address from the list of recipients, select it in the list and then click Clear.

3. Click Save. The changes are implemented.

Deleting Alerts

You can delete alerts from the list when they are no longer needed.

To delete alerts from the list:

1. In the Alerts screen, in the Delete column, select the checkbox of each alert you want to delete.

2. Below the list, click Delete. You are prompted to confirm that you want to delete the selected alerts.

3. Click Yes. The selected alerts are deleted.

 

See also

Managing Preset Views
Monitoring the System
Managing the Call Queue
Purging the System
Managing the Cache
Reprocessing Interactions and Managing Audits
System Configuration
System Alerts
 

Home > Tools > System Administration > System Alerts

System Alerts

A monitoring process runs on every platform computer in the system. The current state of the platform computers in the system is
displayed in the Monitor System page. The system can be configured to send out e-mail notification messages to specified recipients
whenever a monitoring process discovers an error, such as a full disk, on one of the monitored computers. Whenever a new error is
discovered, a notification is sent. The notification lists all errors that are detected in the system at the time it is sent (even if
notifications about them have already been sent).

Note: New notifications are only sent out when new errors are discovered. Even if an error has remained uncorrected for a long
period of time, no new notifications are sent out about it unless additional errors are detected.

System alert notifications are configured using a Saved Report called System alert. This saved report appears automatically in the
Saved Reports page and cannot be deleted. It is configured using the Scheduling feature.

To configure System Alert notifications:
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1. In the Main Menu, under Reports, select Saved Reports. The Saved Reports tab opens.

Saved Reports tab

2. Locate the row of the System alert report, and click Schedule ( ). The scheduling dialog box opens, and the Recipients tab
is displayed. (The Schedule tab is not available for this report, because it is configured automatically.)

 

Scheduling dialog box

3. Fill in the fields as follows:

Field Description
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To The e-mail addresses of the report recipients. Separate multiple addresses with semi-colons (;). 

From The sender address to use 

Subject The text that should appear in the subject line of the e-mail. 

Report
Format

Select Web archive to format the results as an MHT file (which can be opened in Internet Explorer). Select
PDF to format the results as a PDF file.

Priority Select the desired priority level for the e-mail message.

4. Click Schedule. The recipients of system alerts are set as specified.

 

See also

Managing Preset Views
Monitoring the System
Managing the Call Queue
Purging the System
Managing the Cache
Reprocessing Interactions and Managing Audits
System Configuration
Managing Alerts
 

Home > Tools > Elements Explorer

Elements Explorer

The Elements Explorer allows you to browse the elements (Topics, Programs, and Categories) available in your version of
SpeechMiner.

 

See also

Topic Statistics
Program Statistics
Category Statistics

Category Management
User Management
System Administration
 

Home > Tools > Elements Explorer > Topic Statistics

Topic Statistics
The Topic Statistics screen displays the properties of selected Topics, such as the Topics' Term Count (the number of terms the
Topic contains) and Program Count (how many Programs use the Topic).
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Topic Statistics page

To open the Topic Statistics screen:

In the Main Menu, under Tools, select Elements Explorer and then select Topic Statistics. 

To view the properties of one or more Topics:

1. In the Topics Multi-Select box, select the Topics whose properties you want to see. (For additional information about using the
Multi-Select box, see Defining Search Criteria.)

2. Click Search. The properties of the selected Topics are displayed. 

Exporting to XLS:

You can export the table of Topic properties to an XLS file for offline use. This may be especially useful during the implementation
phase.

To export the list of Topics:

Click Export. 

 

See also

Program Statistics
Category Statistics
 

Home > Tools > Elements Explorer > Program Statistics

Program Statistics
The Program Statistics screen shows the following information for selected Programs:

The number of Topics in the Program. This information can help you identify empty Programs.

List of Topics in the Program, including the name of the Topic, its save date, the name of the user who saved it, and the list of
Terms in the Topic

 

Program Statistics page
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To open the Program Statistics screen:

In the Main Menu, under Tools, select Elements Explorer and then select Program Statistics. 

To view information about one or more Programs:

1. In the Programs Multi-Select box, select the Programs whose properties you want to see. (For additional information about
using the Multi-Select box, see Defining Search Criteria.)

2. Click Search. The information about the selected Programs is displayed. 

 

See also

Topic Statistics
Category Statistics
 

Home > Tools > Elements Explorer > Category Statistics

Category Statistics

The Category Statistics screen contains a complete list of the Categories defined in your system. The screen displays data about
each Category, including the following:

Name: The name of the Category and its place in the hierarchy of Categories. This information is displayed in a similar fashion
in the Category Explorer (see Exploring Calls).

Description: Description of the Category

Locked By: Lock status. Indicates whether the Category is locked, and, if it is, which user locked it

Expression: Summary of the Category definition. This provides a quick way to review the definition and check that it is correct.

Active: Active status. Indicates whether the Category is active or inactive

To open the Topic Statistics screen:

In the Main Menu, under Tools, select Elements Explorer and then select Category Statistics. 

See also

Topic Statistics
Program Statistics
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Home > Permalinks

Permalinks

The Permalink feature enables you to save a network address for a particular item, such as a query or a report. This makes it easy to
access the item again. For example, after you select search criteria for a new call search, you can generate and save a Permalink to
the query. Later, you can paste into the Address field of your browser. When you press Enter, the search form is opened with all of
your search criteria specified. You can save the Permalink on your computer or as a favorite in your browser, or you can send it to
other users by e-mail or IM. Then, when you or the recipient want to run the search, you need only open the link in a browser.

In some cases, when you generate a Permalink, you can specify whether is can be accessed by anyone who has the link or only by
SpeechMiner users who have permissions in the system for the item. In these cases, if you choose the latter option, users must
provide their SpeechMiner username and password in order to access the item. When this option is not available, a SpeechMiner
username and password are always required.

Permalinks can be created for a variety of types of items, including specific calls, call searches, reports, and coaching sessions. When
you choose to generate a Permalink for one of these items, a Permalink dialog box opens and displays the Permalink URL. For
information about how to use this dialog box, see below. For information about how to open the dialog box in a particular screen, see
the section of this manual that describes the screen.

Permalink dialog box

To save a generated Permalink:

1. At the bottom of the Permalink dialog box, select Allow anonymous if you want to permit users to open the link without a
username and password. If you do not select this option, a username and password for a user account with permissions for
the linked item is required in order for a user to access the link.

Note: This option is not available for all types of Permalinks, and users must log in in order to open the link.

2. Click Copy & Close. The link is copied to your clipboard and the dialog box closes. Paste the link in a text file, the Address
field of your browser, an e-mail message, etc., as required. 

Most Permalinks only enable users to open interactions that belong to partitions for which they have permissions. Some Permalinks
allow users to open interactions from partitions for which they don't have permissions. When this is the case, a warning message
appears in the Permaling dialog box:
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Warning in Permalink dialog box

 

See also

Welcome
Getting Started
Workflows
Views
Action Items
Search
Using the Media Player
Explore
Quality Monitoring
Coaching
Reports
Tools
Appendix A: Standard Reports

Creating a New Call Search
Saved Searches 
Media Player: More Actions Options
Managing Saved Reports 
Managing the Coaching Session List
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Home > Appendix A: Standard Reports

Appendix A: Standard Reports

SpeechMiner comes with a number of standard report templates. These report templates are described in this appendix. For
information about configuring and generating reports from templates, see Reports.

Note:

Some reports may not be available to all users. As such, you may not see them in your system.

You may have access to reports that are not documented here because they were custom made for your organization.

 

See also

Template Layout
Common Parameters
Templates 

 

Home > Appendix A: Standard Reports > Template Layout

Template Layout

This section explains the general layout of report templates. The next section, Common Parameters, describes parameters that
appear in many report templates. These sections are followed by the Templates section, a catalogue of all of the report templates,
with descriptions of each report and additional information about the reports. When specific templates use significantly different
layouts and parameters from the most common ones explained below and in the Common Parameters section, they are explained in
the Templates section in the description of the relevant report template.

The report templates in SpeechMiner have a maximum of three rows of parameters, each row dealing with different functions in the
report. In addition, most report templates have a Data Set filter section on the left side of the screen. The layouts of most templates
are similar to the Agent Comparison template shown below.

Agent Comparison template

In this section, we will explain the layout of report templates using the Agent Comparison template as an example, since it has the
most common layout of parameters you will encounter.

Template Rows

The following rows appear on the right side of the template: 
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First Row

Contains controls for working with report results (see Creating a Custom Report), followed by the Template field, in which you can
select the type of report, and the Report Name field, which you can use to name the report. If you choose to save the report
parameters as a saved report (see Managing Saved Reports), the Report Name is used to identify it in the system.

 

Second Row

Contains fields for defining the report title and an optional report description. These items are displayed at the top of the report
results. By default, the name of the report template is used as the report title, but you can modify it as necessary. Some templates
also have a Version parameter in this row. If so, you can use this parameter to select the size or format of the report output.

 

Third row

Contains the Items on Report parameters - the fields that determine which items will appear graphically on the report. In some
reports, one or more of the parameters may also have statistical functions.

 

Data Set Filters

The left side of most report templates contains the Data Set filters. These filters specify which data will be included in the report's
analyses. For information about the filters and how to configure them, see Common Parameters.

Data Set filters

When you are not configuring the Data Set filters, you can hide the left panel of the screen if you wish.

To hide or show the Data Set filter panel:

Appendix A: Standard Reports . 218

 

SpeechMiner ® User Guide Release 8.0 © 2013, Genesys Inc. Unauthorized Reproduction is Prohibited



In the upper-right corner of the panel, click  or .

The current filter settings are displayed on the right side of the template below the first row:

Current filter settings

  

See also

Common Parameters
Templates 
Creating a Custom Report 
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Common Parameters

The following parameters are the most common ones you will encounter. Most of them have the same function no matter which
template you use. Exceptions will be briefly explained in this section, and dealt with in detail in the documentation on individual reports
in the Templates section.

General Settings 

Template

You can choose or switch to any of the report templates available.

Report Name

Text entered in this field will be used as a file name for the report if you choose to save the report. This name will appear under the
Saved Reports tab for future access.

Report Title

Text entered in this field will be displayed in large, bold type at the top of the report results. The report title is optional. The name of
the report template appears in this field by default, but can be modified or deleted.

Description

Text entered in this field will be displayed in fine print directly below the Report Title in the report results. The description is optional. 

Version

The output of some reports can be generated in different versions - different sizes or formats In this field, select the desired output
version from the dropdown list. The available options vary depending on the template. The following options may be available:

Full Report: Full­size report output optimized for printing (either 11” wide x 8.5” high, or 8.5” wide by 11” high, depending on
the template). Full reports often contain two parts: a graph or chart followed by a summary table which may also contain
additional details.

In some cases, when a Full report contains items that can be expanded to display more details, the version has two options,
Expanded and Collapsed. When Full Report (Expanded) is selected, all items are initially expanded when the report is
displayed; when Full Report (Collapsed) is selected, all items are initially collapsed. In either case, the items can be
expanded or collapsed by the user after the report is generated.

Mini: Small output for display in the Views page (480px wide x 288px high) 

Wide: Wide-width output for display in the wider columns of the Views page (768px wide x 288px high)

Table Only: Full­size report output that only includes the summary table; graphs and diagrams are not printed (either 11” wide
x 8.5” high, or 8.5” wide by 11” high, depending on the template)
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X-Axis Only: For bubble charts; when this option is selected, the report output is in the form of a table with a bar graph
representing the x-axis values. No bubble-chart is produced, and y-axis values are not represented. (Width: 768px)

Y-Axis Only: For bubble charts; when this option is selected, the report output is in the form of a table with a bar graph
representing the y-axis values. No bubble-chart is produced, and x-axis values are not represented. (Width: 768px)

Data Set Filters

The Data Set Filters allow you to narrow down the data from the entire database in order to base your report on a subset of the
available data.

All of the Data Set Filters have an "AND" relationship, which means each filter further restricts the options available, and all call events
and topics represented in your final data set satisfy all Data Set Filters. Should you choose options from two different filters that
mutually exclude each other (e.g., a Program designated as "Customer Service France" with calls only in French and the Language
option "Dutch"), you will have zero data in your report.

Note that the parameters that appear under Items on Report (i.e., the third row of parameters; see description below) allow you to
select specific information from the base of data that is selected under Data Set Filters. Distributional information presented in the
report is calculated for the items selected under Items on Report, built upon the base of data that is selected using the Data Set
Filters.

The Data Set Filters appear in the Filter Panel on the left side of the report template for all reports that support them. The filters are
divided into groups. The basic filters appear at the top of the Filter Panel and are always displayed when the panel is displayed. The
other groups of filters can be expanded or collapsed. The following groups of filters are available:

Filter Group Description 

Basic filters Filters for selecting interaction types, languages, and the date range

Note: A day begins at 0:00 and ends at 23:59. "To Date" date filters (All, Today, Week to Date, Last 7 Days, Month
to Date. Last Month, Quarter to Date, Last 90 Days) include calls until the exact time and date the report is
generated. The times given are for the time zone where your Web server is deployed, and therefore are not
necessarily the same as the times where you are physically located.

SpeechMiner Filters for selecting the Categories and Programs of calls, and the Topics that must be found in them

For each option, select one or more values. Only calls in which at least one of the selected values for each option
was identified are included in the data set. For example, if you select three Categories and two Programs, only
calls belonging to at least one of the Categories and one of the Programs are included.

You can add lines to the Categories and Topics. The logical relationship between each line is AND. For example, if
one line under Categories specifies one Category and another line specifies another Category, a call must be in
both Categories to be included. To add a line, click .

To create a negative filter, click the  button beside the field. For example, to include all Categories except

Category A, select Category A and select the  button beside the Category field.

Call
Properties

Filters that allow you to select agents, call length, and external call ID properties

Agents: Select any combination of agents and workgroups. If you select a workgroup, all the agents in the
workgroup are included in the data set. You can also choose to search for the "current user" rather than a
specific agent or workgroup. In this case, the condition changes depending on which user runs the report. 

Call Length: Select the range of call durations to include in the data set: In the first field, select either
Less Than, Between, or More Than. In the second text field or fields, fill in the number of seconds. If you
selected Less Than, only calls that are shorter than the value you specified are included. If you selected
Between, calls whose durations are more than the first value and less than the second value are
included. If you selected More Than, only calls that are longer than the value you specified are included.

Call External ID: Type any portion of a call's external ID; any calls whose external IDs include the
characters you specify are included in the data set. You can use the * character as a wildcard. Place it at
the beginning or end of a sequence of characters to indicate that at least one other character must be in
that position in the sequence. For example, type *123 to specify external IDs that begin with any sequence,
but end with 123, or type 123* to specify external IDs that begin with 123 and end with any other sequence
of characters.

Metadata Filters for selecting metadata values

Metadata is collected by the recording system and relayed by it to SpeechMiner. The types of available metadata
vary from system to system. You can select any type of metadata available in your system and, if you wish, you
can specify a value for it. The search results will only include calls for which the selected type of metadata has a
value defined, and, if you specify a value, for which the defined value equals the specified value.
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User Actions Filters for finding calls that have user comments, were played back by users, about which forms were filled out, or
quality checking was performed

Under Call Comment Text, specify text that must appear in a comment that a user added to a call. In the other
fields, select the users who must have performed the specified actions.

For additional information about the filters and about working with the Data Set Filter interface, see Defining Search Criteria.

Items on Report

The parameters in this section allow you to select specific information from—and calculate distributional information on—the data in
the data set that was specified using the Data Set Filters. If no selections are made under Items on Report, default values will
determine how the data you have narrowed down through the Data Set Filters appear in the report.

Since the parameters in Items on Report differ from report to report, only the most common ones are explained in this section,
listed alphabetically. Less common parameters will be explained in their respective templates.

Agents

You can select the specific Agents or Workgroups to be analyzed and displayed in your report. The default value ("Any") includes all
agents. Your selections here must match up with your selections in the Data Set Filters (e.g., the same Workgroups or Agents,
belonging to the same Languages and Programs), if the latter are not all set to default ("Any"). In other words, the report output will
only include Agents who were selected here and who were not excluded from the data set in the Data Set Filters.

Categories

You can select specific Categories of calls to limit the data set analyzed for your report. Your data set will include calls belonging to
any of the Categories selected. Use the default value ("Any") to include all available Categories. Note that if a single call belongs to
multiple Categories, it will be counted as one call for each Category selected under this parameter. Also, bear in mind that the report
output will only include calls in Categories that were selected here and were not excluded from the data set in the Data Set Filters.
Thus, if you selected certain Categories in the Data Set Filters section, only Categories that are selected both there and here will
appear. 

When used with Percentage of Calls in the Data Type parameter, the report will display the ratio of {the number of calls from the
selected Categories in Items on Report} to {the number of calls from the Categories selected for analysis in Data Set Filters}, as a
percentage. Note that if one or more calls belong to multiple Categories, the sum of the percentages of calls for all Categories may
add up to more than 100%.

Data Type or Compare

You can specify the type of data you wish to display in your report. The most common choices are: 

Number of Calls: Displays the number of calls per each report item. Data may vary depending on the other filters selected.

Percentage of Calls: Displays the percentage of calls per report item in your data set. For additional information, see
Categories (in this Items on Report section).

Average Call Duration: Displays the average length, in minutes, of all calls for each report item. The entire conversation for
the call recording session is considered, excluding the wrap time after the call.

Total Resources: Displays the total amount of time, in hours, of all the calls per report item. It is essentially the sum of all call
durations.

Period Type or Period

This parameter is most commonly seen on reports that show trends. The output of the report will be displayed in increments of the
selected Period Type. For each increment, the value of the selected Data Type will be displayed for each particular report item. For
example, if the Data Type is "Number of Calls" and the Period Type is "Day," the number of calls for each day in the date range
included in the report will be shown.

Top or Display

In this parameter, you can choose how many of the highest or lowest values are displayed on the report. The options may include 5,
10, 15, 20, All, All Sorted, and All Unsorted.

   

See also

Template Layout
Templates 
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Home > Appendix A: Standard Reports > Templates

Templates

This section contains detailed information regarding each report template, including a general description, an overview explaining how
to customize the report (how the parameters function), and a sample report. For some templates, additional information on common
usages and actions you can perform on the reports is provided.

Most reports are interactive: you can drill down within a report to view additional details about any graphic component (graph bars,
lines, or table headers) by clicking on it. In addition, you can play a call in the Media Player directly from an Interaction List in the
report results. These interactive options are called actions. In some cases, report results offer additional action options. In these
cases, the description of the report includes as Actions section describing the additional actions that are available. For more
information about using the standard report actions, see Creating a Custom Report.

In some cases, reports have a number of available versions, such as a Full version, a MINI version, and a Wide version. In these
cases, a single template is used to generate all of the versions, and a Version parameter is used to select the desired version. (For
additional information about the Version parameter, see Common Parameters.)

Note: The information you see in reports is limited to the data to which you have access. 

The following standard report templates are available: 

Agent Bubble Chart
Agent Comparison
Agent Trend
Audit Analysis
Call List
Capacity Trend
Category Bubble Chart
Category Distribution
Category Trend
Coaching Summary
First Topic Distribution
Metadata Frequency
MINI_System Load
Monitor System
Performance Profile
Predictive Elements
Program Distribution
QM Agent Summary
System Load
Team Comparison
Top and Bottom Performers
Topic Analysis - Audits
Topic Analysis - Trends
Topic Call List
Topic Correlation
Usage Tracking
User Management
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Agent Bubble Chart
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Description

The Agent Bubble Chart report compares Agents and/or Workgroups by plotting them on a graph according to the percentage of calls
in the horizontal (x-axis) and vertical (y-axis) Categories. Each Agent is represented on the graph by a bubble. The size of each bubble
represents the average call duration.

The X-Axis Only and Y-Axis Only versions present the data as a histogram indicating percentage of calls per Agent and/or Workgroup,
rather than a bubble chart.

Common Usages

Plot Agents showing average call duration plus two customer-experience Categories (e.g., Dissatisfaction and Escalation)

Plot Agents showing average call duration plus two agent-efficiency Categories (e.g., Transfer Rate and Hold Rate)

Plot Agents showing average call duration plus two Categories that represent metadata (e.g., Customer Satisfaction and Issue
Resolution)

Customizing the Report

General Settings

Version: Available in Full Report (standard size), Mini, Wide, X-Axis Only, and Y-Axis Only versions. For additional information,
see Common Parameters. 

For all other parameters, see Common Parameters.

Data Set Filters

 See Common Parameters.

Items on Report

X-Axis Categories: Select one or more Categories to include in the x-axis of the bubble chart. Note that only Categories that
were not excluded from the data set by means of the Categories parameter of the Data Set Filters section are included in the
report.  

Y-Axis Categories: Select one or more Categories to include in the y-axis of the bubble chart. Note that only Categories that
were not excluded from the data set by means of the Categories parameter of the Data Set Filters section are included in the
report.

For all other parameters, see Common Parameters.

Actions

Click a bubble in a chart, a bar in a graph, or an item in a table to open a list of calls included in the item.

In X-Axis Only and Y-Axis Only versions, click  to drill down to a Category Trend report.

Sample Reports
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Full Report Version
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X-Axis Only Version

 

Home > Appendix A: Standard Reports > Templates  > Agent Comparison

Agent Comparison

 

Description

The Agent Comparison report consists of a bar graph comparing Agents' performance against each other as well as against the
average value of all Agents represented.

Common Usages

Plot Agent performance statistics to see who performs above and below the benchmark (the average of a group determined by
the filter selections)

Drill down on specific Agents to play their calls and find examples of effective agent behavior or of areas needing improvement

Utilize the data obtained from the report to identify training needs for effective agent coaching

Customizing the Report

General Settings

Version: Available in Full Report (standard size), Mini, Wide, and Table Only versions. For additional information, see Common
Parameters. 

For all other parameters, see Common Parameters.
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Data Set Filters

See Common Parameters.

Items on Report

See Common Parameters.

Actions

Click a bar in a graph or an item in a table to open a list of calls included in the item.

Sample Report
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Agent Trend

 

Description

The Agent Trend report is a line graph that displays agent performance on one or more selected categories over time.

Common Usages

Track progress of agent performance over time to monitor effectiveness of training programs.

Use graph to measure and compare performance and provide feedback to the agent.

Customizing the Report

General Settings

Version: Available in Full Report (standard size), Mini, Wide, and Table Only versions. For additional information, see Common
Parameters. 

For all other parameters, see Common Parameters.

Data Set Filters

See Common Parameters.

Items on Report

See Common Parameters.

Actions

Click a line in a graph or an item in a table to open a list of calls included in the item.

Sample Report
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Audit Analysis

Description

The Audit Analysis report is a table that shows the precision with which each Topic was identified by SpeechMiner. The precision
value is given for one or more confidence levels, as specified in the report parameters, and is determined by the TP/FP/SFP (True
Positive/False Positive/Sense False Positive) selections made by the auditor as part of the call-auditing process.

This report is instrumental to implementers, as it allows them to fine-tune the system to the right accuracy level. After learning about
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This report is instrumental to implementers, as it allows them to fine-tune the system to the right accuracy level. After learning about
Topic-identification performance, the implementer can adjust confidence levels as necessary.

Common Usage

Monitor the quality of the different Topics in the system based on audit information.

Customizing the Report

General Settings

See Common Parameters.

Items on Report

Audit Dates: The same as Date Range (see Common Parameters). The dates, however, refer to when the calls were audited
rather than when the calls were processed in the system.

Language: See Common Parameters.

Programs: See Common Parameters.

Topics: Choose the Topics whose audits you want to examine.

Exclude missing events: If checked, all orphaned audits will be excluded. For more information on orphaned audits, contact
your SpeechMiner administrator.

Thresholds: Type in the confidence levels for which you wish to see precision values. Separate multiple values with commas.
For each Topic included in the report, precision values will be displayed as percentages for each confidence level. In addition,
the report also shows the total number of TPs/FPs/SFPs for each Threshold.

Note: Confidence levels are assigned by the system to each term it identifies. They indicate how closely the term defined in the
Topic matches the term that was discovered in the audio segment. "Precision" in the report means the percentage of TPs for
all the audits in the Topic whose confidence levels were equal to or above the given Thresholds. This means that each of the
Thresholds includes all of the audits in the Threshold levels above it. Thus, in the example below, the 40-Threshold column
includes all audits with precision values of 40 or higher, the 50-Threshold column includes all audits with confidence levels of
50 or higher, and so on.

Actions

Click a Topic to drill down to the audit information for each of the terms in the Topic (shown in the Sample Reports section
below).

Click the TP/FP/SFP numbers to drill down to an Audit Interaction List (shown in the Sample Reports section below), which
lists the calls that were audited.

Sample Reports
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Audit Analysis report
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Topic analysis of selected term
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Audit Interaction List
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Call List

 

Description

The Call List report is a table that lists calls that match specified filters and settings. It is an easy way to track down calls by using
filters. Results for each call include the external call ID, the Call Time (the start time of the call), the call's Program, the Agent
handling the call, the call Duration, and, optionally, any comments that were added to the call by users.

Common Usage

Retrieve calls based on specified search parameters.

Listen to call audio of interest for quality assurance purposes.

Customizing the Report

General Settings 

See Common Parameters.

Data Set Filters

See Common Parameters.

Items on Report

Comments: Select DISPLAY to show any comments that were added to a call when the call was opened in the audio player.
Select HIDE if you do not want the comments to be visible to the report recipient.

For all other parameters, see Common Parameters.
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Actions

Click a call in the table to open the Media Player and play the call.

Sample Report

 

Home > Appendix A: Standard Reports > Templates  > Capacity Trend

Capacity Trend

 

Description

The Capacity Trend report contains information that can be used by the system administrator to monitor the system load and see the
extent to which the system can handle new incoming calls. It has two parts:

A bar graph that shows the number of hours of loaded calls and accumulated calls for each day in the selected time period.

A table listing the maximum number of channels (i.e., the maximum number of agents taking calls concurrently at any one time
in the day) and the maximum number of seats available (i.e., the maximum number of agents who could use the system) each
day

Common Usages

Analyze the number of recent calls in the system to determine if current hardware resources meet the required capacity

Forecast future hardware needs and allocate resources accordingly

Customizing the Report

See Common Parameters.
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Sample Report

 

Home > Appendix A: Standard Reports > Templates  > Category Bubble Chart

Category Bubble Chart
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Description

The Category Bubble Chart report compares Categories by plotting them on a graph according to the percentage of calls in the
horizontal (x-axis) and vertical (y-axis) Categories. Each Bubble Category is represented on the graph by a bubble. The size of each
bubble represents the average call duration. The x-axis value indicates the percentage of calls that were in both the Bubble Category
and any of the selected x-axis Categories. The y-axis value indicates the percentage of calls that were in both the Bubble Category and
any of the selected y-axis Categories.

The X-Axis Only and Y-Axis Only versions present the data as a bar graph indicating percentage of calls per Category, rather than a
bubble chart.

Common Usages

Plot call-reason Categories showing average call duration plus two customer-experience Categories (e.g., Dissatisfaction and
Escalation)

Plot call-reason Categories showing average call duration plus two agent-efficiency Categories (e.g., Transfer Rate and Hold
Rate)

Plot call-reason Categories showing average call duration plus two Categories that represent metadata (e.g., Customer
Satisfaction and Issue Resolution)

Customizing the Report

General Settings

Version: Available in Full Report (standard size), Mini, Wide, X-Axis Only, and Y-Axis Only versions. For additional information,
see Common Parameters. 

For all other parameters, see Common Parameters.

Data Set Filters

See Common Parameters.

Items on Report

Bubble Categories: Select the Categories to represent as bubbles in the chart.

X-Axis Categories: Select one or more Categories to include in the x-axis of the bubble chart.

Y-Axis Categories: Select one or more Categories to include in the y-axis of the bubble chart.

Note: For all of these parameters, only Categories that were not excluded from the data set by means of the Categories parameter
of the Data Set Filters section are included in the report. Thus, if you selected specific Categories in the Data Set Filters section, only
Categories that are selected both there and here will be included in the report. 

Actions

Click a bubble in a chart, a bar in a graph, or an item in a table to open a list of calls included in the item.

In X-Axis Only and Y-Axis Only versions, click  to drill down to a Category Trend report.

Sample Reports
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Full Report Version
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X-Axis Only Version

 

Home > Appendix A: Standard Reports > Templates  > Category Distribution

Category Distribution

Description

The Category Distribution report is a graph or chart that shows the distribution of calls by Category for a specified domain. The
distribution can be calculated by percentage of calls or by percentage of resources (total duration of all calls included in the analysis).

Common Usages

Plot the proportion of calls in specified Categories to analyze business trends and customer issues

Compare the distribution of multiple Categories—such as call or cancellation reasons, product popularity, or competitor
mentions—across your body of calls

Utilize the comparative data obtained from the report to identify the optimal ways to target customer issues

Customizing the Report

General Settings

Version: Available in Full Report (standard size), Mini, Wide, Columns, and Summary versions:

Full Report, Mini, Wide: Bar graphs listing the selected Categories and showing their proportion in the data set. For
additional information about these versions, see Common Parameters. 

Columns: A chart that shows the average call duration for each Category. These values are displayed above the total
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number of calls in the Category.

Summary (Pie): A pie chart indicating the proportion of calls or resources in the entire data set that are in or used by
the selected Categories. (Whether to base the calculations on the number of calls or on the total resources is selected
under Distributed By; see Items on Report below.)

For all other parameters, see Common Parameters.

Data Set Filters

See Common Parameters.

Items on Report

Distributed By: Select whether the distribution should be calculated based on percentage of calls (the total number of calls)
or percentage of resources (the total duration of all calls).

For all other parameters, see Common Parameters.

Actions

In Full, Mini, Wide, or Columns versions, click a Category or bar to open a list of calls in the Category.

In the Full version, click Trend ( ) to drill down to the distribution of calls for a Category. If the distribution of the items on
the report (see Items on Report above) was by percentage of calls, the distribution of calls is by percentage of calls; if it was
by percentage of resources, the distribution of calls is by average call duration.

Sample Reports

Full report

Appendix A: Standard Reports . 238

 

SpeechMiner ® User Guide Release 8.0 © 2013, Genesys Inc. Unauthorized Reproduction is Prohibited



Columns report

Summary (Pie) report
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Category Distribution per week (drill-down from Full report)

 

Home > Appendix A: Standard Reports > Templates  > Category Trend

Category Trend

 

Description

The Category Trend report shows changes in Categories over a period of time. The trend line can represent number of calls,
percentage of calls, average call duration, or total resources. There is one line per selected Category.  

Common Usages

Plot the trends in a particular Category or multiple Categories chronologically
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Identify peak periods to make informed scheduling and staffing decisions

Measure the response to new product releases

Evaluate the effectiveness of recent business changes and agent training

Customizing the Report

General Settings

Version: Available in Full Report (standard size), Mini, Wide, and Table Only versions. For additional information, see Common
Parameters. 

For all other parameters, see Common Parameters.

Data Set Filters

See Common Parameters.

Items on Report

See Common Parameters.

Actions

Click a point in a graph or an item in a table to open a list of calls included in the item.

Sample Report

 

Home > Appendix A: Standard Reports > Templates  > Coaching Summary
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Coaching Summary

 

Description

The Coaching Summary report summarizes the current status of coaching sessions in a pie chart and table, and lists active coaching
sessions by user. Items in the list can be expanded to display details about coaching sessions. 

Common Usage

Monitor personnel training.

Customizing the Report

General Settings

Version: Available in Full Report (Expanded) and Full Report (Collapsed) versions. For additional information, see Common
Parameters.

For all other settings, see Common Parameters.

Actions

Click  beside a user/trainee to expand it and view a list of coaching sessions assigned to the user/trainee, or  to collapse an
expanded user/trainee.

Click  beside a coaching session to expand it and view details about the session, or  to collapse an expanded session.

Click  or  at the top of the table to expand or collapse all of the items in the table.

Sample Report
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Home > Appendix A: Standard Reports > Templates  > First Topic Distribution

First Topic Distribution

 

Description

The First Topic Distribution report is a bar graph that shows the first Topics that were detected in each of the selected calls. The
Topics are ranked by the Data Type chosen (Number of Calls, Percentage of Calls, or Average Call Duration).

Common Usages

Classify and quantify calls according to the first-occurring topic that was recognized in the calls.

Compare the first topic distribution to assess why customers call.
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Utilize the comparative data obtained from the report to identify optimal ways to target customer issues.

Customizing the Report

General Settings

See Common Parameters.

Data Set Filters

See Common Parameters.

Items on Report

Topics: Select the Topics you want to include in the report. Note that the Topics selected here must be within the range
selected in the Data Set Filters or they will not appear in the report.

For all other parameters, see Common Parameters.

Actions

Click a bar in the graph to open a list of calls included in the item.

Sample Report

 

 

Home > Appendix A: Standard Reports > Templates  > Metadata Frequency

Metadata Frequency
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Description

The Metadata Frequency report is a histogram that shows, for a selected metadata field, how many calls in the data set had each of
the values of the field. The report has two levels. The top level is a summary that shows how many calls they belonged to each value
and the percentage of all the calls in the data set that had the values. For example, if the metadata field "department" is selected, the
report shows how many departments (values) were represented in the data set, and divides the departments into groups based on
how many calls they had. The lower level gives details for one of the groups in the top level, listing the values that had at least the
number of calls represented by the group, and indicating how many calls they had. The Wide version of the report also shows the
most common Category of those calls.

In the sample reports below, the top-level report contains a bar graph that indicates there were three departments ("3" at the top of
the first bar) for which there were three calls (3x at the bottom of the bar), one department for which there were four calls, and one
department for which there were five calls. Above this, the report shows that 14.8% of the calls in the entire data set were in the first
group, 21.3% of the calls were in either the first or second group, and 29.5% of the calls were in the first, second, or third group. The
Mini version of the report does not include the percentage data. The lower-level report was opened by drilling down on the first bar of
the graph in the top-level report. It shows the breakdown of calls for all the values. 

Common Usages

Classify and quantify calls according to a metadata field.

Utilize the comparative data obtained from the report to identify issues that may require attention.

Customizing the Report

General Settings

Version: Available in Full Report (standard size), Mini, and Wide versions. For additional information, see Common
Parameters. 

For all other parameters, see Common Parameters.

Data Set Filters

See Common Parameters.

Items on Report

Metadata Field name: Select the metadata field for which you want to run the report. Note that the field selected here must
be within the range selected in the Data Set Filters or no data will appear in the report.

Pattern to Include: Enter a series of one or more characters that must be found in the field value in order for it to be
included in the report (optional; leave the field blank to include all patterns). 

Values to Exclude: Enter one or more field values to exclude from the report. Separate multiple values with commas; do not
leave a space after the comma (optional; leave the field blank to include all values).

Minimum Call Count: The minimum number of calls that must be found for a value in order for the value to be included in the
report

For all other parameters, see Common Parameters.
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Actions

In the top level:
Click a bar in the graph to drill down to the lower level 

In the lower-level:
Click a bar in the graph to search for calls that have the field value represented by the bar.

Click  to drill down to a Category Distribution report.

Sample Reports

Top level

Lower level

 

 

Home > Appendix A: Standard Reports > Templates  > MINI_System Load

MINI_System Load
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Description

The MINI_System Load report is a line graph that shows the amount of audio hours processed per day or hour. On the line graph, two
lines are displayed, one for processed calls and one for loaded calls. 

Note: A larger version of this template, System Load, is also available. The smaller version is intended for use in the Views page.

Common Usage

Monitor the processing load of the system.

Customizing the Report

Dates: The same as Date Range in Data Set Filters (See Common Parameters)

Granularity: Choose either HOUR or DAY for the scale on the horizontal axis. Make sure your selection is reasonable for the
dates you selected.

Report Title: See Common Parameters.

Sample Report

 
Home > Appendix A: Standard Reports > Templates  > Monitor System

Monitor System

 

Description

The Monitor System report provides an overview of the SpeechMiner system status. The report consists of three components:
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1. The first chart displays the system load over the specified period. It indicates how many audio hours were loaded and
processed on each day in the period.

2. The second chart displays how many hours of audio were processed at a each given speed in real-time performance.

3. The third chart lists errors and warnings from all machines. It shows the time each error was recorded and the type of error,
and provides additional information about the error.

Common Usage

View and analyze several aspects of system data at once in order to make informed system-administration and resource-
allocation decisions.

Customizing the Report

Dates: Select the time period to include in the report

Show errors: Check this option to include error messages in the list of messages in the third chart.

Show warnings: Check this option to include warning messages in the list of messages in the third chart.

Show information: Check this option to include information messages in the list of messages in the third chart.

Actions

Click Mark as Read to mark all displayed messages as read.

Click Hide read to hide all messages that were already read (available when read messages are displayed).

Click Show read to display all hidden messages (available when read messages are hidden).

Sample Report

Appendix A: Standard Reports . 248

 

SpeechMiner ® User Guide Release 8.0 © 2013, Genesys Inc. Unauthorized Reproduction is Prohibited



 
Home > Appendix A: Standard Reports > Templates  > Performance Profile

Performance Profile

 

Description

The Performance Profile report is a bar graph and table that compares Workgroup or Agent performance in a specified Category or
group of Categories to the benchmark (the Workgroup’s or Agent’s average). You can choose to analyze performance based on the
number of calls, the percentage of calls, average call duration, or total resources. The table includes data about the number of calls,
the difference from the benchmark, and the percentage above or below the benchmark.

Common Usages

Visualize and compare agent performance for training and feedback.

Utilize the data obtained from the report to increase the efficiency of team and operations management.

Assess the efficacy of training programs by plotting performance before and after the program’s implementation.

Customizing the Report

General Settings

Version: Available in Full Report (Expanded), Full Report (Collapsed), Mini, and Wide versions. For additional information,
see Common Parameters. 

For all other parameters, see Common Parameters.

Data Set Filters

See Common Parameters.

Items on Report

Profile: Select the Agents or Workgroups you would like to compare to the average (the benchmark) for specific Categories.
Your selection must match the Benchmark Type, but it does not have to match the Workgroup or Agent parameters in the Data
Set Filters.

Benchmark Type: Select the type of benchmark to use: Agent or Team (Workgroup). The selection here must correspond
with those in the Data Set Filters. If you selected Workgroups in the Data Set Filters (rather than individual Agents in the
expanded Workgroups), you must select Team for the Benchmark Type in order to return results. The Benchmark Type must
also match the Profile selected; if Agent is selected as the benchmark type, Agents must also be selected in the Profile
parameter.

Compare: See Common Parameters.

Categories: See Common Parameters.

Threshold: Specify the minimum percent deviation from the benchmark required for an item to be included in the report. For
example, "40" means only values that are greater or less than the benchmark by at least 40% are included in the report.

Actions
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Actions

Click  beside an agent or team to expand it and view a list of Categories.

Click  to collapse an expanded item.

When an item is expanded, click Trend ( ) to drill down to a Category Trend report.

Sample Report

 
Home > Appendix A: Standard Reports > Templates  > Predictive Elements

Predictive Elements

 

Description

The Predictive Elements report is composed of two bar graphs that show the relationship between selected Categories and Target
Categories. The first graph has nested pairs—the first bar of the pair is the number of calls that fall into the selected Categories, while
the second bar of the pair is the number of calls that fall into both the selected Categories and the Target Categories (Success
Factor). The second graph shows the ratio of the two bars in each pair. By examining the ratios, you can see how each Category
affects the Target and make changes based on those findings.

Common Usages

Plot the relationship between one or more Categories and the Target Categories to better understand cause-effect trends in
customer behavior

Determine which factors increase the likelihood of reaching the desired Target (for example, which of the several potential
Scripts more reliably leads to a closed sale)

Determine which business practices and agent behaviors contribute to an undesired outcome (such as cancellation)

Utilize the data obtained from the report to optimize agent training

Analyze the report data to make informed decisions about business practices

Customizing the Report
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General Settings

Version: Available in Full Report (standard size), Mini, Wide, and Columns versions. The Columns version presents the data in
graphs alone, without printing the values in table format. For additional information, see Common Parameters. 

For all other parameters, see Common Parameters.

Data Set Filters

See Common Parameters.

Items on Report

Categories: See Common Parameters.

Target: Select Categories that you would like to include in the Target. Categories selected must match or be contained within
the Categories previously selected in the Data Set Filters.

Actions

Click an item to open a list of calls in the specified Category (or the specified Category and Target Categories).

Sample Reports

Full version
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Columns version

 
Home > Appendix A: Standard Reports > Templates  > Program Distribution

Program Distribution

 

Description

The Program Distribution report graphs the call volume for each Program.

Common Usage

Visualize and monitor comparative call-volume data by Program.

Customizing the Report

General Settings

See Common Parameters.

Data Set Filters
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See Common Parameters.

Actions

Click an item to open a list of calls included in the item. 

Sample Report

 

Home > Appendix A: Standard Reports > Templates  > QM Agent Summary

QM Agent Summary

 

Description

The QM Agent Summary report summarizes the responses on forms that were filled out by quality monitoring staff after they
reviewed calls.

Common Usage

Visualize and monitor comparative call-quality data by agent, for an entire form and for question groups within the form.

Customizing the Report

General Settings

Form: The name of the form

For all other settings, see Common Parameters.

Data Set Filters
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See Common Parameters.

Actions

In the table, under Actions, click Trend to view a graph summarizing the scores returned by the agent in the past (normally,
over the past three months, but this value may vary from one organization to another). 

Sample Report

 
Home > Appendix A: Standard Reports > Templates  > System Load

System Load

Description

The System Load report includes a line graph and a grid displaying the amount of audio hours processed per day or hour. On the line
graph, two lines are displayed, one for processed calls and one for loaded calls. The grid below the graph shows each point (either a
date or time) that appears in the line graph, with its corresponding loaded and processed hours.

Note: A smaller version of this template, MINI_System Load, is also available. It is intended for use in the Views page.

Common Usage

Monitor the processing load of the system.

Customizing the Report
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Dates: The same as Date Range in Data Set Filters (See Common Parameters)

Granularity: Choose either HOUR or DAY for the scale on the horizontal axis. Make sure your selection is reasonable for the
dates you selected.

Report Title: See Common Parameters.

Sample Report

 
Home > Appendix A: Standard Reports > Templates  > Team Comparison

Team Comparison

Description

The Team Comparison report is a bar graph that compares performance between teams and against the average value of all teams
represented.
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Common Usages

Analyze the report data to optimize team and operations management

Provide clear visual reports for training assessment and feedback

Customizing the Report

General Settings

Version: Available in Full Report (standard size), Mini, and Wide versions. For additional information, see Common
Parameters. 

For all other parameters, see Common Parameters.

Data Set Filters

See Common Parameters.

Items on Report

Teams: Select specific Workgroups to be analyzed and displayed on your report. The default value ("Any") includes all
Workgroups. You must also make the appropriate selections on the Workgroup or Agent, Language, and Program filters in the
Data Set Filters. If, in the Data Set Filters, individual Agents were selected instead of Workgroups, you must select the Team
that contains those Agents, or no results will be returned.

Compare: See Common Parameters.

Categories: See Common Parameters.

Actions

Click a bar in the graph to open a list of calls included in the item.

Sample Report

 

Appendix A: Standard Reports . 256

 

SpeechMiner ® User Guide Release 8.0 © 2013, Genesys Inc. Unauthorized Reproduction is Prohibited

http://sowbread/helpconsole2010/SpeechMiner%208-1%20User%20Manual/page.aspx?pageid=template~1


Home > Appendix A: Standard Reports > Templates  > Top and Bottom Performers

Top and Bottom Performers

Description

The Top and Bottom Performers report is a bar graph that indicates values for three groups (top performers, bottom performers, and
average performers) across multiple Categories. This enables you to identify what top performers do differently from the rest and
thereby spread the knowledge of best practices. This report is only useful if you know ahead of time who your top, bottom, and
average Agents or teams are. It is purely a graphical representation of comparison, and will NOT tell you who the top and bottom
Agents are, but rather how they compare in specific areas of performance.

Common Usages

Compare the behavior of top and bottom performers to identify best practices.

Utilize the data obtained from the report to optimize agent training and improve business processes.

Customizing the Report

General Settings

Version: Available in Full Report (standard size), Mini, and Wide versions. For additional information, see Common
Parameters. 

For all other parameters, see Common Parameters.

Data Set Filters

See Common Parameters. 

Items on Report

Top Agents: Specify the top Agents (based on prior assessment) to be displayed for each Category. The percentage of calls
handled by the selected top Agents will be displayed for each Category. Selections here must be within those made in the
Workgroup and Agent filters in the Data Set Filters.

Bottom Agents: Specify the bottom Agents (based on prior assessment) to be displayed for each Category. The percentage
of calls handled by the selected bottom Agents will be displayed for each Category. Selections here must be within those made
in the Workgroup and Agent filters in the Data Set Filters.

Average: Specify the average-performing Agents (based on prior assessment) to be displayed for each Category. The
percentage of calls handled by the selected average-performing Agents will be displayed for each Category. Selections here
must be within those made in the Workgroup and Agent filters in the Data Set Filters.

Categories: See Common Parameters.

Actions

Click a bar or a value to open a list of calls included in the item. 
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Sample Report

 

Home > Appendix A: Standard Reports > Templates  > Topic Analysis - Audits

Topic Analysis - Audits

 

Description

The Topic Analysis - Audits report is a table that shows the precision with which each Topic was identified by SpeechMiner. Precision
values are given for one or more confidence levels, as specified in the report parameters, and are determined by the TP/FP/SFP (True
Positive/False Positive/Sense False Positive) selections made by the call auditor (see Using an Event Grid).

Each line in the table contains auditing and precision information for one Topic, including the level of strictness required for
recognizing the Topic (as defined in the Topic definition in SMART), how many times the Topic was found in the calls that were
included in the report, how many calls it was found in, and how many of the events found were audited. In addition, the precision is
graded for each threshold included in the report. The grades are calculated by dividing the number of TP events by the sum of the TP
and FP events. The grades are presented as follows:

Grade Value of TP/(TP+FP) 
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 A  A >= 0.8

 B  0.8 > B >= 0.7

 C  0.7 > C >= 0.6

 D  0.6 > D >= 0.5

 F  F < 0.5

This report is instrumental to implementers, as it allows them to fine-tune the system to the correct accuracy level. After learning
about Topic-identification performance, the implementer can adjust confidence levels as necessary.

Common Usage

Monitor the quality of the different Topics in the system based on audit information.

Customizing the Report

General Settings

See Common Parameters.

Items on Report

Topics: Choose the Topics whose audits you want to examine.

Confidence Thresholds: Type in the confidence levels for which you wish to see precision values. Separate multiple values
with commas.

Note: Confidence levels are assigned by the system to each term it identifies. They indicate how closely the term defined in the
Topic matches the term that was discovered in the audio segment. "Precision" in the report means the percentage of TPs for
all the audits in the Topic whose confidence levels were equal to or above the given Thresholds. This means that each of the
Thresholds includes all of the audits in the Threshold levels above it. Thus, in the example below, the 40-Threshold column
includes all audits with precision values of 40 or higher, the 50-Threshold column includes all audits with confidence levels of
50 or higher, and so on.

Actions

Click a Topic to drill down to the audit information for each of the terms in the Topic (shown in the Sample Reports section
below).

Click the  to drill down to an item's details (shown in the last two samples in the Sample Reports section below). The details
show information about the precision as a function of confidence level and as a function of elapsed time in calls.

In the list of terms for a Topic, click the name of a term in order to open a call-search window and find calls in which the term
is found.

Sample Reports
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Topic Analysis - Audits report
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Terms in a selected Topic
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Term Details

 

 

Home > Appendix A: Standard Reports > Templates  > Topic Analysis - Trends

Topic Analysis - Trends
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Description

The Topic Analysis - Trends report is a table that compares how often particular Topics were found in the selected time period with
how often they were found in the preceding time period. Each line in the table contains information for one Topic, including the
percent change between the current period and the preceding period, and the number and percent of calls in each period in which the
Topic was found. 

The baseline time period for the report is selected in the Data Set parameters (see Common Parameters). The preceding time period
is automatically set by the system based on the baseline. For example, if the baseline is a two-month period, the preceding time
period used is the two months preceding that baseline period. 

Common Usage

Monitor Topic trends in calls handles by the system

Customizing the Report

General Settings

See Common Parameters.

Items on Report

Topics: Choose the Topics whose audits you want to examine.

Minimum Number of Calls: Type in the minimum number of calls in which a Topic must be found in order for it to be included
in the results. 

Actions

Click a Topic to drill down to the trend information for each of the terms in the Topic (shown in the Sample Reports section
below).

In the list of terms for a Topic, click the name of a term in order to open a call-search window and find calls in which the term
is found.

Sample Reports
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Terms in a selected Topic

   

 
Home > Appendix A: Standard Reports > Templates  > Topic Call List

Topic Call List

Description

The Topic Interaction List report returns a list of calls in specific Topics based on the search parameters entered. 

Common Usages
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As a drill down from First Topic Distribution

Customizing the Report

Data Set Filters

See Common Parameters.

Items on Report

Report Title: See Common Parameters.

Topics: Select the desired Topics of calls you want displayed. The Topics must match up with the appropriate Workgroup,
Agent, Language, and Program selections in the Data Set Filters.

Actions

Click any call ID to open the Media Player and play the call.

Sample Report

 

Home > Appendix A: Standard Reports > Templates  > Topic Correlation

Topic Correlation
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Description

The Topic Correlation report gives information about the co-occurrence of Topics. The report generates a list of association patterns
by mining the set of Topic events for frequent and significant patterns of association. Each pattern of association is composed of a
cause ("Left Hand Side") and a consequence ("Right Hand Side"); that is, each pattern identifies a particular Topic or sequence of
Topics that seem to lead to the appearance of another specific Topic. For example, the report might include a pattern indicating that
when the Topics Transfer and Dispute are found in a call, they are often followed by the Topic Dissatisfaction. 

For each correlation in the report, statistical information is provided indicating how significant the correlation was in the data set: 

Support: How many times the pattern was found in the data set

Confidence: The percentage from the calls in which the cause was found, in which the consequence was also found

Lift: How dependent the the consequence was on the causes

Saliency: The significance of the correlation - how much information is represented by the pattern of association 

Common Usages

Identifying scenarios in the flows of calls that tend to produce certain results

Investigating the root causes of events that take place during interactions

Customizing the Report

General Settings

Report Title: See Common Parameters.

Description: See Common Parameters.

Items on Report

Date: The end-date of the Date Range included in the report

Date Range: The time period to include in the report, relative to the date specified under Date

Program: Select the Program to use as the data set; interactions belonging to this Program will be included in the report

Target Topics: Select one or more Topics for the Right Hand Side of the report, or Any to include all Topics; only patterns
associating Topics with the selected target Topics will be included in the report.

Minimum Lift: The minimum degree of dependency that must be exhibited between the causes and affects of an
association for the pattern to be included in the report. "Lift" is always greater than or equal to "0"; the higher the value, the
greater the dependency. 

Minimum Confidence: The minimum percentage from the calls in which the cause was found, for which the consequence was
also found, required for the pattern to be included in the report. Range: an integer between 0 and 100.

Sample Report
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Home > Appendix A: Standard Reports > Templates  > Usage Tracking

Usage Tracking

Description

The Usage Tracking report shows information about the activities of users over a selected date range.

Common Usage

Monitor the activity of SpeechMiner users.

Find out who performed the last system Apply in SMART

See which calls have been listened to 

Customizing the Report

Report Title: See Common Parameters.

Description: See Common Parameters.

Dates: The same as Date Range in Data Set Filters (see Common Parameters).

Actions

Click a user to drill down to a log of the user's actions (shown in the Sample Reports section below).

In the log of user actions, click one of the tabs at the top of the list to filter the list. For example, click Logins to see a list of
when the user logged into or out of the system.

Sample Reports
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User Tracking report

 

User log

 
Home > Appendix A: Standard Reports > Templates  > User Management

User Management
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Description

The User Management report is a table that displays the properties of groups and users in your SpeechMiner system.

Common Usage

Monitor users, their roles, and the groups they belong to

Customizing the Report

The first four filters have an AND relationship, which means each filter further narrows down your choices of the users to be
presented on the report. Make sure your selections are not mutually exclusive; otherwise, no results will be returned.

Users: Select the users you want to appear on the report. For additional information about users, see Managing Users.

User Groups: Select the user groups you want to appear on the report. For additional information about groups, see
Managing Groups.

User Roles: Narrow down users by selecting specific roles. For additional information about roles, see Managing Roles.

Active Only: Select Yes to only include active users, or No to include all users. Note that a non-active user is a user whose
account profile is marked as non-active. (It does not refer to users who are not currently using the system.)

Report Title: See Common Parameters.

Sample Report
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